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Preface Introduction
Thank you for purchasing the TOC-VWP Total Organic Carbon Analyzer.

This instruction manual is a TOC-V user manual. It provides operation and 
maintenance procedures for the TOC-V. The procedures related to TOC-Control V 
software system administration are described in detail in the TOC-V Administrator's 
Manual.

Be sure to carefully read this documentation before using the instrument for the first 
time. Read the Operational Precautions before operating the instrument. Follow the 
procedures in the manual to avoid compromising user or instrument safety.

 CAUTION

• Do not operate this instrument before understanding the contents of 
this manual.

• If this manual or the warning labels on the instrument become lost or 
damaged, promptly obtain replacements from your Shimadzu 
representative.

• To ensure safe operation, read and follow the procedures in 
Section 1.2 “Operational Precautions” before operating the 
instrument. 
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Product Warranty and Post Sale Service

Product Warranty

The warranty does not cover malfunctions that result from:

• misuse;

• repairs or modifications made by any company other than the 
manufacturer or an approved company;

• external factors;

• operation under severe conditions, such as environments with high 
temperature, high humidity, corrosive gas, vibration, etc.;

• fire, earthquake or other forces of nature;

• moving or transporting the unit after its initial installation;

• the consumption of items or parts that can be regarded as consumable. 

Post Sale Service

If any problems occur with this instrument, inspect it and take appropriate corrective 
action as described in Section 5.6 “Troubleshooting”. If the problem persists, or 
symptoms are not covered in the Troubleshooting section, contact your Shimadzu 
representative.
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Contents of This Manual
Chapter 1 “Overview”

This chapter provides an overview of the instrument and operational precautions for its 
use.

Chapter 2 “System Description”

This chapter describes the TOC-V system components and optional accessories.

Chapter 3 “Software Overview, Administration, and Setup”

This chapter provides an overview of the TOC-Control V software and describes the 
software’s Administration and Instrument Setup Wizard tools, which are used to 
manage user accounts and configure new systems.

Chapter 4 “Operation”

This chapter describes pre-analysis preparations and instrument and software 
functions, such as setting measurement parameters, starting up the instrument, 
generating calibration curves, and conducting sample analysis. This chapter also 
includes a tutorial that covers setup and measurement procedures.

Chapter 5 “Maintenance”

This chapter describes maintenance procedures and periodic checks required to ensure 
that the instrument provides consistently high accuracy analyses. Troubleshooting 
procedures and error messages are also included in this chapter.

Chapter 6 “Reference Materials”

This chapter describes principles of analysis and lists specifications, standard and 
optional accessories, and specialized terms associated with this instrument. This 
chapter also includes the installation procedure, for use in the event that instrument is 
moved to another site.

Appendix A “Method Validation”

This appendix describes the software’s Method Validation tool, which is used to test 
the variance and linearity of a data set.

Appendix B “Control Charts”

This appendix describes the software’s Control Charts tool, which is used to monitor 
the precision and accuracy of a data set.
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Notation Conventions 

Precautionary Conventions Used in this Manual

The following precautionary conventions are used in this manual.

Other Conventions Used in this Manual

Supplementary Conventions

In addition to the precautionary conventions, Tip and Reference are used to supply 
additional information.

Convention Description

CAUTION Indicates the possibility of slight to moderate 
injury or equipment damage.

Note: Provides additional information to ensure the 
correct use of the instrument.

Convention Description

TIP: Indicates a particular technique, alternative 
means of operation, or useful advice.

Reference: Indicates a reference location for more 
detailed information.
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Warning Labels Used on this Instrument
Electric Shock Warning

High voltage is applied to the UV lamp when it is illuminated. Never touch this 
component as there is a risk of electric shock. Always turn OFF the UV lamp before 
performing any UV lamp-related maintenance.

High Temperature Warning

The TC reactor and UV lamp are at high temperatures during operation (approximately 
80°C). High voltage is applied to the heating element at the periphery of the aluminum 
block of the TC reactor heater. Never touch this area with bare hands as there is a risk 
of burn injury and electric shock. Turn OFF the TC reactor and UV lamp, and allow 
them to cool to room temperature before performing maintenance to the TC reactor or 
UV lamp.
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Ultraviolet Radiation Warning

Ultraviolet light is radiated from the UV lamp when it is illuminated. Due to the risk of 
eye injury, do not view this light directly for prolonged periods even with the supplied 
yellow cover in place. Before turning on the UV lamp, verify that it is correctly 
installed and that the supplied cover is attached. 

Electric Shock Warning

Do not remove this panel, as there is a danger of electric shock.
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Injury Warning

The sample injection components of this instrument move during operation. To prevent 
injury, keep hands away from this mechanism.

Corrosion Warning

Acid and other corrosive substances are present in the liquid waste drained from this 
instrument. Do not touch or spill this liquid waste.
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Corrosion Warning

The waste liquid contained in this receptacle is corrosive. DO NOT touch or spill this 
liquid waste.

Sodium persulfate (oxidizing reagent) and phosphoric acid are corrosive chemicals. 
DO NOT touch or spill these substances.
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1
1Overview

This chapter provides an overview of the instrument and the operational 
precautions for instrument use. 

1.1 Overview

Provides an overview of the instrument. 

1.2 Operational Precautions

Details precautions necessary to ensure that the instrument is used safely and 
correctly.
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1.1 Overview 

The TOC-VWP is an instrument that measures the amount of total carbon (TC), 
inorganic carbon (IC) and total organic carbon (TOC) in water. “Wet chemical 
oxidation with non-dispersive infrared (NDIR) analysis” is a TOC measurement 
method that has been adopted by the JIS1 and other international standards. 

Moreover, when the ASI-V Autosampler or OCT-1 8-Port Sampler is used in 
combination with the main unit, a fully automatic system is created, allowing 
automatic analysis of multiple samples.

Read this user manual carefully before using TOC-VWP instrument to ensure its proper 
use. The manual should be stored in a convenient location for future reference.

 CAUTION
Safety may be compromised if the instrument is used in a fashion 
other than that indicated in this user manual. Pay particular attention to 
the CAUTION sections to ensure safety when using the instrument.

 1. JIS K-0102 “Industrial Waste Water Testing”, JIS K-0551: “Total organic carbon 
(TOC) testing methods for ultra-pure water”, U.S.Pharmacopoeia, EPA 415.2, EPA 
9060A, ASTM D2575, Standard Methods for Examination of Water and Waste 
Water 5310C 
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1.2 Operational Precautions 

Take the following precautions when using this instrument. 

CAUTION
• Ensure that the supplied cover for the UV lamp is installed. Do not 

view the UV lamp directly for prolonged periods even if the cover is 
installed. Ultraviolet radiation can cause eye injury. <Eye injury 
prevention>

• Ensure that the nitrogen carrier gas is flowing before turning on the 
UV lamp of the TC reactor. There is a danger of ozone gas generation, 
physical injury and corrosion of parts. <Physical injury prevention, 
part corrosion prevention>

• Ensure that the TC reactor cover is installed before turning on the 
reactor heater. There is a danger of burn injury due to the high 
temperatures at the TC reactor heater. High voltage is applied to the 
TC reactor heating element, creating a danger of electric shock. <Burn 
and electric shock prevention>

• The black rubber part at the top of the UV lamp reaches high 
temperatures when the UV lamp is illuminated. Do not touch this part 
of the UV lamp as there is a danger of burn injury. <Burn injury 
prevention>

• High voltage is supplied to the UV lamp when it is illuminated. Do not 
touch these parts. <Electric shock prevention>

• Use nitrogen gas as the carrier gas in this instrument. If air or oxygen 
is used, harmful ozone is generated inside the TC reactor, and could 
adversely affect health. <Prevention of harmful health effects>

• Turn off the UV lamp and allow the reactor to cool before performing 
maintenance to the TC reactor or UV lamp. Performing this 
maintenance while the UV lamp is on or the TC reactor is hot could 
result in burn injury or electric shock. <Burn injury and electric shock 
prevention>
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• To reduce back pressure, verify that the external drain tubing 
connected to the waste port on the right side of the instrument does not 
touch the surface of the liquid in the waste container. The height of the 
external tube must always be lower than the height of the drain port. 
Excessive back pressure results in insufficient drainage and waste 
overflow inside instrument. <Part corrosion prevention>

Figure 1.1  External Drain Tubing

• Hand tighten the connectors to the 8-port valve. Use of a tool may 
cause deformation and leakage in the valve. <Part damage prevention>

• Stop operation of the instrument when performing maintenance on any 
of the drive components, such as connecting lines to the 8-port valve 
or connecting/disconnecting lines on the sample injector. If these parts 
are manipulated or if the lines are disconnected during operation, the 
drive component could move, causing injury or discharge of liquid. 
<Injury prevention, corrosion prevention>

• This instrument is designed for measurement of relatively clean 
samples, containing almost no acid, alkali or salts. Depending on the 
concentration, the presence of these types of constituents could 
interfere with measurement accuracy.

• When measuring samples containing organic particulates (organic 
suspensions), insufficient oxidation could result in low values. In 
addition, slurries and other organic suspensions can accumulate in the 
instrument flow lines, damaging the Teflon parts inside the 8-port 
valve and the syringe adversely affecting instrument operation. It is 
recommended that such particles be removed from samples before 
measurement.

• The ASI-V autosampler can be equipped with an optional magnetic 
stirrer; however, this instrument is not designed for measurement of 
samples containing suspended particles. For this reason, references to 
the magnetic stirrer have been removed from this instruction manual.

• To clean the instrument, wipe the surface with a soft cloth moistened 
with water. Do not use chemicals.

Drain tubing (Tubing
placement should be as
indicated by the solid lines.)

Drain container
(Supplied by user.)
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• Repairs to the inside of this instrument can be dangerous. Contact your 
Shimadzu representative to have a trained service engineer perform 
any repairs.

• Do not disassemble or modify this instrument beyond the scope of the 
maintenance procedures in this manual as safety may be 
compromised.

• The construction of this instrument is not explosion-proof. It must not 
be used in dangerous areas.

• Use this instrument with a power supply of AC100-120V (for a 100V 
system) or AC220-240V (for a 200V system).

• Do not use the following characters when naming files or systems to 
be saved:

/ ,  . \ (back slash) : ; (these are all normal-width characters), space (normal 
width, em width)

• Turn OFF the Power Management function of the PC to prevent 
shutdown of the PC power while it is controlling the TOC analyzer. A 
shutdown of this nature would adversely affect performance. 

• Hand-tighten the connectors to the 8-port valve of the 8-port sampler. 
Over-tightening with a tool may exert excessive force to the internal 
valve body, causing deformation and internal leakage. <Part damage 
prevention<

• Shut down the instrument before connecting or disconnecting tubing 
to the 8-port valve or performing maintenance to the drive parts. 
Liquid may be discharged from tubes during operation. <Part 
corrosion prevention>)

• When utilizing the software's printing function, set the paper size to 
letter or A4 and printer graphic resolution to 600 dpi.

• This instrument is equipped with a data backup battery with a life span 
of about 1-year. If the instrument is not turned ON at least once a year, 
it may not connect with the PC.

If the battery is completely depleted, the instrument may not start up when it is 
first turned ON. If this occurs, leave the power ON for 30 seconds, then turn 
the power to the instrument off and back on again.

If the instrument is to remain idle for a long period, turn the instrument ON and 
leave it running for 24 hours at least once a year.
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2
2System Description

This chapter identifies the components of the TOC-VWP, ASI-V autosampler 
and the OCT-1 8-port sampler.

2.1 TOC-VWP

Describes the construction of the TOC-VWP unit using front, right, left, rear, 
top and internal views of the instrument as well as the flow diagram.

2.2 ASI-V Autosampler (Option)

Provides descriptions of front and rear views of the autosampler.

2.3 OCT-1 8-Port Sampler (Option)

Describes the front and rear views of the 8-port sampler.



2.1 TOC-VWP
2.1.1 Front View
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2.1 TOC-VWP

2.1.1 Front View

Figure 2.1 Front View

2.1.2 Right Side View 

Figure 2.2  Right Side View

Start Button

Stop Button

Front Door

Power Switch

Drain Tubing

Dilution
Water
Bottle
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2.1.3 Left Side View
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2.1.3 Left Side View 

Figure 2.3  Left Side View

2.1.4 Rear View 

Figure 2.4  Rear View

1) Flash ROM rewrite switch

2) Printer cable terminal 

3) RS-232C terminal (1)

4) RS-232C terminal (2)

5) ASI-V/OCT-1 signal cable terminal

6) ASI-V/OCT-1 power cable terminal

Sampling Tubing

Acid Oxidizing Reagent

Carrier Gas Inlet

AC Inlet

CO2 Absorber

1 2 3 4 5 6
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2.1.5 Inside Front View
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2.1.5 Inside Front View

Figure 2.5  Inside Front View

1) TC reactor
2) IC reactor
3) Solenoid valve (for IC reactor gas switching)
4) UV lamp
5) TC reactor heater
6) TC reactor cover
7) Carrier gas/sparge gas pressure gauge
8) Carrier gas flow adjustment knob
9) Sparge gas flow adjustment knob
10) Carrier gas/sparge gas flow meter
11) Carrier gas/sparge gas pressure adjustment knob
12) Halogen scrubber
13) Syringe pump cover
14) 25mL syringe
15) 8-port valve
16) Dehumidifier
17) Dehumidifier drain pot

12 3 4 5 6 7 8

9

10

11

12

13

14

15

16

17
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2.1.6 Top View 

Figure 2.6  Top View 

2.1.7 Flow Diagram (TOC-VWP)

Figure 2.7 Flow Diagram (TOC-VWP)

Top Cover



2.2 ASI-V Autosampler (Option)
2.2.1 Front View
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2.2 ASI-V Autosampler (Option) 

2.2.1 Front View

Figure 2.8 Front View

Needle Replacement Window

Sample Tubing

Sample
Cover

Stirrer Speed
Control (option)
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2.2.2 Rear View
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2.2.2 Rear View

Figure 2.9 Rear View

Signal Cable

Power Cable
(attached to ASI)

Rinse Solution Tubing

Drain Tubing

Terminal



2.3 OCT-1 8-Port Sampler (Option)
2.3.1 Front View
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2.3 OCT-1 8-Port Sampler (Option)

2.3.1 Front View

Figure 2.10 Front View

2.3.2 Rear View

Figure 2.11 Rear View

8-Port Valve

8-Port Sampler 1 8-Port Sampler 2

Signal Power
Signal Cable
(with Power Supply)

CableCable
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3Software Overview, Administration,

and Setup
This chapter provides an overview of the TOC-Control V software and 
describes the Administration module and Instrument Setup Wizard.

3.1 Introduction to System Administration Functions

Describes the system administration functions performed by the user.

3.2 Instrument Setup and System Properties

Describes the TOC-Control V Instrument Setup Wizard, which is used to 
configure new systems by collecting information such as installed 
instrumentation, instrument settings and communication parameters. Also 
describes procedures for viewing the properties of and removing previously-
configured systems.
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3.1.1 Screen Lock Function
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3.1 Introduction to System Administration Functions

This section describes the various system administration functions in the TOC-Control 
V software that are available to the user. For a description of system administration 
functions that can be performed by the system administrator, refer to the TOC-V 
Administrator's Manual.

3.1.1 Screen Lock Function

If user must temporarily leave the PC during measurement, the screen can be locked to 
protect the data from another individual making improper or malicious operations in 
TOC-Control V. 

This function can be used only if the User ID / Password item is checked in the 
Security dialog box.

To lock the screen, select Screen Lock in the Tools menu. The screen is locked and the 
Re-enter Password dialog box displayed. Once the screen is locked it can only be 
unlocked by entering the User ID and Password of the user who was logged on at the 
time the screen was locked. 

Figure 3.1 Screen Lock Command

Figure 3.2 Re-enter Password Dialog Box



3.1 Introduction to System Administration Functions
3.1.2 Change Password
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3.1.2 Change Password

This function is used to change the password of a registered user. 

Select Change Password in the TOC-Control V Administrator window to open the 
Change Password dialog box. This function can be used only if the User ID/Password 
item is checked in the Security dialog box. Refer to Section 3.2.4 “Security” in the 
Administrator’s Manual for more information. 

Figure 3.3 TOC-Control V Administrator Window

Figure 3.4 Change Password Dialog Box



3.1 Introduction to System Administration Functions
3.1.3 Add Event Log
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3.1.3 Add Event Log

This function is used when a comment is to be included with the operation history. This 
function is useful for documenting items in the operation history, such as the 
replacement of catalyst, that cannot be recorded automatically through the software. 
Only users with access rights to Add Event Log can use this function. 

This function can be used only if Audit Trail is checked in the Security dialog box. 
Refer to Section 3.2.4 “Security” in the Administrator’s Manual for more information. 

When Add Event Log is selected in the TOC-Control V Administrator window, the 
Add Event Log dialog box is displayed.

Figure 3.5 Add Event Dialog Box

Select one of the items in the Select Item array, and then enter a comment in the 
Comment text field. If the Comment text field is left blank, an error message is 
displayed, and the comment is not added to the Event Log.
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3.2 Instrument Setup and System Properties

This section describes the Instrument Setup Wizard, which is used to configure new 
systems. This section also describes procedures for viewing the properties of and 
removing previously-configured systems.

The TOC-Control V Instrument Setup Wizard is used to enter properties for a new 
system. Access the Wizard by double-clicking the “New System” icon in the TOC-
Control V main window.

Multiple instruments can be configured for the TOC-Control V software system by 
entering information into the series of Wizard screens.

TIP: Use the Back and Next buttons to move among the various Instrument Setup Wizard 
windows.
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TOC-VWP20

3.2.1 System Information Window

The System Information window of the Instrument Setup Wizard is used to enter basic 
system information.

Figure 3.6 Instrument Setup Wizard: System Information Window

System

Enter a unique name for the system, using up to 32 characters. A name must be entered 
before continuing to the next Wizard page. If a system with the entered name already 
exists, an error message is displayed requesting entry of a unique name.

Serial Number

Enter the serial number of the TOC-V. The serial number of the unit is an 8-character 
number (No. ********) that is printed on the plate attached to the lower right side of 
the instrument.

User

The name of the current user is automatically entered into the User field and cannot be 
edited.

Date of Creation

The current date is automatically entered into the Date of Creation field and cannot be 
edited.

Comment

Enter additional system information in the Comment text box. The Comment field is 
optional and can contain up to 512 characters.
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3.2.2 Options Window
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3.2.2 Options Window

The Options window of the Instrument Setup Wizard is used to specify the instrument 
hardware configuration and attached accessories.

Figure 3.7 Instrument Setup Wizard: Options Window

Oxidation

Select “Wet Chemical” from the drop-down list to specify the oxidation method.

Options

Select the installed instrument components by clicking in the appropriate check boxes. 
When [Wet Chemical] is selected as the oxidation method, [ASI], [SSM], [Sparge Kit], 
[8Port Sampler-1], and [8Port Sampler-2] can be selected. The selected options 
determine which Instrument Setup Wizard screens are displayed.

Option Description

TOC Displays the TOC screen of the Instrument Setup Wizard. This 
option is always selected.

ASI Displays the ASI screen of the Instrument Setup Wizard to allow 
autosampler parameters to be set. ASI cannot be selected if SSM or 
8-Port Sampler 1or 2 are selected

Sparge Kit Specifies that the Sparge Kit accessory is installed and that external 
sparging is desired. If the Sparge Kit is selected as an option, the 
“Needle” parameter is enabled on the ASI screen of the Instrument 
Setup Wizard.

8-Port Sampler 1 Select this option when one 8-port sampler accessory is installed. 8-
Port Sampler 1 cannot be selected if the ASI or SSM are selected.

8-Port Sampler 2 Select this option when two 8-port sampler accessories are installed. 
8-Port Sampler 2 can only be selected if 8-Port Sampler 1 is selected.

SSM Select this option when the SSM (solid sample module) accessory is 
installed and necessary for measurement. the SSM cannot be 
selected if the ASI or 8-Port Sampler 1 or 2 is selected.
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3.2.3 TOC Window

The TOC window of the Instrument Setup Wizard is used to set TOC instrument 
parameters.

Figure 3.8 Instrument Setup Wizard: TOC Window

Cell Length

Select the length of the NDIR cell from the drop-down list. Available options:

• Long: for typical measurements.

• Short: for measurement of extremely high concentration samples.

UV Lamp

Turns on the UV lamp inside the TC reactor.

Check this box to perform TC or NPOC measurement.

Reactor Temp ON

Turns on the heater of the TC reactor.

Check this box to perform TC or NPOC measurement.

Buzzer

Enables the internal buzzer function. Select this option to allow the buzzer to sound 
during measurement.

Enable Ready Status Check

Select this option to enable the Ready Status Check function. When the function is 
enabled, the software always verifies that the instrument is in the Ready state prior to 
starting measurement. Enabling the Ready Status Check function is recommended. 
When the function is deselected, measurement can be performed when the instrument 
is not in the Ready state, an option that is mainly for use by service personnel.
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3.2.4 ASI Window
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3.2.4 ASI Window

The ASI window of the Instrument Setup Wizard is displayed if ASI was selected in 
the Options window of the Wizard. Use the ASI screen to set the autosampler 
parameters.

Figure 3.9 Instrument Setup Wizard: ASI Window

Tray Type

Select the ASI tray type from the drop-down list. Options are 40mL Vial and 125mL 
Vial.

Needle

Select the needle type from the drop-down list. Options are:

• Sample: for analysis using only a sample needle

• Sample+Sparge: for analysis using both a sample needle and a sparge needle

The Needle field is enabled only if Sparge Kit was selected in the Options window of 
the Wizard.

Note: The instrument does not automatically recognize the type of needle installed. 
Be sure to select the type of needle that is actually installed in the instrument.

No. of Needle Washes

Enter the number of times (1-10) for the outside of the needle to be washed after each 
sample using purified water from the ASI water bottle. 

No. of Flow Line Washes

Enter the number of times (1-10) for the flow lines to be washed after all samples listed 
in the Sample Table have been measured. Purified water from the ASI water bottle is 
used to wash the flow lines.
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Rinse

Select this option to rinse the sampling needle, syringe and flowlines between each 
sample with purified water from the ASI water bottle.

Rinse after acid addition

Select this option to rinse the sampling needle after each acid addition with purified 
water from the ASI water bottle.

3.2.5 SSM Window

The SSM window of the Instrument Setup Wizard is displayed if SSM was selected in 
the Options window of the Wizard. Use the SSM screen to set the SSM parameters. 
Refer to the SSM-5000A User Manual for details.

Figure 3.10 Instrument Setup Wizard: SSM Window

SSM TC Furnace On

Select this option for TC measurement.

SSM IC Furnace On

Select this option for IC measurement.
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3.2.6 Communication Window

The Communication window of the Instrument Setup Wizard is used to set parameters 
for communication between the instrument and the PC. 

Figure 3.11 Instrument Setup Wizard: Communication Window

Com Port

Select the communication port from the drop-down list. Options include Com1, Com2, 
Com3, and Com4.

Stop Bits

The Stop Bits value is determined by the hardware and is set automatically based on 
the Com Port selection. This field is disabled and cannot be edited by the user.

Parity

The Parity value is determined by the hardware and is set automatically based on the 
Com Port selection. This field is disabled and cannot be edited by the user.
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3.2.7 History Function Window

The History Function window of the Instrument Setup Wizard is used to enable the 
History Log. The History Log records all modifications to the system properties. In 
addition, the History Log can be set to require users to enter comments for each 
modification. 

Note: Once the History Log is enabled, it cannot be disabled. All modifications to the 
system properties are tracked. If the mandatory comment option is selected, 
the user is required to enter a comment each time any system parameter is 
modified.

.

Figure 3.12 Instrument Setup Wizard: History Function Window

Enable History Log

Select this option to enable the software to monitor all modifications to the system 
properties. Once the History Log is enabled, the check box is disabled and the log 
cannot be turned off. The History Log is maintained on the History tab of the 
Instrument Properties dialog box. Refer to Section 3.2.8 "Instrument Properties Dialog 
Box" for more details. If the History Log is not required, it need not be enabled, as the 
software operates properly without it.

A Comment is Required for All Modifications

Select this option to require the user to comment on or obtain approval for all 
modifications. Once this option is selected, the check box is disabled and the option 
cannot be turned off. If the History Log is not required, it need not be enabled, as the 
software operates properly without it.

Finish Button

The History Function window is the final screen in the Instrument Setup Wizard. Make 
the appropriate selections, then click the Finish button. The new instrument is created 
and saved, and its icon appears in the TOC-Control V main window.
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3.2.8 Instrument Properties Dialog Box

Instrument parameters can be viewed and modified using the Instrument Properties 
dialog box, shown below. Open the dialog box by double-clicking the instrument icon 
in the TOC-Control V main window.

Figure 3.13 Instrument Properties Dialog Box

System Tab

The System tab displays the System Information window for the selected system and 
allows editing of the comments field.

Options Tab

The Options tab displays the oxidation method and instrument components that were 
selected in the Options window of the Instrument Setup Wizard. Information on this 
tab can be viewed but not changed.

TOC Tab

The TOC tab displays the TOC window. Some fields on the TOC tab can be edited. If 
the History Log was enabled during setup, edits to the TOC tab are tracked and listed in 
the History tab.

ASI Tab

The ASI tab displays the ASI window. Some fields on the ASI tab can be edited. If the 
History Log was enabled during setup, edits to the ASI tab are tracked and listed in the 
History tab.

Communication Tab

The Communication tab displays the Communication window. Some fields on the 
Communication tab can be edited. If the History Log was enabled during setup, edits to 
the Communication tab are tracked and listed in the History tab.
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History Tab

The History tab displays the History Function window. If the History Log was not 
enabled during setup, this screen can be used to enable the History log.

If the History Log was enabled during setup, the History tab lists all changes made to 
the system parameters. The log lists modifications chronologically, with the most 
recent modification at the top. If the mandatory comment option was selected during 
setup, all modifications listed in the History tab window contain a comment describing 
the reason for the change. View or edit previously entered comments by selecting the 
modification from the list and clicking the Edit Comment button. If the History Log is 
not required, it need not be enabled, as the software operates properly without it.

Figure 3.14 Comment Dialog Box

If the mandatory comment option was selected in the History Function window during 
instrument setup, the Comment dialog box (shown above) is displayed after any 
change is made in the Instrument Properties dialog box. 

3.2.9 Removing a Configured System

Systems are removed from the TOC-Control V software using the main window. To 
remove a system, right-click the appropriate system icon and select Delete. Once a 
system is removed, it cannot be restored.
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4Operation

This chapter describes procedures for pre-analysis preparations, setting 
measurement parameters, starting up the instrument, generating calibration 
curves, and conducting sample analysis. This chapter also includes a tutorial 
that covers setup and measurement procedures.

4.1 Analysis Preparation

This section describes installation of the TC and IC reactors, mounting of the 
syringe and other procedures used for actual sample analysis.

4.2 Setting General Measurement Parameters

This section describes the procedures for entering the analysis parameters.

4.3 Analysis

This section describes the procedures for instrument startup, calibration curve 
generation, sample analysis, method development and instrument shutdown.

4.4 Sample Table Editor

This section describes the various sample table menus.
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TOC-VWP30

4.1 Analysis Preparation

4.1.1 Installing the TC reactor

Installation Procedure

1. Loosen both of the TC reactor cover screws, and remove the cover. 

2. As shown in Figure 4.1 “Connection of TC Reactor and Fitting”, connect the 
joint fitting to the narrow end of the TC reactor. 

Note: Orient the joint fitting perpendicular to the TC reactor branch tube. 
When facing the branch tube. the blue tubing is connected to the right 
side of the fitting, and the white tubing to the left.

Figure 4.1 Connection of TC Reactor and Fitting

3. As shown in Figure 4.2 “Connection of TC Reactor and Viton Connector”, 
connect the Viton connector to the TC reactor branch tube, and fasten it with 
the hose clamps.

Figure 4.2 Connection of TC Reactor and Viton Connector

Branch Tube
TC Reactor

Joint Fitting

Hose Clamps

Viton Connector
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4. Remove the six (6) TC reactor heater insulator retaining pins, then open the 
two (2) heater retaining brackets to open it up.

Figure 4.3 TC Reactor Heater

5. Roll the heat conducting sheet into a tube. With the opening of the sheet on the 
opposite side from the branch tube, slide the TC reactor into the tube and then 
slide the rolled sheet into the TC reactor heater.

6. Align the branch tube of the TC reactor with the notch on the back of the 
heater surface. Verify that the seam in the heat conducting sheet faces the front 
of the TC reactor heater, close the TC reactor heater, and close the retaining 
brackets.

Note: If the inside of the TC reactor can be seen through the space in the heat 
conducting sheet, the TC reactor is correctly installed. 

7. Open the top cover, and connect the UV lamp connector to the UV lamp power 
supply as indicated on the circuit board.

Figure 4.4 UV Lamp Cable Connector

8. Replace the cover on the TC reactor. Pass the tubing and wires through the slit 
in the TC reactor cover. 

9. Close the top cover.

Retaining
Retaining
Brackets

Pins

Connector
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 CAUTION

• Turn OFF the TC reactor heater and the UV lamp, and wait for the 
heater to cool to room temperature before performing any 
maintenance on the TC reactor. There is a danger of burn injury and 
electric shock. 

• High voltage is applied to the UV lamp and UV lamp power supply. 
Due to the danger of electric shock, turn OFF the UV lamp before 
performing any maintenance on the TC reactor.

• The TC reactor is constructed of glass. To avoid injury, do not break 
the glass when connecting the TC reactor.

• When tightening the plastic nuts used on the connectors, do not use 
any tools. Tightening securely by hand is sufficient.

• Do not contaminate internal or external surfaces of the TC reactor or 
the inside of the connectors with organic substances such as grease or 
oil. This is critical when performing high sensitivity measurement.

4.1.2 Installing the IC Reactor

Installation Procedure

1. As shown in Figure 4.5 “Connection of IC Reactor and Fitting”, connect the 
joint fitting to the narrow end at the bottom of the IC reactor.

Figure 4.5 Connection of IC Reactor and Fitting

2. As shown in Figure 4.6 “Connection of IC Reactor and Viton Connector”, 
connect the Viton connector to the IC reactor branch tube, and fasten it with 
the hose clamps.

IC Reactor

Joint Fitting
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Figure 4.6 Connection of IC Reactor and Viton Connector

3. Insert the sparge tube into the IC reactor, and secure it by tightening the cap 
screw.

Figure 4.7 Inserting the Sparge Tube

4. Attach the IC reaction tube to the instrument using the mounting clamp. 

Figure 4.8 Attaching the IC Reaction Tube

Hose Clamps

Viton Connector

Cap Screw

Sparge Tube

Mounting Clip
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 CAUTION

• The IC reactor is constructed of glass. To avoid injury, do not break the 
glass when installing the IC reactor. 

• When tightening the plastic nuts used on the connectors, do not use 
any tools. Tightening securely by hand is sufficient.

• Do not contaminate internal or external surfaces of the IC reactor or 
the inside of its connectors with organic substances such as grease or 
oil. This is critical when performing high sensitivity measurement.

4.1.3 Installing the Syringe

This section describes the procedure for attaching the syringe to the syringe pump 
assembly.

Depending on the instrument status, flow lines are connected to each of the 8 ports of 
the syringe pump valve. If the syringe is installed or removed without following the 
sequence described below, acid can be released from the syringe connection port. The 
sequence described below must be followed.

CAUTION
• Due to the potential for injury, keep hands away from the sample 

injector during operation of the syringe pump unit.

• The syringe barrel is made of glass and must be handled carefully to 
avoid breakage.

Syringe Replacement Procedure

1. Open the TOC-Control V Sample Table Editor and connect the instrument.

2. From the Instrument menu, select Maintenance>Change Syringe.

The Syringe Change dialog box is displayed.
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4.1.3 Installing the Syringe
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Figure 4.9 Syringe Change Dialog Box

3. Click the Preparation Start button to begin the procedure. A progress bar is 
active while the syringe moves to the position where it can be replaced. 

4. When the progress bar begins blinking, remove the screw at the bottom of the 
syringe pump cover, and remove the cover.

5. Remove the syringe from the syringe connection port of the 8-port valve.

6. Attach the new syringe to the syringe connection port of the 8-port valve.

Note: Do not use tools when replacing the syringe; hand-tighten only. 
Over-tightening can deform the components of the 8-port valve and 
result in leaks.

Figure 4.10 Installing the Syringe

7. Verify that the syringe moves smoothly between the upper and lower positions 
by clicking the directional arrows on the Syringe Change dialog box. 

8. With the syringe in this position, hand-tighten the plunger retaining screw on 
the plunger holder. 

9. Click the Finish Replacement button to move the syringe to its initial position.

Syringe

Plunger
Retaining
Screw
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10. Click the Close button.

Note: Once the syringe is mounted, perform the syringe pump zero point 
detection operation.

4.1.4 Syringe Pump Zero Point Detection

This section describes the procedure for performing automatic detection of the syringe 
pump zero point.

Note: Perform the zero point detection procedure whenever a new syringe is installed 
or the syringe is replaced. 

Procedure

1. Open the TOC-Control V Sample Table Editor and connect the instrument.

2. From the Instrument menu, select Maintenance>Zero Point Detection.

The Zero Point Detection dialog box is displayed.

Figure 4.11 Zero Point Detection Dialog Box

3. Click the Start button. 

A progress bar is active while the syringe moves to the position where the zero 
point can be detected. When the progress bar stops blinking, the procedure is 
complete.

4. Click the Close button.
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4.1.5 Water Supply to the Dehumidifier Drain Container

The drain container must be filled with purified water to prevent carrier gas release 
from the drain tubing.

Procedure

1. Remove the rubber cap from the drain container.

2. Remove the drain container from the installation clip.

3. Introduce purified water (deionized water is acceptable) into the dehumidifier 
drain container up to the level of the drain discharge tube on the side of the 
container.

4. Cap the drain container with the rubber cap.

5. Return the drain container to its position in the installation clip. 

6. Verify that the dehumidifier drain tubing reaches to the bottom of drain 
container.

 CAUTION

Do not bend drain tubing, as this may prevent drain discharge.

Figure 4.12 Filling the Dehumidifier Drain Container 

Rubber Cap

Drain Tubing

Installation Clip
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4.1.6 Preparing the Persulfate Oxidizer Solution

To prepare the oxidizer, dissolve 60g of sodium persulfate and 15mL of phosphoric 
acid (85%) in purified water, and bring to a total volume of 500mL. This solution 
consists of 10.5% sodium persulfate and 3.8% phosphoric acid. It is not necessary to 
measure the reagents with great accuracy. A ±2% degree of accuracy is adequate. It is 
necessary, however, to keep the contaminant concentration in both reagents as low as 
possible. While reagent grade phosphoric acid should be used, it is not easy to find 
reagent grade sodium persulfate. Use sodium persulfate with as low a contaminant 
concentration as possible. Directly after preparing the oxidizer, blank values are high, 
resulting in an adverse affect on accuracy for high sensitivity analysis. It is therefore 
recommended that the persulfate preparation be allowed to stand in a cool, dark 
location for 24 hours before use. The persulfate solution is stable for approximately 
one month when stored in a cool, dark location.

Preparation Procedure

1. Prepare the persulfate solution by dissolving 60g of sodium persulfate and 
15mL of phosphoric acid (85%) in purified water, and diluting to 500mL with 
purified water.

2. Wash the provided persulfate bottle with laboratory detergent, rinse well with 
tap water, and then rinse several times with purified water. 

3. Rinse the persulfate bottle several times with small amounts of the persulfate 
solution, discarding the rinse volume after each rinse. Transfer the remaining 
persulfate solution to the bottle.

4. Place the persulfate bottle on the left side of the instrument.

5. Pass the tubing labeled PERSULFATE through the hole in the cap of the bottle.

6. Attach a cable tie to the tubing to prevent it from being pulled out of the cap. 

7. Place the cap on the persulfate bottle.

Note: Verify that the tip of the tube reaches all the way to the bottom of the 
bottle.

 CAUTION

Sodium persulfate and phosphoric acid are corrosive chemical 
substances. Do not touch or spill these substances. Refer to 
Section 6.9 “Material Safety Data Sheets” for details.
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4.1.7 Preparing Acid

To prepare the acid, mix 100mL of reagent grade phosphoric acid (85%) with purified 
water, and bring to a total volume of 500mL. It is not necessary to measure the reagent 
with great accuracy. A ±2% degree of accuracy is adequate. The phosphoric acid 
solution is stable for approximately one month when stored in a cool, dark location. 

Preparation Procedure

1. Prepare the acid solution by mixing 100mL of phosphoric acid (85%) in 
purified water, and diluting to 500mL with purified water.

2. Wash the provided acid solution bottle with laboratory detergent, rinse well 
with tap water, and then rinse several times with purified water. 

3. Rinse the acid solution bottle several times with small amounts of the acid 
solution, discarding the rinse volume after each rinse. Transfer the remaining 
acid solution to the bottle.

4. Place the acid solution bottle on the left side of the instrument.

5. Pass the tubing labeled H3PO4 through the hole in the cap of the bottle.

6. Attach a cable tie to the tubing to prevent it from being pulled out of the cap. 

7. Place the cap on the acid bottle.

Note: Verify that the tip of the tubing reaches all the way to the bottom of the 
bottle.

 CAUTION

Phosphoric acid is a corrosive chemical substance. Do not touch or 
spill this substance. Refer to Section 6.9 “Material Safety Data 
Sheets” for details.
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4.1.8 Preparation of Dilution Water

This section describes the preparation of water used for automatic sample dilution.

Procedure

1. Wash the provided dilution water bottle with laboratory glassware detergent, 
wash well with tap water, then rinse a number of times with purified water.

2. Fill the container with purified water to the 2 liter level.

3. Place the container on the right front side of the instrument.

4. Pass the dilution water intake tubing, labeled DILUTION, through the hole in 
the cap. 

5. Attach a cable tie, about 200mm from the end of the tubing, to prevent the 
tubing from being pulled out of the cap.

6. Place the cap on the container.

Note: Verify that the tip of the intake tubing nearly reaches the bottom of the 
container.

Figure 4.13 Dilution Water Bottle

Note:  Purified Water

• Use the purest water available.

• To obtain good measurement reproducibility, it is recommended that the water 
in the dilution water bottle be replaced with fresh purified water every day.

• Refer to Section 4.1.11.1 “Preparation of Standard Solutions” for details on 
the degree of purity for “purified water.” 

Dilution

Drain Tubing

Water Bottle
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4.1.9 Installation of the CO2 Absorber

A CO2 absorber is used to remove CO2 from the carrier gas that purges the optical 
system of the detector. The CO2 absorber is installed using the following procedure. 

Procedure

1. Cut the tips of the rigid tubes (2) in the lid of the CO2 absorber with a knife.

2. Connect the flexible tubing that exits the rear panel of the instrument near the 
top as described below.

Tubing labeled “L”: Connect to tube labeled “L” on CO2 absorber.

Tubing labeled “S”: Connect to tube labeled “S” on CO2 absorber.

Note: The flexible tubing should not be bent.

3. Place the CO2 absorber in the holder behind the instrument.

Figure 4.14 CO2 Absorber 
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4.1.10 Adjusting Sparge Gas Flow Rate

The sparge gas flow rate should be adjusted before sparging is performed using the 
optional external sparge kit. The procedure for adjusting the sparge gas flow rate is 
described below. 

Procedure

1. Open the TOC-Control V Sample Table Editor and connect the instrument.

2. From the Instrument menu, select Maintenance>Sparge Gas Valve.

The sparge gas solenoid valve opens and sparge gas begins to flow.

3. Open the front door of the instrument.

4. Adjust the flow rate to about 100mL/min using the sparge gas flow rate 
adjustment knob.

Note: The flow rate should be adjusted according to the size and shape of the 
sample container.

5. Close the front door of the instrument.

Figure 4.15 Sparge Gas Flow Rate Adjustment
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4.1.11 Preparation and Storage of Standard Solutions

4.1.11.1 Preparation of Standard Solutions

Zero Water

Zero water refers to a standard solution with zero concentration of TC or IC, or the 
water used to prepare these standard solutions. Water that is in theory absolutely free of 
carbon (TC) is used as zero water. It is difficult, in practice, to obtain this type of water. 
Even ultra-pure water obtained using a high-performance membrane technique or 
water that has been repeatedly distilled has a TC content of about 10µg/L. This value is 
measured directly after manufacture, and increases when the water is stored in a 
container. Carbon dioxide is contained in the atmosphere at 300-500mg/L. The CO2 
content is higher in a room with many people, or where combustion equipment is used. 
This carbon dioxide dissolves in the water and is present as IC. The dissolved amount 
is generally about 0.2mg/L, but is dependent on the water temperature and carbon 
dioxide content of the air in contact with the water. Refer to Table 6.2 “CO2 Content 
(ppm) in Distilled Water Equilibrated with Atmosphere Temperature (°C)”. 
Instruments that prevent contact with air are not incorporated in water up-take, 
retention or storage during common distillation and purification of water. For this 
reason, IC is present in most distilled or purified water. There are cases where the TC 
content in distilled water commercially available in plastic or glass containers is 
1mg/L.

Note: The purity of water required for zero water varies depending on the analysis 
range. There would be no problems using commercially available purified 
water when a 100mg/L sample is measured. The quality of the zero water 
should be considered along with the analysis range.

Preparation of TC Standard Solutions 

1. Accurately weigh 2.125g of reagent grade potassium hydrogen phthalate 
previously dried at 105-120°C for about 1 hour and cooled in a desiccator.

2. Transfer to a 1L volumetric flask and dissolve in zero water.

3. Add zero water to the 1L mark, and stir the solution.

The carbon concentration of the solution is equivalent to 1000mg/L and will be 
denoted as 1000mg C/L. This solution is retained as the standard stock 
solution. Here, the standard concentration of 1000mg/L is denoted as 
1000mgC/L.

Note: The standard stock solution may be prepared at other concentrations. 
For example, a 2000mg C/L solution may be used as the standard 
stock solution.
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4. The standard stock solution is diluted with zero water to prepare standard 
solutions at the required concentrations.

Note: The TC standard solution reagent need not be potassium hydrogen 
phthalate. Depending on the application, other substances are also 
acceptable (e.g., sucrose, etc.).

Preparation of IC Standard Solution 

1. Accurately weigh 3.50g of reagent grade sodium bicarbonate (bottle labeled 
sodium hydrogen carbonate) previously dried for 2 hours in a silica gel 
desiccator, and 4.41g of sodium carbonate previously dried for 1 hour at 
280-290°C and cooled in a desiccator.

2. Transfer the weighed materials to a 1L volumetric flask.

3. Add zero water to the 1L mark.

4. Stir well to mix.

This solution is equivalent to 1000mg C/L and is referred to below as the “IC 
Standard Solution”.

4.1.11.2 Storage of Standard Solutions

The standard solutions undergo concentration changes when stored even for short 
periods, particularly the low-concentration solutions. Therefore, it is recommended 
that high concentration standard stock solutions (for example, 1000mgC/L) be stored 
in airtight containers in a cool, dark place. Glass bottles are suitable storage containers.

Storage Time

The limitation on storage of standard solutions is about 2 months for 1000mg C/L 
standard stock solutions, and about 1 week for diluted standard solutions (for example, 
100mg C/L). These limitations are for sealed containers in cold storage.

Note: IC standard solution absorbs atmospheric carbon dioxide and undergoes 
concentration changes, so it is particularly important to store this solution in a 
sealed container.

Prepare Fresh Standard Solutions

• If reproducibility of analysis values is poor, or concentration values fluctuate.

• If contaminants, even small amounts of dust, are present in the standard 
solution.
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4.1.12 Sample Preparation

4.1.12.1 High Sensitivity Analysis 

High sensitivity analysis refers to measurement of trace amounts (commonly 0.5mg/L 
or less) of TOC in samples such as ultra-pure water. The precautions described in the 
sections below should be followed when conducting trace analysis on the order of 
10-100µg/L.

Precautions for High Sensitivity Analysis

Measure Samples Immediately

Samples containing trace carbon, such as ultra-pure water, should be measured 
immediately after collection. If analysis cannot be performed immediately, 
store the sample in a dark location without freezing at 0-10°C, and perform 
analysis as soon as possible. 

To collect the water, introduce water into a well-washed container, leaving no 
headspace, and seal the container. 

Use Glass Sample Containers

Glass containers are optimal for use as sample containers. 500mL - 1L 
commercially available glass screw-lid jars with Teflon seals (generally 
referred to as heat-resistant screw-top jars or hermetic jars) are appropriate for 
use as water collection and transport containers.

Note: Exercise caution when using plastic containers, as the elution of TOC 
components may occur.

Use NPOC for Analysis of Ultra-pure Water

Use the NPOC method for analysis of ultra-pure water samples. TOC 
determination using the difference between TC and IC is prone to large 
analysis errors for the following reasons:

• The TOC value is significantly affected since a large portion of TC 
often comprises IC. Errors in TC analysis and IC analysis are additive. 

• Carbon dioxide is absorbed from the atmosphere during sample 
collection and analysis. During the elapsed time between TC analysis 
and IC analysis, the sample absorbs more carbon from the atmosphere, 
causing the IC result to be higher than the IC content in the TC result. 
Therefore, subtracting the elevated IC result from the TC yields a 
biased TOC value. 

• The TOC value can also be greatly influenced if standard solutions are 
not prepared and measured carefully. Errors are compounded since 
two calibration curves must be generated for TC and IC.

• In NPOC analysis, POC (purgeable organic carbon) may be volatilized 
from the sample during sparging for IC removal. This is not a problem 
since the ultra-pure water contains practically no POC.
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Calibration Curve Generation and Sample Analysis

Minimize contamination of the sample due to the addition of oxidation acid by 
limiting the amount of acid added to obtain a final sample pH of 4 or less. 
Determine the appropriate volume of acid to be added beforehand, by carrying 
out trial oxidation using a graduated cylinder, etc. 

If the volume of acid added is less than 100µL, analytical reproducibility 
decreases due to fluctuation in the volume of acid added. Establish the absolute 
volume to be added to be at least 100µL, though the addition volume is 
actually set using a percentage of the volume of sample injected.

A 2-point calibration curve that passes through the origin is used for sample 
measurement. The case below describes the generation of a 2-point calibration 
curve shifted to pass through the origin. The concentrations used are 0µg/L 
and 400µg/L.

Cautions in Calibration Curve Generation and Sample Measurement Using High 
Sensitivity Analysis

The case below describes the generation of a 2-point calibration curve shifted through 
the origin. The calibration standard concentrations are 0µg/L and 400µg/L.

Preparation of Standard Solutions

A 2-point calibration curve using 0µg/L and 400µg/L is generated. The 
calibration curve is shifted through the origin to correct for the TC contained in 
purified water used for preparation of the standard solutions.

The 0µg/L and 400µg/L TC standard solutions should be prepared at the same 
time using the same purified water. Wash well, two 250mL volumetric flasks 
with purified water (preferably water containing low TC concentration). 
Carefully introduce 1mL of 100mg/L TC standard stock solution (for a 
400µg/L solution) into one of the volumetric flasks. Distilled water is 
introduced up to the graduation line in both volumetric flasks.

Standard preparation procedures should be performed as quickly as possible, 
using caution to avoid inclusion of external contaminants. If a water 
purification apparatus is the source of purified water, allow the water to flow 
for a few minutes prior to use, as the initial water will have a higher TC 
concentration. Alternate the flasks a number of times while filling them with 
water to equalize, as much as possible, the TC concentration of the purified 
water.

Use fresh purified water when filling the volumetric flask to the graduation 
line. Do not use rinse bottle water that has been standing for a long period of 
time because the TC concentration continually increases with time.
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Instrument Preparation

The blank peaks present at the start of high sensitivity analysis will become 
progressively smaller and gradually stabilize. As a result, calibration curves 
generated too soon after the start of analysis may be inaccurate because they 
contain data collected during unstable conditions. To prevent this problem, 
perform 5 or more measurements of purified water containing 2-3 drops of 1M 
HCl per 100mL of water prior to analyzing the calibration standards. Use the 
same measurement parameters (injection volume, sparge time) that will be 
used for the calibration standards and samples. 

Calibration Curve Analyses

Calibration curves are generated using the following two methods.

1) Using standard solution in a 250mL volumetric flask

Insert the sample tubing directly into the volumetric flask until it 
reaches the bottom of the flask. Perform analyses quickly. Four to five 
repeated analyses can be made with almost no effects from the 
absorption of atmospheric carbon dioxide. Cover the opening of the 
volumetric flask with sealing film or paraffin to prevent 
contamination. Use this method when the IC value of the purified 
water used for standard solution preparation (specifically, 0µg/L 
standard solution) is about 50µg/L or less.

2) Sparging the standard solution

To sparge in the sample injection syringe, set the acid addition ratio to 
0.5%, and the sparge time to 2 minutes. To sparge using the optional 
external sparge kit, transfer about 60mL of the standard solution to a 
clean sample container, add 1-2 drops of 2M hydrochloric acid, sparge 
for 10 minutes and analyze.

Cover the sample container with paraffin or sealing film to prevent 
contamination. A glass container with an external diameter of 
24-25mm and a height of 200-250mm is appropriate. Test tubes, 
stopper-equipped test tubes and chromatography tubes of suitable size 
are available commercially. If the outer diameter of the container is too 
large, the air-to-water contact efficiency is decreased, requiring a 
longer sparge time. Ensuring that the tip of the sparge tube is near the 
bottom of the container will improve the sparging efficiency.

Reference: Refer toSection 4.3.2 “Tutorial” andSection 4.4.2.2 “Calibration Curve” for detailed 
descriptions of generating calibration curves using the TOC-Control V software.
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Sample Analysis

Use the standard curve generated in the previous section and measure the 
NPOC of the sample. Measure the sample using the same method described in 
method 2) above for measuring standard solutions. If the values gradually 
decrease with each repeated analysis using the optional external sparge kit, 
extend the sparge time to ensure sufficient sparging. The shape of the sample 
container, sample volume, amount of sparge gas and IC content of the sample 
all have a bearing on the required sparge time. Determine the appropriate 
sparge time in accordance with these factors.

4.1.12.2 Pretreatment for IC Removal (Sparging)

Errors for TC and IC analyses are additive. For samples that have a comparatively high 
IC content relative to the TOC content, the TOC analysis error is large if it is 
determined by the difference between TC and IC results. Samples of this type include 
samples from the natural environment such as rivers, lakes, swamps, oceans and 
ground water, or samples from water treatment facilities.

Using the difference between TC and IC to determine TOC is not appropriate for 
purified water or ultra-pure water samples. This is because the CO2 in air dissolves in 
the sample and is measured as IC; this concentration tends to vary.

In such cases, the sample is pretreated with aeration or sparging before analysis to 
remove the IC. The sample is then subjected to TC analysis, immediately followed by 
TOC analysis using the NPOC method.

Sparge Sequence

There are 2 methods available for performing sparging with this instrument.

1) Sparging within the IC reactor for a set time, followed by 
measurement

Refer to Section 4.3.2 “Tutorial” for details on the measurement 
method.

2) Independent sparging of sample using the optional external sparge kit

Transfer the sample to a clean sample container, acidify the sample 
and then perform sparging. A glass container with an external 
diameter of 24-25mm and a height of 200-250mm is appropriate, 
however, to generate a calibration curve with a full scale of 50µg/L or 
less, 20-70mL of standard solution are required (for repeat 
measurement), requiring a larger container. There are test tubes, 
stopper-equipped test tubes and chromatography tubes of suitable size 
available commercially. If the outer diameter or the container is too 
large, the sparge gas-to-water contact efficiency is decreased, 
requiring a longer sparge time. 
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Sparge Procedure

1. Start delivery of the sparge gas using the procedure described for adjusting the 
gas flow.

Reference: Refer to Section 4.1.10 “Adjusting Sparge Gas Flow Rate” for details.

2. Add concentrated phosphoric acid (85%) which has been diluted by a factor of 
5 to acidify the sample to a pH of 2-3.

3. Insert the sparge tubing into the sample.

To improve the sparging efficiency, the tip of the sparge tubing should be as 
close to the bottom of the sample container as possible.

By this method, sparge gas can be used independently. While the first sample is being 
measured, the next sample can be sparged, thereby improving analysis efficiency.

About Sparge Time

In nearly all cases, IC is adequately removed by sparging within the IC reactor for 
3 minutes. When the concentration of IC is high, for example 10mg/L of IC, set the 
sparge time to 4-5 minutes to remove 99+% of the IC.

Conversely, when the concentration of IC is extremely small, as in the case of purified 
water samples, a sparge time of less than 3 minutes should be sufficient to achieve 
adequate IC removal.

If the optional external sparge kit is used to perform sparging outside the instrument, or 
if sparging is performed inside the vial placed in the autosampler, processing 
conditions must be investigated as mentioned above.

4.1.12.3 Persulfate Addition Volume

The persulfate solution is added automatically in TC and NPOC measurement. The 
volume of persulfate to be added is set in the Conditions setting screen. The default 
addition volume is 1.5mL, which usually provides adequate oxidation for analysis. 

If the peak shape broadens and the TC reactor temperature, carrier gas flow and other 
instrument conditions are normal, the situation may be improved by increasing the 
volume of persulfate. This helps sharpen the peak shape if the sample inadvertently 
contains non-dissolved organic substances. Increasing the amount of persulfate beyond 
the default values should only be used in such instances. Changing the volume of 
persulfate added to the sample when it is not necessary chemically results only in using 
more persulfate. If it is determined that all of the organic substances in the sample are 
easily decomposed, the volume of persulfate may be reduced based on examination of 
the factors (recovery rate examination). If the volume added is smaller than 100µL, 
reproducibility is adversely affected due to fluctuation of the volume of persulfate 
added. Therefore, set the addition amount so that the actual volume added is at least 
100µL. 
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4.1.12.4 Acid Addition Volume

The acid solution is added automatically in IC and NPOC measurement. The volume of 
acid to be added is set in the Conditions setting screen. The default volume is 3% of the 
total volume of sample processed in the IC reactor. This usually provides adequate 
acidification but may be insufficient depending on the sample characteristics. If the IC 
measurement peaks broaden under normal carrier gas flow and other instrument 
conditions, or if IC removal is insufficient in NPOC measurement, increasing the 
volume of acid so that the final pH is 2-3 may be effective. The volume added should 
be determined by trial testing beforehand. Conversely, when performing high 
sensitivity analysis, the volume added can be reduced to suppress the background from 
the acid. See Section 4.1.12.1 “High Sensitivity Analysis” for more details.

Note: In analyses where IC exceeds 5mg/L, the sample injection volume displayed 
on the screen is less than 3mL. The sample volume is diluted to 3mL with the 
addition of dilution water to the sample in the IC reactor. The volume of acid is 
calculated based on this total volume. 

The total volume used to perform sparging for NPOC measurement is about 
5mL at least, depending on the number of measurement repetitions and 
whether or not auto dilution of the sample is conducted. The volume of acid 
added is calculated as a percentage of the total sample volume. 

4.1.12.5 Measurement of Samples Containing Suspended Solids

In the TOC-VWP, persulfate reagent is added to the sample, which is then subjected to 
ultraviolet irradiation and heat to oxidize the organic component of the sample. The 
recovery rate varies for samples that contain non-dissolved organic substances or 
suspended particles. This is most obvious when the non-dissolved organic substances 
are inadvertently decomposed or if substances are difficult to decompose causing them 
to be oxidized non-uniformly.

Therefore, it is important to filter sample suspensions and to analyze only the filtrate. 
When the sample contains sedimenting suspended particles, set the sample aside and 
allow the solids to completely settle out, then analyze the supernatant liquid. 

If samples are analyzed with the suspended particles present, wash the TC reactor 
(Section 5.2.5 “Washing the TC Reactor”) and IC reactor (Section 5.2.6 “Washing the 
IC Reactor”) frequently to prevent buildup of residual suspended solids in the flow 
line, which could cause carryover or blockage.

Heavy solids that settle quickly, such as soil and sand, remain at the bottom of the 
syringe and can scratch the rotor of the 8-port valve. Separate out such sedimentation 
before analysis. 
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Countermeasures

Perform one of the following processing procedures before analyzing samples that 
contain suspended particles.

1) TOC measurement of sample supernatant 

Set the sample suspension aside and allow the particles to settle to the 
bottom of the sample container. Use only the supernatant liquid as the 
sample. Depending on the sedimentation characteristics of the 
suspended particles, the soluble TOC (DOC: Dissolved Organic 
Carbon) is analyzed in this method.

2) TOC measurement of filtrate

The filter paper or membrane filter may contain TOC that could 
contaminate the sample. Heat the glass filter paper before use. Then 
use water or the sample solution to wash away any TOC in the filter.

Filter the sample through glass fiber paper or a membrane filter to 
remove the suspended particles. The dissolved TOC in the filtrate is 
analyzed. 

4.1.12.6 Handling Samples Containing Acids, Bases or Salts

When samples contain halogens, various adverse effects such as reduction in the 
recovery rate and poor peak shape are evident in TC and NPOC analysis. The degree to 
which these effects are manifested depends on the absolute amount of the halogen 
injected into the TC reactor. 

The table below gives the maximum concentration limits at which the halogen (e.g., 
chloride ion) does not produce the above-mentioned effects. 

The effects of the halogen are relatively large with respect to the small peaks when 
measuring concentrations up to 1mg/L. If 50mg/L of chloride ion is present in a 
10µg/mL sample, measurement is not possible. 

When halogen is present in samples having high TOC concentrations, dilute the sample 
to reduce the adverse effects of the halogen. If the calibration curve concentration is set 
to 70mg/L or greater, dilution is performed automatically in the TOC analyzer (2-50 
times, depending on the set value).

If sample dilution is not an option due to low TOC concentration, the injection volume 
might be reduced by using a larger calibration curve concentration setting. 
Measurement reproducibility may be decreased when a smaller injection volume is 
used. 

Table 4.1 Halogen Concentration Maximum Limit (Example: Chloride Ion)

Calibration Curve 
Concentration 

Injection Volume (Auto-
matically set value)

Halogen Concentration 
Maximum Limit (Chloride 

ion)

1mg/L 3mL 500mg/L

50mg/L 0.5mL 3000mg/L
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4.1.13 Sample Preparation for Autosampler Measurement

4.1.13.1 Vial Types

There are 2 types of autosampler vials. Since the TOC-VWP is most often used for high 
sensitivity measurement or measurement of low concentration samples, use the 40mL 
and 125m vials because they conserve sample and reduce contamination of the sample 
from the inner wall of the vial. The 125mL vial is recommended for analyzing samples 
with extremely low concentrations on the order of 100µg/L.

Use the sample volumes indicated in the following table for the corresponding vial 
type. Using volumes less than those listed below may result in an insufficient amount 
of sample for analysis
.

1 Sample volume when vial is filled to the bottom of vial cap.
2 Sample volume when vial is filled to 1cm from bottom of vial cap.

In NPOC analysis, the sample volume is decreased to reduce contact with the sample 
cap during sparging. Sparging cannot be performed in the vial when using 125 mL 
vials.

Note: Vials to be used for the first time should be washed with laboratory detergent 
and then rinsed well with purified water. Alternatively, certified precleaned 
vials can be purchased.

Maximum Number of Measurements by Vial Type 

When using the 40mL and 125mL vials and the volume of sample indicated above, the 
relationships between the full-scale values of the calibration curve and the maximum 
possible number of measurements are indicated in the following tables. These are 
based on use of a single wash (default).

Table 4.2 Vial Types

Vial Typical Sample Volume1 Sample Volume for NPOC Analysis2

40mL 40mL 35mL

125mL 125mL 105mL

Table 4.3 40mL Vials

Calibration Curve 
Full Scale Maximum Number of Measurements

NPOC Analysis TC Analysis TC-IC Analysis

25µg/L 1 1 _

50µg/L 2 2 1

100µg/L 3 4 2

200µg/L - 5mg/L 5 5 2

10mg/L 5 6 3

20mg/L 7 8 4

50mg/L - 3500mg/L 9 or more 10 or more 5 or more
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4.1.13.2 Filling Vials with Sample

Under normal operation conditions, open vials may be used for analyzing samples with 
the autosampler. In the following situations, however, the vials must be sealed: 

1) sparging with the autosampler for NPOC analysis 

2) measuring acidic samples

3) IC analysis 

4) POC analysis

5) low-concentration samples (as a guideline, less than 10mg/L) 

6) alkaline samples (pH 7 or higher)

7) samples that contain volatile organic hydrocarbon components

8) a large number of samples to be measured 

9) standard solutions

In situations (1) and (2) above, corrosion of the instrument may occur due to 
spattering of sample, which contains acid. If the samples are left in the 
autosampler following measurement, there is danger that the autosampler may 
be subjected to corrosion due to the volatilization of acid. 

In situations (3) through (9), analysis values are affected by contamination of 
absorbed CO2 from the atmosphere or volatilization of the TOC component in 
the sample.

Methods of Sealing Vials

There are two acceptable methods of sealing the sample vials.

1) Using the caps provided with the vials.

Note: Use caps only after washing them with water or laboratory cleaning 
solution, and then rinsing well with purified water.

2) Using a paraffin-based sealing film marketed under names such as 
Parafilm.

Table 4.4 125mL Vials

Calibration Curve 
Full Scale Maximum Number of Measurements

NPOC Analysis TC Analysis TC-IC Analysis

25µg/L 4 4 2

50µg/L 7 8 4

100µg/L 11 13 6

200µg/L - 3500mg/L 16 or more 18 or more 9 or more



4.1 Analysis Preparation
4.1.13 Sample Preparation for Autosampler Measurement

TOC-VWP54

Using Caps

125mL vials

Caps and seals are provided with the vials. 

1. Place a seal over the vial opening. 

Note: Because the seals are perforated during injection, discard the seals 
after use. 

2. Place the vial cap over the seal. 

For 40mL vials

Seal-equipped caps are provided with the vials.

1. Using a seal-equipped cap provides an adequate seal for the vial. 

Note: Because the seals are perforated during injection, discard the 
seal-equipped cap after use.

Using Paraffin-based Sealing Films 

Procedure

1. Cut the sealing film into approximately 25mm x 25mm (1inch x 1inch) 
squares. 

2. Place a sealing film square over the opening of the vial, and stretch it to seal it 
to the edges of the vials. 

3. Press the edges down so that they wrap around the outside of the vial.

Figure 4.16 Sealing the Vial

Do not allow
film edges
to descend below
vial threads.
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4.1.13.3 Placing Vials in the Vial Rack

Remove the vial rack from the ASI-V before placing the sample vials in it. There are 
three different types of vial racks, each accommodating a different vial size.

The ASI-V permits random access of vials in the vial rack. The vials are measured 
according to the sequence set in the “ASI Schedule Settings” screen, thus analysis can 
start from any position number in the vial rack and occur in a non-sequential vial order.

TIP: When samples are to be sparged using the optional external sparge kit, analysis can be 
performed more efficiently if the vials are placed in sequential rack-positions without 
gaps, so the vial adjacent to the vial being measured can be sparged.

Installing the Vial Rack 

Install the rack using the following procedure.

1. Place the vial rack containing vials on the ASI-V turntable.

2. Place the cover over the turntable.

Note: During analysis, the turntable must be covered. The ASI-V will not 
operate if the turntable cover is not detected.

4.1.13.4 High Sensitivity Measurement using the Autosampler

When using the autosampler to analyze pure and ultra-pure water samples having 
carbon concentrations on the order of a few hundred µg/L, the following high 
sensitivity measurement precautions must be taken. Refer to Section 4.1.12.1 “High 
Sensitivity Analysis” for details.

• NPOC analysis is recommended because TOC (TC-IC) analysis tends to have 
a greater variation in measured values than NPOC.

IC often accounts for a significant portion of the TC. Errors in the two values 
are additive using TOC (TC-IC) analysis. This significantly influences TOC 
analysis.

• For analysis of calibration curves, fill well-washed vials with standard 
solutions to about 5-10mm from the top and seal immediately.

Use a cap that has been rinsed with purified water before use.

When placing the vial in the rack, handle the vial carefully to prevent the 
standard solution contacting the cap. 

Low-concentration standard solutions must be prepared each time they are 
used.
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• The automatic IC removal process of acidification and sparging for NPOC 
analysis can be performed inside the vial of the autosampler or in the 
TOC-VWP unit. The optional external sparge kit is required when performed 
inside the vial. Automatic IC removal should be performed in the TOC-VWP 
for sample concentrations up to 500µg/L for the following reasons.

• There is a risk that a slight amount of IC may be re-dissolved into the 
sample during measurement when IC removal is performed inside the 
vial.

• There is a risk of sample contamination when the needle pierces the 
seal during automatic acid addition in the vial. 

• To stabilize the peaks, perform 4 - 5 injections using the same analysis 
parameters before performing the calibration curve analysis. For example, to 
generate a 400µg/L calibration curve, set 400µg/L as the 1st standard solution 
concentration, and enter 1 as the vial number. Place a 0µg/L solution in vial 
position 1. The objective is to inject water using the same injection volume 
used for the calibration curve. This stabilizes peaks and thoroughly washes the 
sample needle and sparge needle with purified water before generating the 
calibration curve. 

In the 2nd row of the settings screen and using the same calibration curve 
number as above, set the analysis parameters for 0µg/L and 400µg/L. Place the 
standard solutions in the rack after the stabilizing injections are complete.

• Acid addition for NPOC analysis can be performed automatically using the 
autosampler. It is best to perform manual addition of phosphoric acid for 
NPOC analysis on the order of 10µg/L. This is because, automatic acid 
addition pierces a hole in the seal, allowing CO2 contamination from the air.

• If the number of needle washes is set to “0” in the “Instrument Settings - ASI” 
dialog box, the needle is not washed.

Even if ultra-pure water is used for analysis on the order of 100µg/L, the 
concentration increases in the wash water during the time it is exposed. 
Therefore, better results are obtained in this situation if the needle is not 
washed.

• Do not use the analysis value acquired from the first sample vial. In sample 
analysis, particularly analysis on the order of 10µg/L, the first sample 
measured may yield high results.

• When using the optional external sparge kit, perform sparging using a sparge 
gas flow rate 100mL/min.

As a guideline, use a sparge time of 5-10min for 40mL vials. Increase the gas 
flow rate or sparge time if sparging is insufficient.
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4.1.13.5 Acid Addition in NPOC Analysis

Automatic addition of acid is possible using the autosampler when the optional 
external sparge kit is installed. Using the ASI-V, acidification and sparging can be 
performed on samples during NPOC analysis. To perform acid addition using the 
autosampler, first enter the acid addition amount in the “Measurement Parameters” 
screen.

Acid is drawn from the acid bottle into the syringe, and the set amount of acid is added 
from the sample needle into each of the vials that have been designated for acid 
addition. The phosphoric acid should be diluted 5 times. The acid addition ratio (ratio 
of acid with respect to sample) is generally set to about 3%. A setting of about 1% is 
used for purified water analysis.

The phosphoric acid concentration or amount added should be adjusted in accordance 
with the sample pH or buffering strength to bring the sample pH to 2-3. Before 
analysis, verify the pH using pH paper. The pH need not be checked each time if the 
same type of sample is routinely measured.

 CAUTION

Phosphoric acid is a hazardous chemical. Exercise caution when 
handling to prevent contact and spills. Refer to Section 6.9 “Material 
Safety Data Sheets” for details.

If the sample pH does not reach between pH 2-3, increase the acid addition ratio or the 
acid concentration. Increasing the acid addition ratio results in dilution of the sample. 
If the acid amount is too small, the acid droplet on the tip of the needle may not 
become large enough to drop from the needle. Visually observe the acid droplet to 
confirm that it is actually added to the sample. 

If [Rinse after Acid Addition] is selected in the “Instrument Settings - ASI” dialog box, 
and a value is entered for the number of washes, the needle is rinsed after every acid 
addition. To save time during the analysis sequence, washing of the needle is not 
required when there is very little variation in NPOC concentration among the samples.

4.1.13.6 Sparging in NPOC Analysis 

By using the optional external sparge kit, the next sample vial in the autosampler tray 
can be sparged while the first sample is being analyzed. External sparging is not 
available with the 125mL vials.

If the additional sparge needle is used for the 40mL vials, the next vial to be measured 
can be sparged while the vial in the sampling position is being measured. Sparging is 
not performed again when the previously sparged vial is moved to the sampling 
position. This does not affect the mg/L level NPOC analysis.

For NPOC measurement of samples with concentrations in the order of several 
hundreds µg/L, perform the IC removal process in the TOC-VWP. Refer to 
Section 4.1.13.4 “High Sensitivity Measurement using the Autosampler” for details.

Verify that the sparge gas flow is not so great as to cause sample to splatter onto the 
seal of the vial cap.

Test the completeness of the IC removal by performing IC measurement on the sample 
remaining after NPOC measurement.



4.1 Analysis Preparation
4.1.14 8-Port Sampler Measurement

TOC-VWP58

4.1.14 8-Port Sampler Measurement

4.1.14.1 Type of Sampler Container

There are no restrictions on the type of sample containers that can be used with the 
8-port sampler. It is only necessary that the containers be placed so the sample tubing 
from the various ports can be inserted directly into the containers. 

Note: Wash all sample containers with an appropriate laboratory detergent, and rinse 
them thoroughly with water before using them for the first time. 

4.1.14.2 Loading the Sample

Although it is possible to perform measurement of a sample using the 8-port sampler 
while the container is open, in the following situations, it is necessary to seal the 
sample container. 

1) When performing IC measurement

2) When performing POC measurement

3) When performing measurement of low concentration samples 
(e.g., 10 mg/L)

4) When performing measurement of alkali samples of pH 7 or higher 

5) When performing measurement of samples containing volatile organic 
carbon compounds

6) When the number of samples is so great as to require a long 
measurement time

7) When performing measurement of standard solutions

Note: If the sample container openings are not sealed in the situations listed above, 
measurement values may be influenced by such factors as absorption of 
atmospheric CO2, contamination with carbon containing substances, and 
evaporation of TOC constituents from the samples. 

Sealing the Sample Containers

Sample containers may be sealed using commercial sealing films such as Parafilm. It is 
also possible to pierce the lid of the container and insert the sample tubing into the 
container through this opening. 

Note: In either case, wash the container with a laboratory detergent, and rinse it 
thoroughly with water before use. 



4.1 Analysis Preparation
4.1.14 8-Port Sampler Measurement

59TOC-VWP

Sealing Procedure Using Parafilm

1. Cut a piece of Parafilm to size according to the size of the sample vessel 
opening.

2. Insert the tip of the sampling tube into the vessel, cover the opening with the 
prepared Parafilm, and seal the opening of the vessel, stretching the Parafilm 
over the edges. Be sure that a very small gap in the seal is formed to prevent 
creation of negative pressure inside the vessel. 

3. Press the overlapping portions of the Parafilm around the neck of the opening.

Figure 4.17 Sealing the Container

Parafilm
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4.1.14.3 High Sensitivity Using the 8-Port Sampler

If samples such as purified water or ultra-pure water, having a TOC concentration of 
100ppb or less, are to be measured using the 8-Port Sampler, it is necessary to consider 
the following precautions associated with high sensitivity analysis. Refer to 
Section 4.1.13.4 “High Sensitivity Measurement using the Autosampler” for more 
information.

1) NPOC analysis is recommended because TOC (TC-IC) analysis tends 
to have a greater variation in measured values than NPOC. This is 
because IC often accounts for a significant portion of the TC, and the 
errors in the two values are additive using TOC (TC-IC) analysis. This 
affect significantly influences TOC analysis. 

2) For calibration measurement of standard solutions, fill well-washed 
containers with standard solutions to about 5-10 mm from the top of 
the container, and immediately seal each container. When placing the 
container below the 8-port sampler, handle it carefully to avoid the 
standard solution contacting the sealing surface. Low-concentration 
standard solutions must be prepared each time they are used. 

3) To ensure that the peaks are stable for generating the calibration curve, 
perform 4-5 injections using the same analysis parameters prior to 
performing the calibration curve analysis. For example, to generate a 
400ppb calibration curve, set 400ppb as the 1st standard solution 
concentration, and enter 1 as the container number. Actually place a 
0ppb solution in the container for port No. 1. The objective at this 
point is not to generate a calibration curve, but to inject water using the 
same injection volume that will be used to generate the calibration 
curve. This not only stabilizes the instrument but also thoroughly 
washes the sampling needle with purified water. 

In the 2nd row of the settings screen and using the same calibration 
curve number as above, set the analysis parameters for 0ppb and 
400ppb. When sample measurement starts, the calibration curve to be 
used will be created with the correct standard solutions. 
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4.2 Setting General Measurement Parameters

4.2.1 TOC Parameter Settings

The following parameters must be entered to perform analysis using the PC-controlled 
TOC-V analyzer: The items available for editing change depending on the options that 
are installed.

• UV Lamp

• Reactor Temp On

• Buzzer

• Enable ready status check
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Setting Procedure

1. In the TOC-Control V main window, double-click the icon for the desired 
instrument.

The Instrument Properties dialog box is displayed.

Figure 4.18 Instrument Properties Dialog Box: TOC Tab

2. Click the TOC tab.

The Main Unit Version field displays the instrument version number; this field 
cannot be changed by the user.

3. Enter the parameters as described below:

UV Lamp

Turns on the UV lamp inside the TC reactor. Place a check mark here to turn 
on the UV lamp.

Reactor Temp On

Turns on the TC reactor heater. Place a check mark here to turn on the heater.

Buzzer

Enables the internal buzzer function. Select this option to allow the buzzer to 
sound during measurement.

Enable ready status check

Enables the Ready Status Check function. When the function is selected, the 
software always verifies that the instrument is in the Ready state prior to 
starting measurement. Selecting the Ready Status Check function is 
recommended. When the function is deselected, measurement can be 
performed when the instrument is not in the Ready state, an option that is 
mainly for use by service personnel.
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4.2.2 ASI Parameter Settings

The following parameters must be set when using the ASI-V:

• Tray type

• Needle

• No. of Needle Washes

• No. of Flow Line Washes

• Rinse

• Rinse after acid addition

Procedure

1. In the TOC-Control V main window, double-click the icon for the desired 
instrument.

The Instrument Properties dialog box is displayed.

2. Click the ASI tab.

Figure 4.19 Instrument Properties Dialog Box: ASI Tab

3. Set the following parameters:
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Tray Type

Specifies the size of the vials used in the ASI rack. Select the vial size from the 
drop-down list. The options are 40mL Vial and 125mL Vial.

Needle

Specifies the type of needle used for analysis. Select the needle type from the 
drop-down list. Options include:

• Sample: for analysis using only a sample needle. Sparging for NPOC 
measurement is performed inside the TOC-V unit.

• Sample+Sparge: for analysis using both a sample needle and a sparge 
needle. Sparging for NPOC analysis is performed inside the needle 
when both the when both the sampling and sparge needles are used 
with the external sparge kit.

Note: When using the 125mL vials, only a single needle can be used. Select the 
Sample needle option.

The instrument does not automatically recognize the type of needle installed. 
Be sure to select the type of needle that is actually installed on the instrument.

No. of Needle Washes

Specifies the number of times the needle is rinsed after sample injection. This 
operation rinses the outside of the needle using water drawn from the ASI 
water bottle. This function is not used for analysis of purified water and tap 
water samples.

Enter a number ranging from 0 to 10 in the No. of Needle Washes field.

No. of Flow Line Washes

Specifies the number of times the flow lines are rinsed after all samples listed 
in the Sample Table have been measured. This operation rinses the flow line 
from the sample needle to the injection tubing using water drawn from the ASI 
water bottle. If the automatic acid addition option has been selected, the flow 
lines are rinsed the specified number of times following acid addition to each 
sample; rinsing after acid addition removes acid that remains in the sample 
needle or flow lines. This function is not used for analysis of purified water 
and tap water samples.

Enter a number ranging from 0 to 10 in the No. of Flow Line Washes field.
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Rinse

Enables automatic rinsing of the sample needle and sparge needle between 
each sample using water from the ASI water bottle.

• Rinsing between each sample prevents carryover from one sample to 
the next. Rinsing is not necessary if all samples contain similar carbon 
concentrations.

• Rinsing is not recommended when analyzing ultra-pure water samples 
with expected concentrations of less than a few hundred µg/L. The 
concentration of carbon in the rinse water may affect the sample 
results. Rinsing with ultra-pure water does not reduce this effect, as the 
concentration of carbon in the rinse water increases with exposure to 
the atmosphere.

Rinse after acid addition

Enables automatic rinsing of the sample needle and flow lines after each acid 
addition. 

Note: Rinsing the needle after each acid addition is not necessary if all 
samples contain similar NPOC concentrations. Eliminating the rinsing 
operation saves time during the analysis sequence. 
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4.2.3 Setting Default Measurement Parameters

The Default Measurement Parameters window is used to enter the default values for 
sample measurement parameters. The selections made in the Default Measurement 
Parameters window are displayed as the default values when setting calibration curve 
and sample measurement parameters.

Procedure

1. From the Options menu in the Sample Table Editor, select Default 
Measurement Parameters.

The Default Measurement Parameters window is displayed.

Figure 4.20 Default Measurement Parameters: TC Tab

2. Set the parameters on each of the applicable tabs.

• Units: Select the default concentration units for the measurement results.

• No. of injections: Enter the default minimum/maximum number of injections.

• No. of washes: Enter the default number of times the syringe is washed with 
sample prior to the first injection.

• Max SD: Enter the default maximum standard deviation that is acceptable for 
repeat measurements. If this value is met, no additional injections are required. 
However, if both this value and the Max CV value are exceeded, the samples 
are automatically reinjected up to the maximum number of times specified in 
the No. of Injections field. The Max SD field is disabled if the Number of 
Injections is 1 or if the minimum is equal to the maximum. The default value 
for Max SD is 0.1.

• Max CV: Enter the default maximum coefficient of variation that is acceptable 
for repeat measurements. If this value is met, no additional injections are 
required. However, if both this value and the Max SD value are exceeded, the 
samples are automatically reinjected up to the maximum number of times 
specified in the No. of Injections field. The Max CV field is disabled if the 
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Number of Injections is 1 or if the minimum is equal to the maximum. The 
default value for Max CV is 2%.

Note: The “maximum” No. of Injections field refers to the maximum 
number of repeat injections to be performed when the automatic 
additional measurement function is enabled. Additional measurements 
are performed when both the Max SD and Max CV settings are 
exceeded. When both of these values are exceeded for the set number 
of sample injections, the additional measurement function is 
automatically activated and the sample is reinjected.

4.2.4 Maintenance History Settings

Enter limits for the following parameters to display a warning message when the limits 
are exceeded:

• Dilution water (mL): Records the volume of dilution water used.
• Total Acid Vol (mL): Refers to the total volume of acid used.
• Syringe Stroke (no.): Refers to the number of syringe operations.
• UV Lamp (hour): Refers to the total UV lamp operation time.
• UV Oxid Vol (µL): Refers to the total volume of oxidizer used.
• ASI Rinse Pump (hour): Refers to time of ASI rinse pump tubing use. The 

recommended warning value is 300 hours.
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Procedure

1. From the Instrument menu in the Sample Table Editor window, select 
Maintenance>History.

The Maintenance History dialog box is displayed.

Figure 4.21 Maintenance History Dialog Box

2. Enter warning limits by placing the cursor in the appropriate fields and 
entering numerical values.

3. Click the OK button.

TIP: Measurement is interrupted if the dilution water or acid reservoirs run dry during 
analysis. Prevent measurement interruption by setting the dilution water and total acid 
volume limits to values slightly less than the remaining volume of each respective 
liquid. A warning message is generated before each liquid is completely consumed. 

TIP: Click the Reset button to the right of a parameter to clear its current value.
Total Operation Time records the total time the instrument has been in operation and 
cannot be reset.
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4.3 Analysis

4.3.1 Starting Up the Instrument

4.3.1.1 Turning the Power ON

To perform analysis, turn on the power to the instrument as follows.

Procedure

1. Press the power button on the bottom right of the front panel of the instrument.

TIP: Power Button positions:  

Note: Press the power button once more to turn power to the instrument off.

4.3.1.2 Carrier Gas Pressure

Set the TOC-V Carrier Gas Pressure as Follows.

1. Ultra high purity nitrogen gas is used as the carrier gas for this instrument. Set 
the supply pressure of the carrier gas to 300kPa (44PSI) using the pressure 
regulator at the carrier gas supply source (cylinder).

Note: Ensure that the supply pressure of the nitrogen gas is greater than 
300kPa (44PSI) and does not exceed 600kPa (87PSI).

2. Open the front door of the instrument, and adjust the carrier gas pressure at the 
instrument to 200kPa (29PSI) using the carrier gas pressure regulation knob.

Figure 4.22 Setting the Carrier Gas Pressure

ON
OFF

Carrier Gas

Carrier Gas

Pressure Regulator

Pressure
Regulation Knob
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4.3.1.3 Carrier Gas Flow Rate

Set the flow rate of the TOC-V carrier gas as follows.

Procedure

1. Open the front door of the instrument.

2. Turn the carrier gas flow rate adjustment knob. Adjust the flow rate to 
200mL/min as indicated on the flow rate gauge.

Figure 4.23 Setting Carrier Gas Flow Rate

Note: Do not change the carrier gas flow rate during analysis. The peak area changes 
with respect to flow rate in a nearly inverse proportional relationship and may 
cause errors in analysis precision.

4.3.1.4 Setting Sparge Gas Flow Rate

This sections describes the procedure for setting the flow rate of the sparge gas 
supplied to the TOC-V IC reactor. 

Procedure

1. Open the front door of the instrument.

2. Select Maintenance>Adjust Sparg Flow Rate (Wet.Chem.)

Figure 4.24 Adjust Sparge Flow Rate (Wet. Chem.) Dialog Box

Carrier Gas Flow
Rate Adjustment
Knob
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3. Click the Start button.

4. Turn the sparge gas flow rate adjustment knob so that the flow meter indicates 
a flow rate of 200mL/min.

Figure 4.25 Adjusting the Sparge Gas Flow Rate

5. After making the adjustment, click the Stop button.

6. Click the Close button.

4.3.1.5 TC Reactor Settings

This section describes the procedure for setting parameters for the TC reactor. These 
parameters include the controls for the UV lamp and heater (Reactor Temperature On).

Procedure

1. In the TOC-Control V main menu, click the appropriate system.

The Instrument Settings dialog box is displayed.

2. Click the TOC tab.

3. Place check marks next to UV Lamp and Reactor Temperature On.

4. Click OK.

The display returns to the TOC-Control V menu.

Sparge Gas
Flow Rate
Adjustment Knob
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4.3.2 Tutorial 

This tutorial provides step-by-step instructions on the use of the TOC-Control V 
software. The tutorial assumes that the hardware and software have been installed in 
the manner described in Chapters 2 and 3, and that users have a configured system that 
includes the TOC-VWP and ASI.

Note: If your system does not include the ASI unit, adjust the tutorial procedures as 
appropriate.

In the tutorial, a three-point TC calibration curve and one unknown sample are 
measured. Purified water and the following calibration standards are needed for the 
tutorial:

• A calibration standard of 0mgC/L potassium hydrogen phthalate.

• A calibration standard of 5mgC/L potassium hydrogen phthalate.

• A calibration standard of 10mgC/L potassium hydrogen phthalate.

Reference: Prepare calibration standards as described in Section 4.1.11.1 “Preparation of Standard 
Solutions”.

The following topics are covered in the tutorial:

1) Configuring the Instrument

2) Connecting the Instrument

3) Creating a Sample Table

4) Setting Up the Calibration Standard Runs

5) Setting Up an Unknown Sample Run

6) Performing Measurement

7) Evaluating the Results

8) Printing a Report
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(Topic 1) Configuring the Instrument

Procedure

1. Start the TOC-Control V software by double clicking the TOC-Control V icon 
or by selecting it from the Start>Programs list. 

The TOC-Control V main window is displayed. 

Figure 4.26 TOC-Control V Main Window

2. The instrument configuration must be specified in the software before the 
instrument can be connected to the PC for the first time. Only users with 
administrative privileges can configure the instrument. If the system has 
already been configured, proceed to Step 2 of the tutorial.

3. From the TOC-Control V main window, double-click the New System icon.

The User dialog box is displayed.

4. Enter your user name and password in the dialog box shown below.

Figure 4.27 User Dialog Box
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5. Click the OK button. The Instrument Setup Wizard opens.

Figure 4.28 Instrument Setup Wizard: System Information Window

6. In the System Information window of the Instrument Setup Wizard, enter the 
System Name and Instrument Serial Number. Click the Next button.

The Options window of the Instrument Setup Wizard is displayed.

Reference:  Refer to Section 3.2.1 “System Information Window” for details on the System Name and 
Instrument Serial Number.

Figure 4.29  Instrument Setup Wizard: Options Window

7. Specify the wet chemical options that are configured on the system by clicking 
in the appropriate check boxes, as shown in the above figure.

8. Click the Next button. The TOC window of the Instrument Setup Wizard is 
displayed.
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9. Select the TOC analysis parameters, as shown in the figure below.

Note: Be sure that the “Enable ready status check” option is selected. 
Enabling the ready status check function means that the instrument 
will not begin a new injection until the instrument status is Ready. 

Figure 4.30 Instrument Setup Wizard: TOC Analysis Parameters

Reference: Refer to Section 4.2.1 “TOC Parameter Settings” for details on TOC parameters. 

10. Click the Next button. The ASI window of the Instrument Setup Wizard is 
displayed. Verify that the ASI parameters match those shown on the figure 
below.

Figure 4.31 Instrument Setup Wizard: Autosampler Parameters

11. Click the Next button. The Communication window of the Instrument Setup 
Wizard is displayed. 
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12. Verify the communication information (COM Port, Stop Bits, and Parity). 

Note: If a Shimadzu representative installed your TOC-Control V software, 
the correct settings for your system are already configured. Do not 
change the settings. Refer to Section 3.2.6 “Communication Window” 
for more information on Communication settings.

13. Click the Next button. The History Function window of the Instrument Setup 
Wizard is displayed. If desired, enable the History Log to track all changes to 
the method. Refer to Section 3.2.7 “History Function Window” for more 
information.

Note: The History Log function is automatically activated if Audit Trail was 
checked for the Security item in TOC-Control V Administrator 
window in the main menu.

14. Click the Finish button.

An icon for the system now appears in the TOC-Control V main 
window.

TIP: To edit the system configuration, double-click the system icon in the TOC-Control V 
main window or the Sample Table Editor window. Select Properties from the 
Instrument menu. The Instrument Properties dialog box opens, and system 
configuration options are displayed on tabs in the dialog box.

(Topic 2) Connecting the Instrument

Opening a New Sample Table

1. In the TOC-Control V main window, double-click the Sample Table 
Editor icon. The User dialog box is displayed.

2. Enter your user name and password. Click the OK button.

3. Open a new Sample Table by either selecting New from the File menu or 
clicking the New  toolbar button. The New dialog box is displayed.

Figure 4.32 New Dialog Box
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4. Select the Sample Run icon and click the OK button. 

The General Information dialog box opens.

5. Click the System tab and select the desired system from the drop-down list.

6. Save the Sample Table (.t32) file.

Select Save File As in the File menu. Enter Tutorial and click the Save button.

Figure 4.33 Save As Dialog Box

7. Click the OK button. 

A new, blank Sample Table is displayed.

Figure 4.34  Sample Table
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Connecting to the Instrument

1. To establish communication between the software and the instrument, either 
select Connect from the Instrument menu or click the Connect  toolbar 
button.

The Parameter Configuration dialog box is displayed. Click the Use Settings 
on PC button.

The Sequence dialog box is displayed.

Figure 4.35  Sequence Dialog box

2. The Sequence dialog box displays information about the attempt to establish 
communication between the software and the instrument. 

(Topic 3) Creating a Sample Table

Procedure

1. Enter the default analysis parameters for the Sample Table (.t32) file.

2. From the Options menu, select Default Measurement Parameters.

3. Three injections of each calibration standard and unknown sample are made. 
On the TC tab, change the “No. of injections” value to 3.

The other default measurement parameters should not be changed.

Figure 4.36 Default Measurement Parameters Dialog Box
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Note: The selected measurement parameters will appear as default values 
when setting up calibration and method files.

Reference: Refer to Section 4.2.3 “Setting Default Measurement Parameters” for details.

4. Modify the Sample Table tab at the top of the window so that all items 
contained in the Sample Table are shown on the screen. The default display 
settings may not include all of the Sample Table parameters.

5. From the Options menu, select Display Settings>Table Options.

Use the Select All button to ensure that all items on both tabs in the Table 
Options window are selected.

Figure 4.37 Table Options Window

Note: The selected measurement parameters will appear as default values 
when setting up calibration and method files.

Reference: Refer to Section 4.4 “Sample Table Editor” for detailed descriptions of the Sample Table 
Editor menus and commands.
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(Topic 4) Setting up the Calibration Standard Runs

There are two steps to setting up calibration standard runs: creating a calibration file, 
which stores information about calibration standard measurements, and inserting the 
calibration standard runs in the Sample Table. Separate calibration files are created for 
the TC analysis. The calibration is a three-point curve generated using potassium 
hydrogen phthalate standard solutions.

Creating the TC Calibration File

1. Open the Sample Table Editor. From the File menu, select New. 

The New dialog box is displayed. Click the Calibration Curve icon.

Figure 4.38 New Dialog Box

2. Click the OK button to open the Calibration Curve Wizard. Specific 
information about the calibration is entered on this page.

Figure 4.39 Calibration Curve Wizard (Page 1) System Information 

3. Select the system to be used for the analyses from the drop-down list on page 1 
System Information. 



4.3 Analysis
4.3.2 Tutorial

81TOC-VWP

4. Click the Next button.

Page 2 of the Calibration Curve Wizard is displayed. Choose the type of 
calibration curve.

• Calibration points are distributed uniformly over the concentration 
range

• Edit calibration points manually
• Calibration curve according to DIN 38402/P-51
• Calibration curve according to USP/EP

Figure 4.40 Calibration Curve Wizard (Page 2) Calibration Curve Type

5. Click the radio button for “Calibration points are distributed uniformly over 
the concentration range.” In the future, other options may be more appropriate. 
Refer to Section 4.4.2.2 “Calibration Curve” for a detailed description of the 
calibration curve types. 
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6. Click the Next button.

Page 3 of the Calibration Curve Wizard is displayed. The following options for 
calibration analysis are displayed:

Set the following calibration curve analysis parameters:

• Analysis: TC

• Default Sample Name: Standard

• Default Sample ID: Tutorial

• Calculation Method: Linear Regression

• Check box for Zero Shift: Yes (On)

• Calibration File Name: TCTutorial.cal

Figure 4.41 Calibration Curve Wizard (Page 3) Analysis Information

7. Click the Next button.

Page 4 of the Calibration Curve Wizard is displayed.

The No. of Injections matches the number entered in the default measurement 
parameters for the Sample Table. Refer to Step 3 of this tutorial for more 
information.

8. Enter the TC calibration standard concentration range values of 0 to 10mg/L.

Enter 3 as the number of calibration points.
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Figure 4.42 Calibration Curve Wizard (Page 4) Calibration Measurement Parameters

9. Click the Next button.

Page 5 of the Calibration Curve Wizard is displayed.

The Calibration Points List was completed based on information entered on 
the previous Wizard pages.

10.  To make changes, select a row and click the Edit button.

Figure 4.43 Calibration Curve Wizard (Page 5) Calibration Points List
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11. Click the Next button. 

Page 6 of the Calibration Curve Wizard is displayed.

12. Settings can be made on this page to delay or extend the peak detection time. 
View but do not change the default setting on the page.

13. Click the Next button.

Page 7 of the Calibration Curve Wizard is displayed. The History function may 
be enabled on this page. View but do not change the default setting.

14. Click the Finish button.

The Calibration Curve Wizard closes. The TC calibration curve file is now 
complete and has been saved.

Entering the Calibration Standard Runs in the Sample Table

Now that the calibration file has been created and saved, the calibration standard runs 
must be inserted into the Sample Table.

1. Insert the TC calibration standard runs by placing the cursor in the first line of 
the Sample Table.

2. From the Insert menu, select Calibration Curve.

3. Specify the name of the TC Calibration Curve (tctutorial.cal) and click the 
Open button.

The Sparging/Acid Addition window is displayed. Notice that the TC 
calibration standards have been automatically added to the table.

4. Enter the vial positions (1-3) for the calibration standards directly into the Vial 
column of the table. As vial positions are entered in the table, they are 
highlighted on the tray diagram in the Sparging/Acid Addition window.

Figure 4.44 Sparging/Acid Addition Window for the ASI-V Autosampler
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Figure 4.45 Sparging/Acid Addition Window for the 8-Port Sampler

5. Verify the information, then click the OK button. The Sample Table is 
displayed.The first row of the Sample Table contains the complete TC 
calibration standard measurement information.

Figure 4.46 TC Calibration Standard Information in the Sample Table

6. Save the Sample Table by selecting Save from the File menu or by clicking the 
Save button  in the toolbar.
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(Topic 5) Setting Up an Unknown Sample Run

In Topic 4 of the tutorial, you learned that calibration standard measurement 
information is saved in a calibration file. You also learned that setting up a calibration 
standard run involves two steps: creating a calibration file and then inserting the 
calibration standards into the Sample Table. 

By contrast, information about unknown sample measurement is saved in a method 
file. Setting up an unknown sample run involves two steps: creating a method file and 
then inserting the unknown sample into the Sample Table. In this tutorial, one 
“unknown” sample is analyzed. The “unknown” sample is actually the 5mg/L 
phthalate solution.

Creating a Method File

1. Open the Sample Table Editor. From the File menu, select New.

2. The New dialog box is displayed. Select the Method icon and click the OK 
button. The Method Wizard opens.

Figure 4.47 Method Wizard (Page1) System Information

3. Select the system to be used for the analysis from the drop-down box. Click the 
Next button. 

Page 2 of the Method Wizard is displayed.



4.3 Analysis
4.3.2 Tutorial

87TOC-VWP

4. Select TC from the Analysis drop-down menu. Enter “Sample” in the Default 
Sample Name field and “Tutorial” in the Default Sample ID field. In the File 
Name field, enter “Tutorial.met” as the name of the Method File.

Figure 4.48 Method Wizard (Page 2) Analysis Information

5. Click the Next button.

Page 3 of the Method Wizard is displayed. 

Note: It is possible to enter the calibration curve file in this screen since it 
contains the relevant data.

6. Place the cursor in the Calibration Curve 1 field. Click the Browse  button.

Select the file for the TC calibration curve created earlier (TCtutorial.cal).

Figure 4.49 Method Wizard (Page 3) Calibration Curves
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7. Click the Next button.

Page 4 of the Method Wizard is displayed. 

Figure 4.50 Method Wizard (Page 4) Injection Parameters

8. The following TC analysis parameters are entered. 

• Analysis (disabled)

• Units

• Injection Volume (disabled)

• Expected Conc. Range

• No. of Injections

• SD Max

• CV Max

• No. of Washes

• Auto Dilution

• Acid Addition

• UV Oxid.Vol

• Use blank check area

• Auto correction of inj. vol and dilution

9. Click the Next button. 

Page 5 of the Method Wizard is displayed. View but do not change the default 
settings on this page.
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10. Click the Next button.

Page 6 of the Method Wizard is displayed. View but do not change the default 
settings on this page. 

11. Click the Next button.

Page 7 of the Method Wizard is displayed. View but do not change the default 
settings on this page. 

12. Click the Finish button.

The Method Wizard closes. The method file is now complete and has been 
saved. Insert the sample into the Sample Table.

Reference: Refer to Section 4.4.2.3 “Method Wizard” for a detailed description of the Method Wizard.

13. Insert the unknown sample by placing the cursor in the second line of the 
Sample Table. From the Insert menu, select Sample.

Page 1 of the Sample Wizard (Parameter Source) is displayed.

TIP: To set up multiple analyses using a previously created method, select the Auto 
Generate Table command from the Insert menu. Refer to Section 4.4.5.1 “Auto 
Generate” for details.

Figure 4.51 Sample Wizard (Page 1) Parameter Source

14. Click the Method radio button. By selecting this option, the sample is analyzed 
using the measurement parameters specified in the method just created. Enter 
the name of the method file (Tutorial.met) or click the Browse button to search 
for the file.

Click in the “Skip remaining Wizard pages and use measurement parameters 
from the source” check box. By selecting this option, the analysis parameters 
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for the unknown sample will automatically be copied from the source 
(method) file. As a result, the parameters do not need to be entered manually 
and the remaining pages of the Sample Wizard are not displayed.

15. Click the Finish button.

The Sparging/Acid Addition window is displayed.

16. Enter the vial position (2) for the unknown sample (5mgC/L standard) directly 
into the Vial column of the table. 

17. Verify the information and click the OK button.

The second row of the Sample Table now contains the measurement 
parameters for the unknown sample. (A value is not displayed in the Result 
column until measurement is complete.)

18. Save the Sample Table by selecting Save from the File menu or by clicking the 
Save button  in the toolbar.

Measurement can now be performed.

(Topic 6) Performing Measurement

Procedure

1. Prepare the three calibration standards (0mg/L, 5mg/L and 10mg/L potassium 
hydrogen phthalate) and place them in autosampler tray vial positions 1, 2, 
and 3.

Note: Calibration standards and unknown samples can be placed in any vial 
position when controlling the instrument with the TOC-Control V 
software. 

2. Verify the status of the instrument detectors before starting analysis. From the 
Instrument menu, select Background Monitor, or click the Background 
Monitor  button on the toolbar.

The Background Monitor window is displayed. This window is used to 
monitor the real time signal from the ASI and the detectors. On the TOC tab, 
the status of the baseline should be OK for position, fluctuation, and noise.

Figure 4.52 Background Monitor Window: TOC Tab
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3. Since analysis cannot be performed with the Background Monitor open, close 
the window.

4. Place the cursor in the first row of the Sample Table. From the Instrument 
menu, select Start, or click the Start button  on the toolbar.

The Standby window is displayed.

5. Select Keep running from the options on the Standby window.
• Keep running
• Shut down instrument
• Auto restart

Figure 4.53 Standby Window

Reference: Refer to Section 4.4.6.3 “Standby” for detailed descriptions of the Standby window options.

6. Click the Standby button.

The Sparging/Acid Addition window is displayed.

7. Verify the vial positions and click the OK button.

The Start ASI Measurement window is displayed. 

8. Click the Start button to begin the analysis.
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9. The status of the measurements can be monitored during analysis by viewing 
the Sample Window. To open the Sample Window, either select Sample 
Window from the View menu or select the Sample Window  button on the 
toolbar.

Figure 4.54 Sample Window

Note: Sample Window

• The Sample Window is divided into 3 sections, as shown in the above figure. 
The Graph is in the upper left corner, the Parameter Table is in the upper right 
corner, and the Injection Table is the bottom half of the window. The current 
injection is displayed with asterisks in the Injection Table. As each 
measurement occurs, information in the appropriate Injection Table row is 
completed. Previous injections are shown above the current row. Use the scroll 
bar to see all of the information.

• To view the peak profile of the measurement in progress, click the asterisk of 
Sample No. To view a previous measurement, click that row.

• When the Sample Window is opened, the text on the graph may be overly 
enlarged. In that situation, close the Sample Window and then open it again. 

• During measurement, even if “All Peaks” is selected, because it takes time for 
the screen to update, the peak display may not change. In this case, select “All 
Peaks” following measurement.

10. Statistical information about the current set of injections is calculated and 
displayed in the Sample Window. Preliminary decisions about the 
measurements can be made while the analysis is still in progress.

Note: Information about the current injection is shown in the status box in 
the upper right portion of the Sample Window.
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TIP: The drop-down list above the graph is used to set the graph display. When Current 
Peak is selected, the peak profile of the current injection is drawn in the graph as the 
measurement is performed. Use this window to monitor the analysis as it occurs. To see 
the peak profile of a previous injection, click its row in the Injection Table. To see the 
peak profile of all the injections for a sample, select All Peaks from the drop-down list 
at the top of the graph. Use the right-mouse menu to customize the peak profile graph. 

Reference: Refer to Section 4.4.4.3 “Sample Window” for a detailed description of Sample Window 
options.

11. When measurement is complete, the autosampler moves to the rinse well for a 
flow line rinse and the instrument status tab displays Ready. Close the Sample 
Window.

(Topic 7) Evaluating the Results

The Sample Table now contains measurement information. Use the scroll bars to view 
the measurement information.

We will check the calibration curve results and evaluate the results for the unknown 
sample.

Checking the TC Calibration Curve Results

1. Place the cursor in the first row of the Sample Table.

2. From the View menu, select Calibration Curve, or click the Calibration Curve 
button  on the toolbar.

The Calibration Curve Properties window is displayed.

3. Select the Graph tab to view the TC calibration curve data in graph form.

Figure 4.55 Calibration Curve Properties: Graph Tab

The coefficient of determination (r2) value is a measure of the linearity of the 
relationship between concentration and area. Because we selected the linear 
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regression calculation when we created the calibration file, an r2 value was 
calculated for the TC calibration and displayed in the window. Use the r2 
value to determine the success of the calibration. An r2 value of 1 indicates a 
perfectly linear relationship between concentration and area. Application 
methods may specify an acceptable limit for the correlation coefficient.

4. Select the Data tab to view calibration statistics such as Standard Deviation 
(SD) and Coefficient of Variation (CV). These statistics can also be used to 
evaluate the success of the calibration.

TIP: A successful calibration can be used for future analyses by specifying the calibration 
file name (*.cal) in the method.

5. Close the TC Calibration Curve Properties window when the evaluation is 
complete.

TIP: When All Peaks is selected from the drop-down list at the top of the graph, clicking in 
another row of the Sample Table will automatically update the Sample Window display 
with the peak profiles for that row.

Evaluating the Unknown Sample Results

1. Place the cursor in the second row of the Sample Table, which contains 
analysis information for the unknown sample.

2. Examine the concentration results by scrolling to the Result column in the 
Sample Window. 

Note: The results should be close to 5mg/L.

Figure 4.56 Unknown Sample Results

3. Close the Sample Window when the evaluation is complete.
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Outlier Test

The Outlier Test is used to provide additional information about the measurement 
result.

1. Place the cursor in the second row of the Sample Table, which contains 
analysis information for the unknown sample.

2. From the View menu, select Outlier Test.

Note: The Outlier Test is conducted to identify suspect results. The test 
statistically compares all unknown samples that have the same sample 
name. Because this tutorial includes only one measurement of the 
unknown sample, the outlier test calculation is not meaningful. 

(Topic 8) Printing a Report

Print a report after measurement is complete and the results have been evaluated.

Selecting the Report Items

1. From the File menu, select Page Setup. 

2. The Page Setup window is displayed. Each tab in the window represents a 
section of the report and contains several items. Selections are made on each 
tab to print a typical report for the calibration standards and unknown sample.

Reference: Refer to Section 4.4.2.15 “Page Setup” for detailed descriptions of the Page Setup options.

3. On the Instrument tab, ensure that the Print system information check box is 
selected, then select the options shown in the figure below.

Figure 4.57 Page Setup Instrument Tab
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4. Open the Calibrations tab and select the options shown in the figure below.

Figure 4.58 Page Setup: Calibrations Tab

5. Open the Samples tab and select the options shown in the figure below.

Figure 4.59 Page Setup: Samples Tab

Note: Use the default selections on the Header and Grid tabs.

6. Open the Miscellaneous tab and enter “Tutorial” in the Organization name 
field. Select the Footer check box to include page numbers on the report.

TIP: A company logo can be added to the report header by selecting the Logo check box and 
specifying the logo graphic file. 
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Figure 4.60 Page Setup: Miscellaneous Tab

Previewing the Report

1. Select the Preview button from any of the Page Setup tabs to preview the entire 
report before printing.

TIP: The report can also be previewed from outside the Page Setup window by selecting 
Print Preview>Sample Report from the File menu.

The Preview feature displays each page of the report exactly as it is printed. 
Notice that each item that was selected in the Page Setup window appears in 
the report.

Figure 4.61 Preview the Report Appearance
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TIP: Magnify the view by clicking the magnifying glass tool, or on the Zoom In button. Move 
from page to page by clicking the Next Page and Previous Page buttons. 

2. Print the report by clicking the Print button.

This ends the tutorial. 

Reference: The tutorial provided instructions for setting instrument configuration and analysis parameters, 
adding calibration standard and unknown sample information to the Sample Table, creating 
calibration curves and method files, conducting measurements, and checking and printing 
results. More details on all of these procedures are discussed in Section 3.2 “Instrument Setup 
and System Properties”, Section 4.2 “Setting General Measurement Parameters”, and 
Section 4.4 “Sample Table Editor”.

4.3.3 TC Blank Check Analysis

A TOC system invariably contains substances in the instrument flow lines that produce 
peaks. These peaks are referred to as blank values or system blank values, and are 
present even in water samples containing absolutely no carbon. The magnitude of 
peaks in the blanks differs based on various factors. These peaks can affect the 
accuracy of the TC analyses. For the TOC-V, every effort has been made to minimize 
these peaks. Accuracy is particularly affected when measuring samples such as 
ultra-pure water which have trace amounts of TOC. The blank peaks must be small and 
stable. To check and correct for the magnitude of the system blank peaks, use the 
TOC-Control V Blank Check procedure described below.

The magnitude of the blank and the instrument stability can be assessed from the area 
values obtained during blank measurement. Compare the area of the blank to the area 
determined from the calibration curve to determine the equivalent concentration value 
for the blank.

Note:
• The Blank Check procedure takes about 6 hours to complete and does not 

require continuous monitoring by the user. As a result, performing the 
procedure overnight is recommended.

• Blank values measured during the Blank Check procedure should rapidly 
decrease in magnitude and stabilize. If the instrument flow lines, syringe pump 
interior, or reactor have been contaminated, the blank values will not rapidly 
decrease. In such instances, the Blank Check procedure should be repeated.

• Blank peaks are negligible in the IC analysis flow line. The IC value is zero if 
the water is acidified and sparged. This can easily be confirmed by conducting 
analysis using the IC flow line; however, this is not normally necessary. 
Consequently, there are no special IC flow line check procedures, as with the 
TC blank check.
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Blank Check Procedure

1. Open the TOC-Control V Sample Table Editor and create a blank Sample 
Table for the high sensitivity system.

Note: Do not insert a sample into the Sample Table. The Blank Check 
procedure only works with an empty Sample Table.

2. Connect the instrument by selecting Connect from the Instrument menu.

3. From the Instrument menu, select Maintenance>Blank Check.

The Blank Check Parameters dialog box is displayed.

Figure 4.62 Blank Check Parameters Dialog Box

4. Select the injection volume using the spin controls in the Injection Volume 
field. Select the volume of oxidizer solution using the spin controls in the UV 
Oxident Vol. field. Click the Start button to display the Standby dialog box.

Figure 4.63 Standby Dialog Box

5. Select an option to determine the condition of the instrument after the blank 
check is complete. Options are:

• Keep running
• Shut down instrument
• Auto restart (UV lamp, reactor temperature on, carrier gas, restart 

time)

6. Insert the sampling tube into a container with at least 300mL of purified water.
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7. Click the Standby button.

The Save As dialog box is displayed.

8. Enter a file name and click the Save button. Data from the Blank Check 
procedure is stored in the created file.

Blank check analysis begins.

4.3.4 Ending Measurement

Follow the procedure below to end measurement.

Procedure

1. From the Instrument menu, select Standby.

Figure 4.64 Standby Window

2. Two procedures are available for ending measurement:
• Shut down instrument
• Auto restart

These procedures are described below.
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Shut Down Instrument

Use the “Shut down instrument” option to end measurement and switch off power to 
the instrument.

1. Select “Shut down instrument” in the Standby window and click the Standby 
button.

Power is automatically cut to the TC reactor, UV lamp and heater, carrier gas 
flow is stopped, and power to the instrument is turned off. 

Note: When “Shut down instrument” is selected, the instrument power is 
turned off and the power to the autosampler exhaust fan is turned off. 
If acidic samples are being measured or if sparging is being performed 
using the autosampler in NPOC measurement, there is a danger that 
following measurement, volatilization of acid in the sample could 
cause corrosion of the autosampler. Do not switch off the power to the 
instrument. (Do not select Shutdown.)

Auto Restart

The Auto Restart function is used to shut down the instrument and then restart it at a 
specified time. Selections are made for the date and time that measurement will next be 
performed, as well as for the instrument restart settings. After shutting down the 
instrument, the carrier gas flow and power to the TC reactor UV lamp and heater are 
automatically turned off. Approximately 30 minutes before the restart time, the UV 
lamp is turned on and the heater temperature begins to rise. Carrier gas is automatically 
turned on to allow the instrument to achieve a Ready state by the restart time. 

1. Select “Auto restart” in the Standby window.

2. Select the appropriate instrument restart settings (UV lamp, Reactor temp On 
and Carrier gas). Set the restart date and time.

Note: If a check is placed in the box beside a unit, the power remains on and 
the carrier gas continues to flow. In order to have the power turned off 
automatically, do not place a check mark in any of these boxes. 

3. Click the Standby button.

Power to the instrument is automatically turned off and will be automatically 
turned on about 30 minutes before the restart date and time. By using Auto 
Restart, the instrument is Ready for measurement at the specified startup time.

Reference: Refer to Section 4.4.6.3 “Standby” for detailed descriptions of the available instrument 
shutdown options.
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4.4 Sample Table Editor

The TOC-Control V Sample Table Editor menus and commands are described in this 
section.

4.4.1 Sample Table Window Overview

4.4.1.1 Toolbar Functions

If the Toolbar is not visible, select Toolbar from the View menu, then specify the 
desired Toolbar options.

Note: Many of the Toolbar functions are disabled until a Sample Table is opened or 
communication is established with an instrument.

TIP: A description of each Toolbar button’s function appears when the mouse pointer is 
positioned over the button. 
All of the Toolbar commands are also accessible through the Sample Table Editor 
menus.

New File

Opens a new, blank Sample Table.

Open File

Opens a saved Sample Table. Click the button to display the Open dialog box. 
Select a *.t32 file.

Save File

Saves the data in the open Sample Table. If the open Sample Table is new and 
has not yet been saved, the Save As dialog box is displayed.

Cut

Removes data from highlighted cells in a table and saves them to the clipboard.

Copy

Copies data from highlighted cells in a table and saves them to the clipboard.

Paste

Copies the contents of the clipboard to a selected location in a table.
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Print

Sends the data from the currently displayed window to the printer. Clicking the 
button starts printing immediately using the current printer settings.

Help - About

Provides information about the TOC-Control V software.

Background Monitor

Displays the Background Monitor window, which displays the status of the 
ASI, TC reactor and the instrument detector(s). 

Connect

Opens or closes the electronic connection between the instrument and the PC.

Standby

Shuts down or reactivates the instrument.

Start/Continue

Starts measurement. Either the Manual Injection Parameter or Sparging/Acid 
Addition window is displayed, depending on the instrument settings.

Stop

Stops the measurement sequence after all injections of the current sample are 
complete.

Halt

Immediately stops the current measurement and discards data from the 
interrupted measurement.

Peak Stop

Stops the measurement sequence and aborts analysis of the current sample. 
The peak in progress is treated as if it were a finished analysis.

Properties

Displays the Sample/Method Properties dialog box.

Calibration Curve (View)

Displays the calibration curve data. Highlight the calibration standard row in a 
Sample Table to select the calibration curve to examine.
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Sample

Opens the Sample Window, which displays detailed information for each 
sample injection and can be used to view measurement data in real time. 

Method

Opens the Method Properties window, which contains the method parameters 
for a selected sample.

Exclude

Excludes a selected sample or injection from the calculation. Toggles to 
include an excluded sample.

Recalculate Highlighted

Recalculates the highlighted sample results after applying a new calibration 
curve or excluding injections.

Recalculate All

Recalculates all sample results after applying a new calibration curve or 
excluding injections.

Delete Highlighted Data

Deletes the highlighted measurement data. This function does not change the 
structure of the Sample Table.

Delete All Data

Deletes the measurement data for all samples. This function does not change 
the structure of the Sample Table.

Format

Displays the Floating Point Format dialog box, where options for numerical 
formats can be modified.

Font

Displays the Font dialog box, where options for fonts can be modified.

Insert Sample

Opens the Sample Wizard, and allows a sample to be inserted in the active 
position of the Sample Table.
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Autogenerate

Opens the Sample Group Wizard, and allows a specified group of samples to 
be inserted in the active position of the Sample Table.

Insert Control

Displays the Open dialog box, and allows a selected control sample template to 
be added to the Sample Table.

Insert Calibration Curve

Displays the Open dialog box, and allows a selected calibration curve to be 
added to the Sample Table.

4.4.1.2 Status Bar and Notification Bar

The Status Bar displays the status of various software functions and is displayed at the 
bottom of the open window for all applications. If the Status Bar is not visible, select 
Status Bar from the View menu.

The Notification bar displays information about the status of the TOC-Control V 
software, the connection between the instrument and the PC, measurement events, and 
operation errors. Use the Options>Display Settings>Notification bar Settings window 
to enable, disable, or select settings for the Notification bar. Refer to Section 4.4.9.5 
“Display Settings>Notification Bar Settings” for details. 

Figure 4.65 Status Bar and Notification Bar

Status Bar

Notification Bar
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4.4.2 File Menu

Figure 4.66 File Menu

4.4.2.1 New

The New command opens the New dialog box, which displays the options for all new 
file types. The options are Sample Run, Calibration Curve, Method and Control 
Sample Template. 

Figure 4.67 New Dialog Box

TIP: A new file can also be created by clicking the New File button on the Toolbar and 
typing in the new file name.

Sample Run

Displays the General Information window, which can also be accessed by 
selecting General Information from the Options menu. Refer to 
Section 4.4.9.1 “General Information” for a detailed description of the 
General Information window.

Calibration Curve

Opens the Calibration Curve Wizard, which can also be accessed by selecting 
Calibration Curve from the Insert menu. Refer to Section 4.4.2.2 “Calibration 
Curve” for a detailed description of the Calibration Curve Wizard.
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Method

Opens the Method Wizard which can also be accessed by selecting 
File>New>Method. Refer to Section 4.4.2.3 “Method Wizard” for a detailed 
description of the Method Wizard.

Control Sample Template

Opens the Control Sample Wizard which can also be accessed by selecting 
File>New>Control Sample Template. Refer to Section 4.4.5.3 “Control” for a 
detailed description of the Control Sample Wizard. Refer to Appendix B for a 
description of the Control Charts function.

OK Button

Opens the file associated with the selected icon, and closes the New dialog 
box.

Cancel Button

Closes the New dialog box without making any changes.

4.4.2.2 Calibration Curve

The Calibration Curve command is used to insert a calibration curve into the Sample 
Table. The File>Open dialog box is displayed when the Calibration Curve command is 
selected.

Figure 4.68 File>Open Dialog Box
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A table of calibration information is displayed in the window at the bottom of the Open 
dialog box after a calibration curve is selected. Click the Open button to insert the 
selected calibration curve into the Sample Table. Click the Cancel button to abort the 
operation.

Note: The Insert>Calibration Curve command is not available during sample 
analysis. 

• An error message is displayed if the selected file does not have the correct 
format or is not a calibration curve.

To create a new calibration curve for insertion into the Sample Table, click the New 
button to open the Calibration Curve Wizard. The Calibration Curve Wizard consists of 
several windows, each of which defines specific parameters for the calibration curve, 
as described below.

TIP: The Calibration Curve Wizard can also be accessed by selecting File>New and 
double-clicking the Calibration Curve icon in the New dialog box.

Calibration Curve Wizard (Page 1) System Information

Figure 4.69 Calibration Curve Wizard (Page 1) System Information

Parameter Description

System Select the system to be used.

User Displays the user name. This field cannot be edited.

Date of Creation Displays the current system date and time. This field 
cannot be edited.

Comment Enter a comment (512 characters maximum).
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Calibration Curve Wizard (Page 2) Calibration Curve Type

The Calibration Curve Type window is used to specify the calibration curve type. 

Figure 4.70 Calibration Curve Wizard (Page 2) Calibration Curve Type

Calibration using automatic dilution

Parameter Description

Calibration points are 
distributed uniformly over 
the concentration range

Select this option to calculate the calibration point 
concentrations automatically. The software will 
distribute the points evenly over the calibration curve 
range and display these values on the next page.

Edit calibration points 
manually

Select this option to enter the calibration point 
concentrations manually on the Calibration Points List 
Wizard page.

Calibration curve 
according to DIN 
38402/P-51

Select this option to create a calibration curve according 
to DIN 38402.

Calibration curve 
according to USP/EP

Select this option to create a calibration curve that 
consists of 2 calibration standards with concentrations 
between 0 and 500µg/L and one control sample with a 
concentration of 500µg/L.

Dilution Factor Manual 
Setting

For manually setting dilution factor of standard 
solution. Enter the dilution factor.

Dilution Factor Automatic 
Setting

Automatically calculates dilution factor for standard 
solution, and performs measurement using that dilution 
factor. 

Use Source Dilution 
Function

Prepares standard solution automatically inside the 
instrument, and performs measurement using that 
diluted standard solution.
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Calibration Curve Wizard (Page 3) Analysis Information

The Analysis Information window is used to specify the type of analysis and the 
standard name for the calibration curve.

Figure 4.71 Calibration Curve Wizard (Page 3) Analysis Information

Parameter Description

Analysis Select the analysis type.

Default Sample Name Enter the sample name for the calibration standards (64 
characters maximum).

Default Sample ID Enter the default sample identification for the 
calibration standards (64 characters maximum).

Calculation Method Select the calculation method to be used for the 
calibration from the drop-down list. Available 
calculation methods are point-to-point and linear 
regression. Refer to Section 4.4.4.5 “Properties” for 
detailed descriptions of the calibration methods.

Zero Shift Select this option to shift the calibration curve through 
the origin. Refer to Section 4.4.4.5 “Properties” for a 
detailed description of the Zero Shift option.

File Name Enter the file name of the calibration curve.
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Calibration Curve Wizard (Page 4) Calibration Measurement Parameters

The Calibration Measurement Parameters window is used to specify measurement 
parameters for the calibration standards.

Figure 4.72 Calibration Curve Wizard (Page 4) Calibration Measurement Parameters

Parameter Description

Units Select the concentration units from the options in the 
drop-down list.

Concentration Range Enter the maximum and minimum concentrations of the 
calibration curve standard solutions.

No. of Cal. Points Enter the number of calibration standards that are used to 
create the calibration curve.

No. of Injections Enter the minimum/maximum number of injections for the 
calibration standards.

No. of Washes Specifies the number of times the syringe is washed with 
standard prior to the first injection. If the Auto Dilution 
option is selected, the standard is diluted and the syringe 
washed with the diluted standard. Enter an integer from 0 to 
10.

SD Max and CV Max Specifies the maximum acceptable standard deviation and 
coefficient of variation. Enter a value from 0 to 9999 for SD 
Max and from 0 to 100 for CV Max. If either of these values 
are met, no additional injections are required. If both of 
these values are exceeded, the calibration standards are 
automatically reinjected up to the maximum number of 
times. These fields are disabled if the No. of Injections is 1 
or the minimum is equal to the maximum.

Sparge Time Enter the length of time sparging will occur. (0 - 20 
minutes)

Acid Addition Enter the desired quantity of acid to be added. This option 
is available only for NPOC or related analyses.

UV Oxident Vol. The oxidizer addition volume range is 0 - 3 mL. This is 
entered for TC or NPOC measurement.
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Calibration Curve Wizard (Page 5) Calibration Points List

The Calibration Points List window displays a list of parameters for each calibration 
point. The parameters can be edited by using the buttons below the list. To edit 
calibration information a user must have access rights for updating data.

Figure 4.73 Calibration Curve Wizard (Page 5) Calibration Points List

Parameter Description

Auto Dilution The auto dilution factor is displayed. This field cannot 
be edited.

Inj. Volume Displays the injection volume for the calibration 
standards. This field cannot be edited.

Calibration Points Displays a table of measurement parameters (such as 
those entered in the previous page of the Calibration 
Curve Wizard) for each calibration point. To edit the 
parameters for a calibration point, highlight the point in 
the table and click the Edit button. To add a calibration 
point, click the appropriate number in the No. column to 
specify the insertion point, then click the Add button. To 
delete a calibration point, highlight the point in the table 
and click the Delete button. To delete all calibration 
points, click the Delete All button. 
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Edit Calibration Point Parameters

Click the Edit and Add buttons to display the Edit Calibration Point Parameters 
window. The window is used to enter calibration points manually or to edit the 
parameters of existing calibration points. 

Figure 4.74 Edit Calibration Point Parameters Window

Parameter Description

Calibration Point No. Displays the calibration point number that was selected 
in the “No.” field of the Calibration Points List window. 
The number cannot be edited in this window.

Cal. Point Conc. Displays the actual concentration of the calibration 
point. The concentration is calculated automatically 
based on the values entered into the Standard Solution 
Conc. and Auto Dilution fields.

No. of Injections Enter the minimum and maximum number of 
injections.

SD Max and CV Max Enter the maximum acceptable standard deviation or 
coefficient of variation values.
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Calibration Curve Wizard (Page 6) Peak Time Parameters

The Peak Time Parameters window is used to set peak detection parameters.

Figure 4.75 Calibration Curve Wizard (Page 6) Peak Time Parameters

Setting Item Description

Use default settings Select this option to use the default peak detection 
parameters. When this option is selected, all other 
options in this window are disabled.

Allowed peak start delay The allowed peak start delay is the amount of time (in 
minutes) that can elapse before the analysis is stopped 
because a peak is not detected. Enter a number between 
0 and 20:00.

Total integration time The total integration time is the amount of time (in 
minutes) that analysis continues after the injection. If 
the peak end is determined prior to the set time, 
integration stops and the next injection is made. Enter a 
number between 4:50 and 20:00.
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Calibration Curve Wizard (Page 7) History

The History window is used to enable the History Log. The History Log records all 
modifications to the calibration curve parameters. The History Log can be set to 
require users to enter comments for each modification. If the History Log is not 
required, it need not be enabled, as the software operates properly without it.

Note: Once the History Log is enabled, it cannot be edited. All modifications to the 
calibration curve parameters are tracked. If the mandatory comment option is 
selected, the user is required to enter a comment each time any parameter in 
the calibration curve is modified.

Figure 4.76 Calibration Curve Wizard (Page 7) History

Setting Item Description

Enable history log Select this option to enable the software to monitor all 
modifications to the system.

User has to comment all 
modifications

Select this option to require the user to add a comment 
to all modifications.
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4.4.2.3 Method Wizard

The Method Wizard is used to set method parameters and is accessed by selecting 
File>New>Method. The Method Wizard consists of several windows, each of which is 
described below. The Back and Next buttons are used to navigate between windows. 
Each set of parameters selected for a specific method applies only to that method.

Note: Selected windows in the Method Wizard are repeated for combined analysis 
types such as TOC. Each duplicate window represents one analysis type. 
Parameters that are not applicable to an analysis type will not appear in the 
Method Wizard window.

Method Wizard (Page 1) System Information

Figure 4.77 Method Wizard (Page 1) System Information

Setting Item Description

System Select one of the configured instruments.

Operator Displays the current operator name.

Date of Creation Displays the current time.

Comment Enter a comment (512 characters maximum), if desired.
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Method Wizard (Page 2) Analysis Information

The Analysis Information window is used to set analysis parameters for the method 
being created.

Figure 4.78 Method Wizard (Page 2) Analysis Information

Setting Item Description

Analysis Select the analysis type from the drop-down list.

Default Sample Name Enter the default sample name (64 characters 
maximum).

Default Sample ID Enter the default sample ID (64 characters maximum).

Dilution Enter the preparation dilution factor, which is used to 
calculate concentration results. The default value is 1.

No. of Determinations Enter the number of times each sample is measured. 
Determinations and injections are different; each 
determination is made up of one or more injections. 

File Name Enter the name of the new method. Click the Browse 
button to save the file in a directory other than the 
default directory.
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Method Wizard (Page 3) Calibration Curves

The Calibration Curves window is used to specify the calibration curves used to 
calculate results for samples analyzed by the method. Up to 3 calibration curves can be 
entered and, during analysis, the system automatically determines which curve is most 
suitable for the sample. Refer to Section 6.2.4 “Automatic Selection of the Optimal 
Calibration Curve” for more details.

Figure 4.79 Method Wizard (Page 3) Calibration Curves

Setting Item Description

Analysis Displays the previously selected analysis type.

Calibration Curve 1/2/3 Enter the name of the calibration curve or click the 
Browse button to select a file using the File>Open 
dialog box.

Skip the injection 
parameter pages of the 
wizard

Select this item to skip the Injection Parameters window 
of the Method Wizard. Use this option when the sample 
injection parameters are the same as those used for 
calibration curve measurements.
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Method Wizard (Page 4) Injection Parameters

The Injection Parameters window is used to specify the injection parameters for the 
method.

Figure 4.80 Method Wizard (Page 4) Injection Parameters

Setting Item Description

Analysis Displays the previously selected analysis type.

Units Select the concentration units to be used from the drop down list.

Injection Volume Enter the injection volume.

Expected Conc. 
Range

Enter the expected sample concentration if it is known.

No. of Injections Enter the minimum/maximum number of injections for the samples.

SD Max Enter the maximum acceptable standard deviation. If this value is met, 
no additional injections are required. However, if both this value and 
the CV Max value are exceeded, the samples are automatically 
reinjected up to the maximum number of times. The SD Max field is 
disabled if the No. of Injections is 1 or if the minimum is equal to the 
maximum.

CV Max Enter the maximum acceptable coefficient of variation. If this value is 
met, no additional injections are required. However, if both this value 
and the SD Max value are exceeded, the samples are automatically 
reinjected up to the maximum number of times. The CV Max field is 
disabled if the No. of Injections is 1 or if the maximum and minimum 
values are the same.

No. of Washes Enter the number of times the syringe is washed with sample prior to 
the first injection. If the Auto Dilution option was selected, the sample 
is diluted and the syringe washed with the diluted sample.

Auto Dilution Enter a dilution factor for the samples. The instrument automatically 
dilutes the samples by this factor, and this factor is used to calculate 
the final result.
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Method Wizard (Page 5) Peak Time Parameters

The Peak Time Parameters window is used to set peak integration parameters.

Figure 4.81 Method Wizard (Page 5) Peak Time Parameters

Sparge Time Enter the desired sparge time. This option is available only for NPOC. 

Acid Addition Enter the desired quantity of acid to be added. 

UV Oxid. Vol. Sets the volume of oxidizer solution to be added to the sample.

Use blank check area Select to include blank check result in the concentration calculation.

Auto correction of inj. 
vol. and dilution

Select to enable the instrument to automatically adjust the injection 
volume and dilution factor when the peak height for the initial 
injection exceeds full scale. After the adjustment, measurement is 
repeated.

Setting Item Description

Analysis Displays the previously selected analysis type.

Use default settings Select this option to use the default integration 
parameters. When this option is selected, all other 
options in this window are disabled.

Allowed peak start delay The allowed peak start delay is the amount of time (in 
minutes) that can elapse before the analysis is stopped 
because a peak is not detected. Enter a number between 
0 and 20:00.

Total integration time The total integration time is the amount of time (in 
minutes) that analysis continues after the injection. If 
the peak end is determined prior to the set time, 
integration stops and the next injection is made. Enter a 
number between 4:50 and 20:00.

Setting Item Description
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Method Wizard (Page 6) USP/EP

The USP/EP window is displayed only for TC or NPOC methods, and is used to allow 
samples to be checked in accordance with USP standards. Place a check in the box to 
enable this function.

Figure 4.82 Method Wizard (Page 6) USP/EP
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Method Wizard (Page 7) History

The History window is used to enable the History Log. The History Log records all 
modifications to the method. The History Log can be set to require users to enter 
comments for each modification. 

Note: Once the History function is enabled, it cannot be disabled. All modifications 
to the method are tracked. If the mandatory comment option is selected, the 
user is required to enter a comment each time any method parameter is 
modified.

Figure 4.83 Method Wizard (Page 7) History

Setting Item Description

Enable history log Select this option to enable the software to monitor all 
modifications to the system. Once the History Log is 
enabled, it cannot be changed.

User has to comment all 
modifications

Select this option to require comments or approval for 
all method modifications. If the History Log is not 
required, it need not be enabled, as the software 
operates properly without it.
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4.4.2.4 Open

The Open command is used to select and open a Sample Table, Method, Calibration 
Curve, Parameter, or Control Sample Template file. Save the Sample Table before 
executing the Open command. More than one Sample Table can be opened at the same 
time. Select the Open command to display the Open dialog box.

Figure 4.84 Open Dialog Box

Table 4.5 “Acceptable File Types in the Open Function” displays the types of files that 
can be opened using this function. No other file types should be opened using this 
menu command.

Table 4.5 Acceptable File Types in the Open Function

The opened file may replace the currently displayed table or function, depending on the 
type of file selected. 

File Extension Description

.t32 Sample Table

.met Method

.cal Calibration Curve

.tpl Control Sample Template

.trd Data Profile

Dialog Box Options Description

Look in Find the file to be opened by choosing the appropriate 
folder or accessing other directories. The selected file 
will appear in the File name text box.

File name Enter the name of the file to be opened.

Files of type Select the type of file from the drop-down list. Choose 
only files of type *.t32 when opening a Sample Table.

Open button Opens the selected file.

Cancel button Aborts the Open operation.
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4.4.2.5 Close

The Close command is used to close the current window and is an option only when a 
file is open. If the open file has not been saved and the Close command is selected, the 
Save As dialog box is displayed. Refer to Section 4.4.2.7 “Save As” for details. Enter 
a name for the file and click the OK button to save the file. If the open file has been 
modified but not saved and the Close command is selected, a dialog box is displayed as 
shown below. Click the Yes button to save the file before closing. Click the No button 
to close the file without saving the modified information. Click the Cancel button to 
abort the Close command and return to the file.

Figure 4.85 Dialog Box for Saving Modified Data

4.4.2.6 Save

The Save command is used to save data in the current active file. If the file has not yet 
been saved and the Save command is selected, the Save As dialog box is displayed. 
Refer to Section 4.4.2.7 “Save As” for details.
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4.4.2.7 Save As

The Save As command is used to save the current active file with a new file name. 
Selecting the command opens the Save As dialog box shown below. Button options in 
the dialog box are similar to those in the Open dialog box. Refer to Section 4.4.2.4 
“Open” for more details. Click the Save button to save the data under the specified file 
name. Click the Cancel button to abort the Save As operation.

Figure 4.86 Save As Dialog Box

Dialog Box Options Description

Save in Select the directory in which the file is to be saved by 
choosing the folder or accessing other directories from 
the drop-down list. The currently selected directory 
appears in the Save in text field.

File name Enter a name for the file. The applicable file extension 
will automatically be added if it is not entered.

Save as type Select the type of file from the drop-down list. A list of 
available file types is listed in Table 4.2.
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4.4.2.8 ASCII Export Options

The ASCII Export function is used to export Sample Table data to an ASCII file. Open 
a Sample Table that contains finished measurement data. Select ASCII Export from the 
File menu. The Save As dialog box is displayed. Refer to Section 4.4.2.7 “Save As” 
for details. Enter a file name for the ASCII file to be created and confirm that the “Save 
as type” field contains the ASCII file type (*.txt). If the entered file name matches a 
file that already exists, a confirmation message is displayed.

Figure 4.87 Save As Confirmation Message

Click the Yes button to overwrite the existing file and close the dialog box. Click the 
No button to redisplay the Save As dialog box and enter a new file name.

Select the ASCII Export Options command from the File menu. The ASCII Export 
Options dialog box, which contains several tabs, is displayed. Each tab contains a list 
of export options, as shown in the figures below. On each tab, certain items are selected 
by default. Individual options can be selected or deselected by clicking in the check 
box. Use the Select All and Select None buttons to quickly select and deselect all 
options on a tab. Use the Default button to select the default options on a tab. Click the 
Cancel button to exit the ASCII Export Options dialog box without saving changes. 
Click the OK button to save changes and exit the ASCII Export Options window.

Header Tab

Figure 4.88 ASCII Export Options Window: Header Tab

Setting Item Description

Export header information Select to enable export of the selected header options. 
This option is selected by default.
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System Tab

Figure 4.89 ASCII Export Options Window: System Tab

Data Tab

Figure 4.90 ASCII Export Options Window: Data Tab

Setting Item Description

Export system information Select to enable export of the selected system options. 
This option is selected by default.

Setting Item Description

Export data Select to enable export of the selected data options. This 
option is selected by default.
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Miscellaneous Tab

Figure 4.91 ASCII Export Options Window: Miscellaneous Tab

The Miscellaneous tab contains additional options for the format of exported data. To 
change data format, open a Sample Table, select File>ASCII Export Options, then 
select the file to which changes should be made. On the Miscellaneous tab, select the 
desired type of Separator from the drop-down list. The Separator is the type of 
delimiter used to separate items of data. Select the “Export strings in quotation marks” 
option to enclose all of the character string items in quotation marks.

4.4.2.9 Database Export

The Database Export command is used to enable automatic export of data to an external 
(Microsoft Access) database during analysis. Selecting the command displays the 
Database Options window.

Figure 4.92 Database Options Window

Setting Item Description

Enable automatic database 
export

Select this option to enable the database export function

Database Enter the name and file path of the database, or click the 
Browse button to select the database using the 
File>Open dialog box.
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4.4.2.10 Print>Table

The Print>Table command is used to print the active Sample Table in a table format. 
Select this command to open the Print dialog box, which may have a variable display 
depending on the installed printer driver. Specify items to be included in the printout by 
using the Page Setup command. Refer to Section 4.4.2.15 “Page Setup” for more 
details.

Figure 4.93 Print Dialog Box

The Name text field identifies the printer used to print the table. Specify a different 
printer by selecting it from the drop-down list.

Setting Item Description

Properties Modify the printer settings using standard Windows 
procedures.

Print range Click the All radio button to print all pages of the table. 
Click the Pages radio button and enter the page numbers 
to be printed if all pages are not desired.

Number of copies Enter the number of copies to be printed.
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4.4.2.11 Print>Sample Report

The Print>Sample Report command is used to open the Print dialog box to print the 
Sample Table in report format. The print dialog box is the same as that described in 
Section 4.4.2.10 “Print>Table”.

Figure 4.94 Print Dialog Box

4.4.2.12 Print Preview>Table

The Print Preview>Table option is used to display the sample table before printing. Use 
the buttons at the top of the Print Preview window to change the display or print the 
table, as described below. 

Button Description

Next Page and Previous 
Page

Click the Next Page button to display the next page of 
the report. Click the Previous page button to display the 
previous page of the report. The Next Page button is 
disabled when the last page of the report is displayed, 
and the Previous Page button is disabled when the first 
page of the report is displayed.

One Page/Two Page Click the One Page button to display one page at a time 
in the Print Preview window. After selection, the button 
toggles to the Two Page button. Click the Two Page 
button to display two pages side by side.

Zoom In and Zoom Out Click the Zoom In and Zoom Out buttons to change the 
magnification of the displayed pages. Three different 
zoom factors are available. Repeated selection of either 
option will continue to increase or decrease the 
magnification, as applicable.

Close Click the Close button to close the Print Preview 
window and return to the previous window. The Print 
Preview window must be closed to edit the report.

Print Click the Print button to print the report.
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4.4.2.13 Print Preview>Sample Report

The Print Preview>Sample Report option is used to display the sample report before 
printing. Use the buttons at the top of the Print Preview window to change the display 
or print the report, as described in Section 4.4.2.12 “Print Preview>Table”.

Figure 4.95 Print Preview>Report Window

4.4.2.14 Print Setup

The Print Setup command is used to set print options. Select this command to open the 
Print Setup dialog box, which may have a variable display depending on the installed 
printer driver. Modifications to the Print Setup dialog box are saved until the 
TOC-Control V software is exited.

Figure 4.96 Print Setup Dialog Box
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4.4.2.15 Page Setup

The Page Setup command is used to select items to be printed on a report or table and 
to specify format parameters such as margins, headers, and footers. Selecting the 
command displays the Page Setup window, which consists of several tabs. Each tab 
contains a list of page setup options shown in the figures below. On each tab, certain 
options are selected by default. Individual options can be selected or deselected by 
clicking the check box. Use the Select All and Select None buttons to quickly select 
and deselect all options on a tab. Use the Default button to select the default options for 
a tab. Click the Cancel button to exit the Page Setup window without saving changes. 
Click the OK button to save changes and exit the Page Setup window.

Instrument Tab

The Instrument tab displays a list of instrument information items that can be printed 
on the report.

Figure 4.97 Page Setup Window: Instrument Tab
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Calibrations Tab

The Calibrations tab displays a list of calibration information items that can be printed 
on the report.

Figure 4.98 Page Setup Window: Calibrations Tab

Samples Tab

The Samples tab displays a list of sample information items that can be printed on the 
report.

Figure 4.99 Page Setup Window: Samples Tab
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Header Tab

The Header tab displays a list of header items that can be printed on the report.

Figure 4.100 Page Setup Window: Header Tab

Miscellaneous Tab

The Miscellaneous tab displays a list of format items for the report, as described below.

Figure 4.101 Page Setup Window: Miscellaneous Tab
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4.4.2.16 Exit

The Exit command is used to exit the Sample Table Editor. If the active file has been 
modified but not saved and the Exit command is selected, a dialog box is displayed as 
shown below. Click the Yes button to save the file before exiting. Click the No button 
to exit without saving the modified information. Click the Cancel button to abort the 
Exit command and return to the active file.

Figure 4.102 Save Changes Prompt

If the software is connected to an instrument and the Exit command is selected, a 
dialog box is displayed as shown below. Click the OK button to disconnect the 
instrument before exiting the software. Click the Cancel button to abort the Exit 
command.

Figure 4.103 Disconnect Instrument Prompt

Setting Item Description

Margins Use the spin controls to enter the page margins (in mm).

Footer, Page No. Select this option to print the page number in the footer 
of each page.

Header Organization: Select this option and enter the name of 
the organization in the text box to print the organization 
name in the page header. 
Logo: Select this option to print a bitmap in the page 
header. Use the Browse button to select the bitmap file.
Date/Time: Select this option to print the current system 
date and time in the page header.
User: Select this option to print the current user name in 
the page header.
Document name: Select this option to print the 
document file name in the page header.
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4.4.3 Edit Menu

The Edit menu contains functions that allow a user to modify data. To change data 
using the Edit menu functions, a user must have the appropriate access rights. Options 
such as Cut, Copy, and Paste are available only when a content selection from an open 
file is made.

Figure 4.104 Edit Menu

4.4.3.1 Undo

The Undo function is used to reverse the last change made in the active Sample Table 
and is only available after the user changes the content of a cell in the table. The Undo 
function is not available during actual measurement or when the user has inserted or 
deleted finished samples, calibration curves, or control samples.

4.4.3.2 Cut/Copy/Paste

The Cut, Copy, and Paste functions are used to edit selected Sample Table cells and 
rows. The Cut command deletes selected information from rows or cells and stores it 
on the clipboard. The Cut command cannot be used to delete entire samples after 
measurement is complete. The Copy command copies selected data from rows or cells 
and stores it on the clipboard. The Paste command copies the contents of the clipboard 
to the selected cells or rows of the table. When pasting an entire row, click the 
destination row number to highlight the entire destination row, then execute the Paste 
command.

Note: When pasting, do not select a destination row that currently contains data. The 
data will be overwritten!

• The Cut, Copy, and Paste commands can also be accessed by clicking the icons 
on the Toolbar. 
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4.4.3.3 Replace

The Replace function is used to replace text in Sample Table cells with specified text. 
Select the Replace function to open the Replace dialog box. The Replace command can 
be used to replace data in the Sample Name, Sample ID, Dilution, and Comment fields 
of the Sample Table. The command cannot be used to replace data for samples after 
measurement is complete. 

Figure 4.105 Replace Dialog Box

4.4.3.4 Find

The Find function is used to search for specified text. Select the Find command to open 
the Find dialog box, which is similar to the Replace dialog box and displays the options 
described below. Refer to Section 4.4.3.3 “Replace” for more details.

Setting Item Description

Find what Enter the text to be searched for.

Replace with Enter the text that the searched-for text should be 
replaced with.

Match case Select to perform a case-sensitive text search.

Find Next Select to begin the search or to continue a search that 
has already begun.

Replace Select to replace the found text with the text in the 
“Replace with” field.

Replace All Select to replace all occurrences of found text with the 
text in the “Replace with” field.

Cancel Select to close the Replace dialog box.

Setting Item Description

Find what Enter the text to be searched for.

Match case Select to perform a case-sensitive text search.

Direction Click the Up radio button to search the table backwards 
from the current location. Click the Down radio button 
to search the table forward from the current location.

Find Next Select to begin the search or to continue a search that 
has already begun.

Cancel Select to close the Find dialog box.
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4.4.3.5 Exclude

The Exclude function is used to exclude selected injections from the calculations. A 
user must have access rights for updating data to use the Exclude function. To exclude 
data, highlight the desired injection shown in the Sample Window Injection Table and 
select Exclude from the Edit menu. A confirmation dialog box is displayed. Click the 
Yes button to exclude the selected data. Click the No button to abort the operation.

Figure 4.106 Exclude Confirmation Dialog Box

4.4.3.6 Recalculate>All

The Recalculate>All function is used to recalculate the data for all measured samples 
in a Sample Table after applying a new calibration curve or excluding injections. To 
execute the command, open the appropriate Sample Table and select Recalculate All 
from the Edit menu. A message is displayed in the Notify folder of the Notification bar 
when the recalculation is complete.

4.4.3.7 Recalculate>Highlighted

The Recalculate>Highlighted function is used to recalculate the data for selected 
samples after applying a new calibration curve or excluding injections. The function is 
similar to the Recalculate All function described in Section 4.4.3.6 “Recalculate>All” 
of this manual. To execute the command, open the appropriate Sample Table, highlight 
the samples to be recalculated, and select Recalculate Highlighted from the Edit menu.

4.4.3.8 Delete Data>All

The Delete Data>All function can only be used if the GLP/GMP conformity was 
disabled during system installation. The function is used to delete all measurement data 
in the Sample Table. The Sample Table structure can then be used to enter new data. A 
user must have access rights for updating data to use the Delete Data>All function.

To use the Delete Data>All function, open a Sample Table that contains measurement 
data and select Delete Data>All from the Edit menu. A confirmation dialog box is 
displayed, as shown in the figure below. Click the Yes button to delete the data. Click 
the No button to abort the operation. A message is displayed in the Notification bar 
when the data has been deleted.

Figure 4.107 Delete Data Confirmation Dialog Box
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4.4.3.9 Delete Data>Highlighted

The Delete Data>Highlighted function is used to delete the measurement data for 
selected samples. To execute the command, open the appropriate Sample Table, 
highlight the samples to be deleted, and select Delete Data>Highlighted from the Edit 
menu. A message is displayed on the Notifications tab in the Notification bar when the 
selected data has been deleted.

4.4.3.10 Import

The Import function is used to import data from an ASCII file into a Sample Table. The 
Import function is not available during sample analysis. To import data, open the 
destination Sample Table and place the cursor in the row of the table where the data 
will be imported. Select the Import function from the Edit menu. The Open dialog box 
is displayed. Select the ASCII file from where the data will be imported. The data is 
inserted in the current position of the active Sample Table.

4.4.4 View Menu

The View menu contains options for viewing calibration, method, and sample 
information, and for selecting settings for the display screen.

Figure 4.108 View Menu

4.4.4.1 Calibration Curve

The View>Calibration Curve command is used to view the calibration curve 
information associated with a sample. Place the cursor in the desired row of the 
Injection Table and select the Calibration Curve command from the View menu. The 
Calibration Curve Properties window is displayed. Refer to Section 4.4.4.5 
“Properties” for more details.

TIP: The Calibration Curve Properties window can also be displayed by clicking the 
Calibration Curve (View) button on the Toolbar.
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4.4.4.2 Method

The View>Method command is used to view the properties associated with a method. 
Selecting the command displays the Sample/Method Properties window, which 
consists of several tabs, including a separate tab for each applicable method. Each tab 
lists options for method properties, as shown in the figures below. Individual options 
can be selected, deselected, or edited by clicking in the check boxes or entering 
information into the text fields. Certain options are disabled if sample analysis is 
complete. Each tab contains the same command buttons: OK, Cancel and Apply. Click 
the OK button to save changes and exit the Sample/Method Properties window. Click 
the Cancel button to exit the Sample/Method Properties window without saving 
changes. Click the Apply button to save changes without exiting the Sample/Method 
properties window.

Figure 4.109 Sample/Method Properties Window: Common Tab

Common Tab

Setting Item Description

System Displays the system currently in use.

User Displays the name of the user who created the method.

Date of Creation Displays the date on which the method was created.

Comment Enter a comment (512 characters maximum).

Print Prints the calibration curve information
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Parameter Tab

Figure 4.110 Sample/Method Properties Window: Parameter Tab

Setting Item Description

Analysis Displays analysis type. Changes cannot be made to this 
field. 

Dilution Displays the preparation dilution factor, which is used 
to calculate sample concentrations. This field can be 
edited.

Sample Name Displays the default sample name (64 characters 
maximum). This field can be edited.

Sample ID Displays the default sample ID (64 characters 
maximum). This field can be edited.

No. of Determinations Displays the number of times (1-10) the sample is 
measured. Determinations and injections are different; 
each determination is made up of one or more 
injections. This field can be edited.

Perform sample checking 
according to USP/EP

Select to enable USP sample checking. 

Current Method Displays the file name of the current method. Changes 
cannot be made to this field.
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TC Tab

Figure 4.111 Sample/Method Properties Window: TC Tab

Analysis Parameters

Setting Item Description

Units Displays the concentration units. This field can be 
edited by selecting another option from the drop-down 
list.

No. of Inj. Displays the minimum/maximum number of injections 
for the samples analyzed with this method. This field 
can be edited.

No. of Wash Displays the number of times the syringe is washed with 
sample prior to the first injection. If the Auto Dilution 
option was selected, the sample is diluted and the 
syringe washed with the diluted sample. This field can 
be edited.

SD Max Displays the maximum acceptable standard deviation. 
If this value is met, no additional injections are required. 
However, if both this value and the CV Max value are 
exceeded, the samples are automatically reinjected up 
to the maximum number of times. This field can be 
edited.

CV Max Displays the maximum acceptable coefficient of 
variation. If this value is met, no additional injections 
are required. However, if both this value and the SD 
Max value are exceeded, the samples are automatically 
reinjected up to the maximum number of times. This 
field can be edited. 

Acid Add Displays the quantity of acid to be added to each 
sample. This value is expressed as a percent of the 
sample volume. This option is available only for NPOC 
and related analyses. This field can be edited.

UV Oxid Vol. Enter the volume of oxidizer solution to be used.
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Peak Time Parameters

Other Parameters

Setting Item Description

Use default settings Select this option to use the default settings for 
peak integration.

Allowed peak start delay Displays the amount of time (in minutes) that 
can elapse before the analysis is stopped 
because a peak is not detected. This field can 
be edited by entering a number between 0 and 
20:00. This option is disabled when Use 
default settings is selected.

Total integration time The total integration time is the amount of time 
(in minutes) that analysis continues after the 
the injection. If the peak end is determined 
prior to the set time, integration stops and the 
next injection is made. Enter a number 
between 4:50 and 20:00.This option is 
disabled when Use default settings is selected.

Setting Item Description

Auto correction of inj. 
volume and dilution

Select this option to enable the instrument to 
automatically adjust the injection volume and 
dilution factor when the peak height for the 
initial injection exceeds full scale. After the 
adjustment, measurement is repeated.

Auto Dilution Displays the factor by which the instrument 
will automatically dilute the sample. This field 
can be edited.

Inj. Volume Displays the injection volume. This field can 
be edited.

Expected Conc. Range Enter the expected concentration if it is 
known.

Use area retrieved from the 
blank check

Select this option to include the blank check 
result in the concentration calculation.

Calibration Curve 1/2/3 Displays the name(s) of calibration curve(s) 
used to quantitate samples analyzed by the 
method. These fields can be edited by entering 
a calibration curve file name or clicking the 
Browse button to search for the file.
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IC Tab

The IC tab options are similar to those described above for the TC tab, except that the 
Acid Add and UV Oxid. Vol. parameters are not available.

Figure 4.112 Sample/Method Properties Window: IC Tab

NPOC Tab

The NPOC tab options are similar to those described above for the TC tab.

Figure 4.113 Sample/Method Properties Window: NPOC Tab
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History Tab

If the History Log was enabled when the method was created, the History tab displays 
a list of changes made to the method parameters. If the History Log was not enabled 
previously, it can be enabled on the History tab.

Figure 4.114 Sample/Method Properties Window: History Tab

A list of the Comment dialog box contents is shown below:

Table 4.6 Comment Dialog Box Contents

Setting Item Description

Enable history log Select this option to enable the software to monitor all 
modifications to the system. If the History Log is not 
required, it need not be enabled, as the software operates 
properly without it. Once the History log is enabled, it 
cannot be disabled.

User has to comment all 
modifications

Select this option to require comments or approval for all 
modifications. If the History Log is not required, it need not 
be enabled, as the software operates properly without it.

ASCII Export The displayed items in the list are exported as a 
tab-delimited text file.

Item Description

Date/Time Displays the date and time of the modification.

User Displays the user who made the modification.

Changed item Describes the parameter that was changed.

From Displays the previous parameter value.

To Displays the new parameter value.

Comment Lists the reason for the modification.
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4.4.4.3 Sample Window

The Sample Window is used to display detailed measurement information. The 
information displayed in the Sample Window varies based on the type of analysis 
performed. To view the Sample Window, open a Sample Table, place the cursor in the 
row of the Sample Table that contains the desired sample, and select Sample Window 
from the View menu. The Sample Window is displayed.

TIP: To view measurement data in real time, place the cursor in the row of the Sample Table 
that contains the current sample (**********), then open the Sample Window.

The Sample Window is divided into 3 sections: the Graph, the Parameter Table, and the 
Injection Table. The sections can be resized by dragging the dividers between the 
sections.

Figure 4.115 Sample Window
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Graph

The upper left section of the Sample Window displays the peak profile graph. Change 
the graph type by choosing from the options on the drop-down list. 

Note: To view the peak profile of the measurement in progress, click the row with the 
asterisk in the Sample No. column. To view a previous measurement, click the 
desired row.

Parameter Table

The upper right section of the Sample Window displays sample parameters.

Setting Items Description

Current Peak Displays the peak profile of the highlighted injection.

All Peaks Displays all injection peaks for the selected sample.

Cal. Curve Displays calibration curves (for calibration standards 
only). This function is not available during real-time 
analysis

Setting Item Description

Sample Name Displays the name of highlighted sample.

Sample ID Displays the sample identification from the Sample 
Table.

Object ID Displays the ID for each set of measured data.

Analysis Displays the analysis method used for the sample.

Result Displays the sample concentration.

Dilution Factor Displays the preparation dilution factor. The result is 
multiplied by this factor to calculate the final 
concentration. If the sample was not diluted, do not 
change the default value of 1.
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Injection Table

The lower section of the Sample Window displays the Injection Table, which contains 
detailed information about the injections performed for the selected sample. Asterisks 
are displayed in the Injection Table for the injection that is currently being measured. 
Some columns in the Injection Table use the Merge Cell function to display 
information that is common to all the injections of a particular sample. If the sample 
has been analyzed by more than one analysis method, the Injection Table contains 
several folders displayed as tabs at the bottom of the window. The columns in the 
Injection Table are described below.

Setting Items Description

Spl. No. Displays the sample number.

Inj. No. Displays the injection number.

Area Displays the area value.

Mean area Displays the mean area value for all injections of that 
sample.

Conc. Displays the concentration obtained for the injection.

Mean Conc. Displays the mean concentration obtained for all 
injections of the sample.

Result Displays the analysis result.

Notes Displays any analysis flags or notations associated with 
that sample.

SD Area Displays the standard deviation calculated from the 
area.

CV Area Displays the coefficient of variation calculated from the 
area.

SD Conc. Displays the standard deviation calculated from the 
concentration.

CV Conc. Displays the coefficient of variation calculated from the 
concentration.

Status Displays the analytical status, either “measuring” or 
“finished.”

Vial Displays the vial number (for ASI samples only).

Excluded Displays the exclusion flag, denoted as “E” for user 
exclusion of the sample, “ES” for exclusion by the 
system, or “Not Excluded”.

Modified Displays the modification flag of “M” if the sample was 
modified.

Inj. Volume Displays the injection volume for each injection.

Dilution Factor Displays the preparation dilution factor used in 
measurement. 

Calibration curve Displays the calibration curve used.
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4.4.4.4 Outlier Test

The Outlier Test (also known as the Grubb test) is used to determine whether a selected 
injection is an outlier. The test also determines whether the injection with the highest 
deviation from the mean value is still within an acceptable range. The Outlier Test can 
only be performed if the sample contains at least three non-excluded injections.

Figure 4.116 Outlier Test (Grubb Test) Window

To perform the Outlier Test, open the Sample Window and select the cells containing 
the data to be tested. From the View menu, select Outlier Test. The Outlier Test (Grubb 
Test) window is displayed. Select either Conc. or Area (CNV) for the data source. 
Exclude the injection that is suspected of being an outlier, then select OK to close the 
dialog box.

If the sample does not contain enough injections for the test to be performed, an error 
message is displayed and the Outlier Test (Grubb Test) window will not open.

The Outlier Test (Grubb Test) window contains the parameters listed below.

Setting Items Description

Result List Displays the result of the Outlier Test.

Conc. radio button Select to indicate that test calculations are to be 
performed based on the concentration data.

Area (CNV) radio button Select to indicate that test calculations are to be 
performed based on the area data.

Result Displays the result of the test.

Exclude button Click this button to exclude a suspect sample and 
recalculate the test result.

Suspicious inj. Indicates the injection suspected of being an outlier, 
which is identified as the sample with the highest 
deviation from the mean value.

SD Displays the standard deviation for all of the injections.

CV Displays the coefficient of variation for all of the 
injections.

Grubb Value Displays the limit value from the Grubb table.

Test Value Displays the calculated Outlier Test value.
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4.4.4.5 Properties

The View>Properties function displays various windows. The display depends on the 
content of the cell selected in the sample table. If a range of cells is selected, the upper 
left cell is considered the active cell. The table below shows the possible selections and 
the corresponding Properties windows.

Table 4.7 Properties Windows

The Properties window contains options for viewing and modifying the method, 
calibration curve, and sample properties. Each Properties window consists of several 
tabs. The Calibration Curve Properties window tabs are shown and described below.

Calibration Curve Properties Window

Figure 4.117 Calibration Curve Properties Window: Common Tab

Content of Active Cell Properties Window

Calibration Curve Calibration Curve Properties window

Method Sample/Method Properties window

Any other cell for a sample Sample/Method Properties window

Any other cell of a control 
sample

Control Sample Properties window
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Common Tab

The Common tab of the Calibration Curve properties window contains information 
about the calibration curve.

Parameter Tab

Figure 4.118 Calibration Curve Properties Window: Parameter Tab

Setting Item Description

System Displays the system used to create the calibration curve. 
This field cannot be edited.

User Displays the name of the user who created the 
calibration curve. 

Date of Creation Displays the date and time the calibration curve was 
created. 

Comment A comment regarding the calibration curve may be 
entered here.

Print Prints the calibration curve information.
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Setting Item Description

Analysis Displays the analysis method used to create the calibration 
curve. This field cannot be edited.

Unit Displays the concentration units. This field can be edited.

Sample Name Displays the default sample name used for the calibration 
standards (64 characters maximum). This field can be 
edited.

Sample ID Displays the default sample ID (64 characters maximum). 
This field can be edited.

No. of Cal. Points Displays the number of calibration standards used. This 
field cannot be edited.

Calculation Method Displays the calibration curve calculation method. This 
field can be edited by selecting a different option from the 
drop-down list. Two calculation methods are available: 
point-to-point and linear regression. For both types, a 
curve representing the relationship between detector 
response and concentration is displayed. The 
point-to-point curve fit draws a straight line between 
adjacent data points and considers each line segment to be 
a separate calibration line governed by its own equation. 
A linear regression statistically determines the line that 
best fits the pattern of all data points. The number used to 
describe the agreement between the calculated line and the 
data points is called the Coefficient of Determination (r2). 
A coefficient of 1 indicates that the line fits the data points 
perfectly.
The general equation for a straight line is:

Y = mX + b
where:
Y = Y-axis data point
X = X-axis data point
m = slope of line
b = Y-axis intercept point

Zero Shift Select Zero Shift to shift the regression curve through the 
origin. This option does not change the slope of the line. 
Use this option as a correction when the TC content in the 
Zero water used to prepare the calibration standards is too 
large to ignore.

Calibration Curve File Displays the file name of the calibration curve. This field 
cannot be edited.
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Analysis Tab

The Analysis tab displays additional analysis parameters.

Figure 4.119 Calibration Curve Properties Window: Analysis Tab

Analysis Parameters

Peak Time Parameters

Setting Item Description

No. Washes Enter the number of times (0-10) the syringe is washed 
with standard prior to the first injection. If the Auto 
Dilution option was selected, the standard is diluted and 
the syringe washed with the diluted standard. 

Acid Add Enter the quantity of acid to be added to each standard 
prior to injection. This value is expressed as a percent of 
the sample volume. This option is available only for 
NPOC or related analyses. 

Sparge Time Enter the pre-sparge time (0-20 minutes). This option is 
only available when the external sparge kit is enabled 
and the analysis type is NPOC.

UV Oxid. Vol. Enter the volume of oxidizer to be added.

Setting Item Description

Use default settings This option is selected if the default settings are used for 
peak integration.

Allowed peak start delay Displays the amount of time (in minutes) that can elapse 
before the analysis is stopped because a peak is not 
detected. 

Total integration time The total integration time is the amount of time (in 
minutes) that analysis continues after the injection. If 
the peak end is determined prior to the set time, 
integration stops and the next injection is made. Enter a 
number between 4:50 and 20:00.



4.4 Sample Table Editor
4.4.4 View Menu

TOC-VWP154

Data Tab

The Data tab displays information about each calibration standard used in the 
calibration curve.

Figure 4.120 Calibration Curve Properties Window: Data Tab

The columns of the Calibration Points window are described below.

Table 4.8  Data Tab Columns

Setting Item Description

Auto Dilution Displays the auto dilution factor.

Inj. Volume Displays the injection volume, which varies depending 
on the analysis type.

Column Name Description

No. Displays the calibration point number.

Conc. Displays the concentration of the calibration point.

Mean Area Displays the mean area value counts from all 
non-excluded injections.

No. of Injections Displays the minimum and maximum number of 
injections.

Excluded “E” indicates that a calibration point has been excluded.

SD Max Displays the maximum standard deviation limit.

CV Max Displays the maximum coefficient of variation limit.

SD Displays the calculated standard deviation.

CV Displays the calculated coefficient of variation.



4.4 Sample Table Editor
4.4.4 View Menu

155TOC-VWP

Additional buttons are displayed below the data columns, and can be used to 
manipulate the calibration parameters. The buttons are described below. Refer to 
Section 4.4.2.2 “Calibration Curve” for more detailed descriptions.

Graph Tab

The Graph tab displays the calibration curve in a graphical format.

Figure 4.121 Calibration Curve Properties Window: Graph Tab

Button Function

Edit Edit the parameters for the selected calibration point.

Add Add a new calibration point.

Delete Delete the selected calibration point.

Delete All Delete all calibration points.

Exclude Exclude the selected calibration point.

Setting Item Description

Slope/Intercept/r^2 The values for Slope, Intercept, and r2 are displayed for 
the selected calibration curve. 
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History Tab

If the History Log was enabled when the calibration curve was created, the History tab 
displays a list of changes made to the calibration curve parameters. If the History Log 
was not previously enabled, it can be enabled on the History tab.

Figure 4.122 Calibration Curve Properties Window: History Tab

A list of the Comment dialog box contents is shown below:

Table 4.9 Comment Dialog Box Contents

Setting Item Description

Enable history log Select this option to enable the software to monitor all 
modifications to the system. If the History Log is not 
required, it need not be enabled, as the software operates 
properly without it.

User has to comment all 
modifications

Select this option to require comments or approval for all 
modifications. If the History Log is not required, it need not 
be enabled, as the software operates properly without it.

Ascii Export The displayed items in the list are exported as a 
tab-delimited text file.

Item Description

Date/Time Displays the date and time of the modification.

User Displays the user who made the modification.

Changed item Describes the parameter that changed.

From Displays the previous parameter value.

To Displays the new parameter value.

Comment Lists the reason for the modification.
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4.4.4.6 Customize

The View>Customize window contains two tabs, one that displays or hides the toolbars 
and one that customizes the toolbar content.

Toolbars Tab

Figure 4.123 Customize Window: Toolbars Tab

Select the desired toolbars from the list. All items are selected by default.

Option Description

Show Tooltips Displays tooltips when the mouse cursor is positioned 
over the toolbar button.

Cool Look Select this option to display the toolbar buttons as flat 
buttons. This item is selected by default.

Large Buttons Select this option to display the toolbar buttons in a 
larger size.

New button Click this button to create a user-defined toolbar button.

Reset button Click this button to reset the toolbar display to its 
original state or delete a user-defined toolbar button.
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Command Tab

Figure 4.124 Customize Window: Command Tab

4.4.4.7 Toolbar

The View>Toolbar function is used to select or deselect individual toolbars for display. 
Toolbar display options (such as button size or appearance) can also be set using this 
command.

Figure 4.125 Toolbar Window

4.4.4.8 Status Bar

The View>Status Bar function toggles the display state of the status bar between Show 
and Hide. If the status bar is currently displayed, selecting this option will hide the 
status bar. If the status bar is not displayed, selecting this option will display the status 
bar.

Option Description

Categories Displays the available toolbars.

Buttons Displays the buttons in the selected toolbar. The buttons 
can be moved by dragging up to any toolbar.

Description Displays a description of the selected button.
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4.4.4.9 ASI / 8-Port Sampler Vials

This function displays the ASI or 8-Port Sampler dialog box, and allows the user to 
enter vial numbers for measurement using the ASI or the 8-Port Sampler. To access this 
command, either create or open a sample table, and select View > ASI / 8-Port Sampler 
Vials. The Sparge / Acid Addition dialog box opens automatically when the Start 
command is made. The OK button saves the changes and closes the dialog box. 

Using the Autosampler

Figure 4.126 Sparge / Acid Addition Dialog Box for the ASI-V

Using One 8-Port Sampler 

Figure 4.127 Sparge / Acid Addition Dialog Box for One 8-Port Sampler

Using Two 8-Port Samplers 

Figure 4.128 Sparge / Acid Addition Dialog Box for Two 8-Port Samplers
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When the mouse is positioned over a vial in the drawing of the of ASI or 8-Port Sampler, a 
tool-tip showing the vial number displayed. Click the vial to display the following items.

TIP: The desired vial position for a sample can be entered either directly into the Vial 
column or by placing the cursor in the appropriate row of the Sparging/Acid Addition 
window and then double-clicking the desired position in the tray diagram.

4.4.4.10 Data Profile

Displays the raw measurement data. The data profile is never modified or processed 
following the initial collection. It includes the corresponding measurement parameters. 
The files which were created and named using the object ID, each occupy a row in the 
sample table, and are stored within the RawData folder in folders named using the date 
of creation.

The View>Data Profile function is used to view the data profile for a sample. Highlight 
the desired row of the Sample Table, then select the command.

Parameter Description
Vial No. Displays the currently selected vial number.
Acid Addition rate Displays the acid addition percentage for each vial.
Sparge time Displays the sparge time for each vial.
Total injection volume Displays the total injection volume for each vial.
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4.4.5 Insert Menu

The Insert menu contains options for inserting sample groups, calibration curves, 
individual samples, and control samples into the Sample Table.

Figure 4.129 Insert Menu

4.4.5.1 Auto Generate

The Auto Generate command opens the Sample Group Wizard, which is used to create 
a group of unknown samples, control samples, and calibration standards, and then 
insert the group into the active position of the Sample Table.

Sample Group Wizard (Page 1) Sample Source

The Sample Source window is used to specify the source of sample measurement 
parameters.

Figure 4.130 Sample Group Wizard (Page 1) Sample Source

Setting Item Description

Method radio button Click this option to analyze the samples using the 
measurement parameters from a specified method. This 
is the default option.

Method text field Enter the desired method or select the method using the 
Browse button.

Calibration Curve radio 
button

Click this option to analyze the samples using the 
measurement parameters from a specified calibration 
curve.

Calibration Curve text 
field

Enter the desired calibration curve or select the curve 
using the Browse button.
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Sample Group Wizard (Page 2) Sample Parameter

The Sample Parameter window is used to enter basic information about the sample group.

Figure 4.131 Sample Group Wizard (Page 2) Sample Parameter

Setting Item Description

No. of Samples Enter the number of samples in the group. Enter an 
integer ranging from 1 to 200. The default value is 1.

Start Vial Enter the starting vial position for the sample group. 
Enter an integer ranging from 0 to 9 or 1 to 100, 
depending on the sample tray size. The default value is 
1. This field is disabled if an autosampler is not a 
component of the configured system.

Sample Name/Sample ID The default designations for these fields are obtained 
from the method or calibration curve identified in Page 
1 of the Sample Group Wizard. Enter other names if 
desired.

Index Start Select this option to start the counting index. Each 
sample added receives an increased counting index 
number.
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Sample Group Wizard (Page 3) Calibration Curves

The Calibration Curves window is used to identify the calibration standards in the 
sample group and to specify their placement in the group. The window is also used to 
revise the list of calibration curves that are used to quantitate samples in the group.

Figure 4.132 Sample Group Wizard (Page 3) Calibration Curves

Setting Item Description

Perform Calibration Select one of the available options for when calibration 
should be performed: At the beginning of the sample 
group or Always, after (a selected number of) Samples 
have been analyzed.

Add button Use this button to add a calibration curve.

Delete button Highlight a calibration curve listed in the window and 
click the Delete button to remove the curve from the 
sample group.

Calibration Curves No.: Displays the calibration point number.
File name: Displays the calibration curve name.
Analysis: Displays the analysis type.
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Sample Group Wizard (Page 4) Controls

The Controls window is used to identify the control samples in a sample group and to 
specify their placement in the sample group.

Figure 4.133 Sample Group Wizard (Page 4) Controls

Insert Control Samples

Use the options listed below to insert individual control samples in the sample group.

Control Templates

The Control Templates table displays a list of the control sample templates currently 
assigned to the sample group. The templates specify measurement parameters, evaluation 
criteria, and failure actions for the control samples. This table is empty by default. Use the 
options listed below to revise the list of control sample templates associated with the 
sample group.

After all four pages of the Sample Group Wizard are complete, click the Finish button 
to save changes and add the sample group to the Sample Table. If invalid parameter 
values were entered, an error message is displayed and the sample group is not inserted 
into the Sample Table until the error is corrected.

Setting Items Description

At the beginning of the 
sample group

Select this option to add control samples at the 
beginning of the sample group.

Always, after (number of) 
Sample(s)

Select this option to add control samples at defined 
intervals between unknown samples.

At the end of the sample 
group

Select this option to add control samples to the end of 
the sample group.

Option Description

Add Select this option to add a control template to the 
sample group.

Delete Select this option to delete a highlighted control 
template from the list.
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4.4.5.2 Sample

The Sample command opens the Sample Wizard, which is used to insert sample 
measurement parameters into an existing Sample Table. The Sample Wizard is not 
accessible during an analysis. 

Sample Wizard (Page 1) Parameter Source

The Parameter Source window is used to specify the source of the sample 
measurement parameters. The source can either be a method file or a calibration file. 
When one of these sources is selected, the sample is analyzed using the same 
measurement parameters as those in the specified file. Some of the source parameters 
can be edited in subsequent pages of the Sample Wizard. A sample can also be added 
to the Sample Table without specifying a source, an option that is desirable when a 
sample is analyzed using different parameters than those specified in the method or 
calibration files. In this case, unique measurement parameters for the sample are 
entered on subsequent pages of the Sample Wizard

Figure 4.134 Sample Wizard (Page 1) Parameter Source

Parameter Description

Method radio button Select this option to use the sample measurement 
parameters from a specified method. This is the default 
option. Enter the method name in the text field or use 
the Browse button to select the file using the File>Open 
dialog box.

Calibration Curve radio 
button

Select this option to use the measurement parameters 
from a specified calibration curve. Enter the calibration 
curve name in the text field, or use the Browse button to 
select the file using the File>Open dialog box. 

Edit parameters manually 
radio button

Select this option to insert a sample without defining a 
source. Sample measurement parameters are entered in 
pages 1-12 of the Sample Wizard.

Skip remaining Wizard 
pages and use 
measurement parameters 
from the source

Select this option to accept all measurement parameters 
from the source file. The Next button becomes a Finish 
button, and subsequent pages of the Sample Wizard are 
not displayed. This option is disabled if Edit parameters 
manually is selected.
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Sample Wizard (Page 2) Analysis Information

Figure 4.135 Sample Wizard (Page 2) Analysis Information

Note: For combined analyses, some Sample Wizard windows may appear more than 
once so that parameter modifications specific to each analysis type can be 
entered. The analysis type that is associated with each Sample Wizard window 
is found in the Analysis box at the top of the window.

Parameter Description

Analysis Select the analysis type from the drop-down list. 

Default Sample Name Enter the sample name. 

Default Sample ID Enter the sample identification.

Dilution Enter the preparation dilution factor. 

No. of Determinations Use the spin controls to enter the number of times the 
sample is measured. Determinations and injections are 
different; each determination is made up of one or more 
injections. Enter an integer from 1 to 10.



4.4 Sample Table Editor
4.4.5 Insert Menu

167TOC-VWP

Figure 4.136 Sample Wizard (Page 3) Calibration Curve

Sample Wizard (Page 3) Calibration Curve

The Calibration Curve window is used to identify the calibration curve(s) used to 
calculate the sample concentration. If more than one curve is identified, the software 
automatically selects the curve to be used in calculating sample concentration. Refer to 
Section 6.2.4 “Automatic Selection of the Optimal Calibration Curve” for details.

Parameter Description

Analysis Displays the analysis type. This field cannot be edited.

Calibration Curve 1/2/3 Enter the name of the calibration curve or click the 
Browse button to select a file using the File>Open 
dialog box.

Skip the injection 
parameter pages of the 
wizard

Select this item to skip the Measurement Parameters 
window of the Sample Wizard. Use this option when the 
sample measurement parameters are the same as those 
used for calibration curve measurements.
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Sample Wizard (Page 4) Injection Parameters

Figure 4.137  Sample Wizard (Page 4) Injection Parameters

Parameter Description

Analysis Displays the analysis type. This field cannot be edited.

Units Enter the concentration units.

Injection Volume Enter the injection volume.

Expected Conc. 
Range

Enter the maximum expected sample concentration.

No. of Injections Enter the minimum and maximum number of injections for the 
sample.

SD Max Enter the maximum acceptable standard deviation. If this value is 
met, no additional injections are required. If both this value and the 
CV Max value are exceeded, the sample is automatically reinjected 
up to the maximum number of times. The SD Max field is disabled if 
the No. of Injections is 1 or if the minimum is equal to the maximum.

CV Max Enter the maximum acceptable coefficient of variation. If this value is 
met, no additional injections are required. If both this value and the 
SD Max value are exceeded, the sample is automatically reinjected up 
to the maximum number of times. The CV Max field is disabled if the 
No. of Injections is 1 or if the minimum is equal to the maximum.

No. of Washes Enter the number of times the syringe is washed with sample prior to 
the first injection. If the Auto Dilution option is selected, the sample 
is diluted and the syringe washed with the diluted sample.

Auto Dilution Enter a dilution factor for the sample. The instrument automatically 
dilutes the sample by this factor, and the result is multiplied by the 
factor to obtain the final concentration. The default Auto Dilution 
value is 1.

Sparge Time Enter the sparge time.
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Sample Wizard (Page 5) Peak Time Parameters

Figure 4.138 Sample Wizard (Page 5) Peak Time Parameters

Acid Addition Enter the desired quantity of acid to be added. This value is expressed 
as a percent of the sample volume. This option is available only for 
NPOC or related analyses.

UV Oxid. Vol. Sets the volume of wet chemical oxidizer that will be added.

Use blank check area Select this option to subtract the blank check area from the measured 
area of the sample. This option is only available for TC and NPOC 
analyses.

Auto. correction of 
inj. vol. and dilution

Select this option to enable the instrument to automatically adjust the 
injection volume and dilution factor when the peak height for the 
initial injection exceeds full scale. After the adjustment, measurement 
is repeated.

Parameter Description

Analysis Displays the analysis type. This field cannot be edited.

Use default settings Select this option to use the default integration parameters. When 
this option is selected, all other options in this window are disabled.

Allowed peak start 
delay

The allowed peak start delay is the amount of time (in minutes) that 
can elapse before the analysis is stopped because a peak is not 
detected. Enter a number between 0 and 20:00.

Total integration time The total integration time is the amount of time (in minutes) that 
analysis continues after the injection. If the peak end is determined 
prior to the set time, integration stops and the next injection is 
made. Enter a number between 4:50 and 20:00.

Parameter Description
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Sample Wizard (Page 6) Calibration Curve

A second Calibration Curve window is only displayed when more than one analysis 
type has been specified. This window is the same as Page 3 of the Sample Wizard, 
which is described above. This screen is displayed when the measurement type is TOC. 
Verify the analysis type in the Analysis text box at the top of the page and make the 
appropriate selections.

Figure 4.139 Sample Wizard (Page 6) Calibration Curve Window (Second Analysis)
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Sample Wizard (Page 7) Injection Parameters

A second Injection Parameters window is only displayed when more than one analysis 
type has been specified. This window is the same as Page 4 of the Sample Wizard, 
which is described above. This screen is displayed when the measurement type is TOC. 
Verify the analysis type in the Analysis text box at the top of the page and make the 
appropriate selections.

Figure 4.140 Sample Wizard (Page 7) Injection Parameters Window (Second Analysis)
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Sample Wizard (Page 8) Peak Time Parameters

A second Peak Time Parameters window is only displayed when more than one 
analysis type has been specified. This window is the same as Page 5 of the Sample 
Wizard, which is described above. This screen is displayed when the measurement type 
is TOC. Verify the analysis type in the Analysis text box at the top of the page and 
make the appropriate selections.

Figure 4.141 Sample Wizard (Page 8) Peak Time Parameters Window (Second Analysis)

Sample Wizard (Page 9) USP/EP

The USP/EP window is displayed only for TC or NPOC methods, and is used to enable 
samples to be checked in accordance with USP/EP standards. Select the check box to 
enable the function.

Figure 4.142 Sample Wizard (Page 9) USP/EP
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4.4.5.3 Control

The Control command is used to insert a control sample into an existing Sample Table. 

Note: A control sample template must be created before a control sample can be 
inserted into a Sample Table. A control sample template has a file extension of 
*.tpl and specifies measurement parameters for the Control Sample. 

The following subsections describe the procedures for creating a control 
sample template and for inserting a control sample into a Sample Table.

Creating a Control Sample Template

Control sample templates are created using the Control Sample Wizard. To access the 
Control Sample Wizard select File>New>Control Sample Template. The Control 
Sample Wizard consists of several windows, each of which defines specific parameters 
for the control sample template.

Control Sample Wizard (Page 1) System Information

Figure 4.143 Control Sample Wizard (Page 1) System Information

Parameter Description

System Select the instrument.

Operator Displays the current operator name. This field cannot be 
edited.

Date of Creation Displays the current date and time. This field cannot be 
edited.

Comment Enter a comment (512 characters maximum).
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Control Sample Wizard (Page 2) Control Sample Type

The Control Sample Type window is used to identify the type of control sample.

Figure 4.144 Control Sample Wizard (Page 2) Control Sample Type

Parameter Description

Control Sample Select this option to define individual sample 
parameters. This is the default option.

Control Chart Sample Select this option to add the control sample to a defined 
control chart. Enter the file name or use the Browse 
button to select the control chart file from the 
File>Open dialog box.

System Suitability Test for 
USP/EP

Select this option to check the control sample using 
USP/EP criteria.

Save the data in a control 
sample template

Enter a file name or use the Browse button to select the 
control sample template from the File>Open dialog 
box.
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Control Sample Wizard (Page 3) Parameter Source

The Parameter Source window is used to specify the source of the control sample 
measurement parameters. The source can either be a method file or a calibration file. 
When one of these sources is selected, the control sample is analyzed using the same 
measurement parameters as those in the specified method or calibration file. Some of 
the source parameters can be edited in subsequent pages of the Control Sample Wizard. 
A control sample can also be added to the Sample Table without specifying a source, 
an option that is desirable when a control sample is analyzed using different parameters 
than those specified in the method or calibration files. In this case, unique 
measurement parameters for the sample are entered on subsequent pages of the Control 
Sample Wizard.

Figure 4.145 Control Sample Wizard (Page 3) Parameter Source

Parameter Description

Method radio button Select this option to use the measurement parameters from a 
specified method. Enter the method name in the text field, or 
use the Browse button to select the file using the File>Open 
dialog box. This is the default option.

Calibration Curve radio 
button

Select this option to use the measurement parameters from a 
specified calibration curve. Enter the calibration curve name 
in the text field, or use the Browse button to select the file 
using the File>Open dialog box. 

Edit parameters 
manually radio button

Select this option to insert a control sample without defining 
a source. Control sample measurement parameters are 
entered in subsequent pages of the Control Sample Wizard.

Skip remaining Wizard 
pages and use 
measurement 
parameters from the 
source

Select this option to accept all measurement parameters from 
the source file. The Next button becomes a Finish button, and 
subsequent pages of the Control Sample Wizard are not 
displayed. This option is disabled if Edit parameters 
manually is selected.
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Control Sample Wizard (Page 4) Analysis Parameters

Figure 4.146 Control Sample Wizard (Page 4) Analysis Parameters

Parameter Description

Analysis Select the analysis type from the drop-down list. If a 
source method or calibration file was specified on Page 
3 of the Control Sample Wizard, this field is disabled 
and the applicable analysis type is displayed.

Default Sample Name Enter the sample name. If a source method or 
calibration file was specified on Page 3 of the Control 
Sample Wizard, the default sample name from the 
source is displayed.

Default Sample ID Enter the sample identification. If a source method or 
calibration file was specified on Page 3 of the Control 
Sample Wizard, the default sample identification from 
the source is displayed.

Dilution Enter the dilution factor. If a source method or 
calibration file was specified on Page 3 of the Control 
Sample Wizard, the default dilution factor is displayed.

Calibration Curve Enter the calibration file name that is used to calculate 
control sample concentration. If a source method or 
calibration file was specified on Page 3 of the Control 
Sample Wizard, the default calibration curve name from 
the source is displayed.
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Control Sample Wizard (Page 5) Injection Parameters

Figure 4.147 Control Sample Wizard (Page 5) Injection Parameters

Parameter Description

Analysis Displays the analysis type. This field cannot be edited.

Units Select the concentration units.

Injection Volume Enter the injection volume.

Expected Conc. Range Enter the maximum expected concentration.

No. of Injections Enter the minimum/maximum number of injections for the 
control sample. The setting range is from 1-20.

SD Max Enter the maximum acceptable standard deviation. If this 
value is met, no additional injections are required. If both 
this value and the CV Max value are exceeded, the control 
sample is automatically reinjected up to the maximum 
number of times. The SD Max field is disabled if the No. of 
Injections is 1 or if the minimum is equal to the maximum.

CV Max Enter the maximum acceptable coefficient of variation. If 
this value is met, no additional injections are required. If 
both this value and the SD Max value are exceeded, the 
control sample is automatically reinjected up to the 
maximum number of times. The CV Max field is disabled if 
the No. of Injections is 1 or if the minimum is equal to the 
maximum.

No. of Washes Enter the number of times the syringe is washed with sample 
prior to the first injection. If the Auto Dilution option is 
selected, the sample is diluted and the syringe washed with 
the diluted sample.
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Control Sample Wizard (Page 6) Peak Time Parameters

The Peak Time Parameters window is used to set peak detection parameters for the 
control samples.

Figure 4.148 Control Sample Wizard (Page 6) Peak Time Parameters

Auto Dilution Enter a dilution factor for the samples. The instrument 
automatically dilutes the control sample by this factor, and 
the result is multiplied by the factor to obtain the final 
concentration. The default Auto Dilution value is 1.

Acid Addition Enter the desired quantity of acid to be added. This option is 
available only for NPOC and related analyses.

Sparge Time Enter the sparge time.

UV Oxid. Vol. Enter the volume of the wet chemical oxidizer to be added.

Use area retrieved from 
the blank check

Select this option to subtract the blank check area from the 
measured area of the control sample.

Setting Item Description

Use default settings Select this option to use the default integration parameters. 
When this option is selected, all other options in this window 
are disabled.

Allowed peak start 
delay

The allowed peak start delay is the amount of time (in 
minutes) that can elapse before the analysis is stopped because 
a peak is not detected. Enter a number between 0 and 20:00.

Total integration time The total integration time is the amount of time (in minutes) 
that analysis continues after the injection. If the peak end is 
determined prior to the set time, integration stops and the next 
injection is made. Enter a number between 4:50 and 20:00.

Parameter Description
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Control Sample Wizard (Page 7) History

The History window is used to enable the History Log. The History Log records all 
modifications to the control sample template properties. The History Log can be set to 
require users to enter comments for each modification.

Note: Once the History Log is enabled, it cannot be disabled. All modifications to the 
control sample template are tracked. If the mandatory comment option is 
selected, the user is required to enter a comment each time any parameter in 
the control sample template is modified.

Figure 4.149 Control Sample Wizard (Page 7) History

Setting Item Description

Enable history log Select this option to enable the software to monitor all 
modifications to the control sample template. Once this 
is enabled, it cannot be disabled. If the History Log is 
not required, it need not be enabled, as the software 
operates properly without it.

User has to comment all 
modifications

Select this option to require comments or approval for 
all modifications. 
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Control Sample Wizard (Page 8) Control Checking

The Control Checking window is used to select options for control checks and control 
limits. This window is not displayed if the USP/EP system suitability criteria are used 
because the control limits are already defined.

Figure 4.150 Control Sample Wizard (Page 8) Control Checking

Setting Option Description

Recovery Select this option to check recovery amounts in control 
samples.

Spiked Select this option to use an original and a spiked sample to 
calculate the recovery amount. This option is enabled only 
when the Recovery option is selected.

Original Concentration Enter the original concentration of the spiked sample. This 
field is enabled only when the Recovery option is selected.

Spiked Concentration Enter the concentration of the spiked sample. This field is 
enabled only when the Recovery and Spiked options are 
selected.

Mean Value 
(Concentration)

Select this option to check the mean value of the measured 
concentrations.

Blind Value (Area) Select this option to check the mean value of the measured 
area values.

Spanwidth 
(Concentration)

Select this option to check the deviation of the measured 
concentrations.

Max. Dev. Enter the maximum acceptable deviation. This field is 
enabled only when the Spanwidth option is selected.

Low Enter the lower limit of the valid control range if the Blind 
Value option is selected.

Up Enter the upper limit of the valid control range if the Blind 
Value option is selected.
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Control Sample Wizard (Page 9) Failure Action

The Failure Action window is used to specify the actions taken when a control sample 
exceeds the specified control limits.

Figure 4.151 Control Sample Wizard (Page 9) Failure Action

Note: Save the control sample template and close the Control Sample Wizard by 
clicking the Finish button.

Setting Item Description

Action when the failure 
event occurs the first time

Select the action to be taken the first time a control 
sample exceeds the control limits. Options available 
from the drop-down list are:
Continue (notify): Select this option to allow the 
analysis sequence to continue normally and display a 
failure message in the Notification bar.
Stop (whole sample run): Select this option to stop the 
sample run and display a failure message in the 
Notification bar.
Repeat (from last control or calibration): Select this 
option to automatically reanalyze all samples analyzed 
after the previous valid control sample or calibration 
curve (whichever occurred most recently) and display a 
failure message in the Notification bar.

Action when the failure 
event occurs the second 
time

Select the action to be taken the second time a control 
sample exceeds the control limits. The options available 
from the drop-down list are Continue and Stop. The 
Repeat option is not available.
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Inserting a Control Sample into the Sample Table

Once the control sample template has been created, a control sample can be entered 
into the Sample Table by following the procedure below.

Procedure

1. Open the Sample Table and place the cursor in the row where the control 
sample will be inserted.

2. From the Insert menu, select Control.

The Open dialog box displays the available control sample template files.

3. Select the appropriate control sample template and click the Open button.

The Open dialog box closes and the Sparging/Acid Addition window is 
displayed.

4. Enter the ASI vial position for the control sample into the appropriate cell in 
the Sparging/Acid Addition window. 

5. Click the OK button.

The Sparging/Acid Addition window closes.

6. Scroll through the Sample Table to verify that the control sample has been 
inserted at the correct location.
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4.4.6 Instrument Menu

The Instrument menu contains commands for connecting, starting, and stopping the 
instrument, and for instrument maintenance functions.

Figure 4.152 Instrument Menu

4.4.6.1 Background Monitor

The Background Monitor command is used to open the Background Monitor window, 
which displays the status of the autosampler and all installed instrument detectors. The 
real time signal and ready status for various detectors can be viewed by toggling 
between the individual instrument tabs. The command is available only when an 
instrument is connected to the software. Instrument and communication errors are 
displayed in the Notification bar. The Background Monitor window cannot be opened 
during measurement.

TOC Tab

Figure 4.153 Background Monitor Window: TOC Tab

The baseline is displayed at the bottom of the TOC tab window.

Parameter Description

Wet Reactor Displays the temperature of the TC reactor.

Dehumidifier Displays the temperature of the dehumidifier.

NDIR Baseline Pos.: Displays the status of the NDIR detector baseline 
position.
Baseline Fluc.: Displays the status of the NDIR detector 
baseline fluctuation.
Baseline Noise: Displays the status of the NDIR detector 
baseline noise.
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ASI Tab

The ASI tab is available only if the ASI is connected to the instrument. The ASI Power 
indicator displays the power status of the ASI. The ASI Cover indicator displays the 
status of the ASI cover.

Figure 4.154 Background Monitor Window: ASI Tab

4.4.6.2 Connect

The Connect command is used to connect or disconnect the instrument and the 
software. If the instrument is not connected, selecting the Connect command opens the 
communication port, initializes the instrument, and downloads and checks the 
instrument parameters. During this process, the Sequence window displays the 
progress of the connection. To abort the Connect operation while it is in progress, click 
the Cancel button.

Figure 4.155 Sequence Window

The bottom portion of the Sequence window displays a list of tasks that are performed 
during the Connect process. The progress and result of each task are shown in columns 
to the right of the task list. The Sequence window closes when the connection process 
is complete. If an error occurs during the Connect process, an error message is 
displayed in the Notification bar and the result column, and the Sequence window 
remains open.

If the instrument is already connected to the software, the Connect command is used to 
disconnect the instrument. A confirmation request dialog box is displayed when the 
command is selected, as shown below.
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Figure 4.156 Disconnect Confirmation Request Dialog Box

Click the OK button to disconnect the instrument, or the Cancel button to abort the 
disconnect operation. 

4.4.6.3 Standby

The Standby function is used to shut down the instrument. To access the Standby 
function, open a Sample Table and select Standby from the Instrument menu. The 
Standby window, which lists options for the shutdown operation, is displayed. Select 
the desired options and click the Standby button. Click the Escape button to abort the 
Standby operation and maintain the instrument in Ready mode. 

Reference: Refer to Section 4.3.4 “Ending Measurement” to end measurement.

Figure 4.157 Standby Window

Item Description

Shut down instrument Select this option to begin instrument shutdown. After 
Execute is pressed, the carrier gas, UV lamp and TC 
reactor heater are turned off. 

Auto restart Select this option to shut down the instrument and 
automatically restart it at a specified time. Set the restart 
time using the spin controls for Auto start time. The 
default settings are the current system date and time.

UV Lamp & Reactor Select this option to keep the TC reactor UV lamp and 
heater on for 30 minutes. This option is available only 
when the Auto restart option is selected.

Carrier Gas Select this option to keep the carrier gas flowing for 30 
minutes. This option is available only when the Auto 
restart option is selected.
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4.4.6.4 Start(Continue)

The Start command is used to start the instrument. Start a sequence by opening a 
Sample Table, inserting samples, connecting the instrument, and selecting Start from 
the Instrument menu. Refer to Section 4.4.6.2 “Connect” for more information on 
connecting the instrument. 

The Standby window is displayed. Click the Keep running radio button. If the ASI is 
installed, the Sparging/Acid Addition window is displayed. Verify the vial positions 
and click the Start button to begin measurement.

If the ASI is not installed, the Meas Mode dialog box is displayed. To perform 
continuous measurement or to continue measurement, click OK. Click cancel to abort 
the start procedure.

Figure 4.158 Meas Mode Dialog Box

4.4.6.5 Stop>Peak Stop

The Stop>Peak Stop command is used to interrupt the current measurement. The peak 
measured up to the stopping point is considered a complete peak. After the Stop>Peak 
Stop command is executed, the next injection listed in the Sample Table is made and 
analysis continues normally.

4.4.6.6 Stop>Finish Current Sample

The Stop>Finish Current Sample command is used to interrupt measurement after all 
injections of the current sample are complete. After the Stop>Finish Current command 
is executed, the instrument remains in the Ready mode.

4.4.6.7 Stop>Halt

The Stop>Halt command is used to immediately interrupt the current measurement, 
discard data from the current injection, and return the instrument to the Ready mode.

Item Description

Normal This mode requires user input between each 
sample before the instrument will move to the 
next sample in the sample table.

Continuous Select this mode to measure continuously 
through the sample table rows until the 
instrument is stopped by the user.

Non Stop Mode Select this mode to perform measurement 
continuously using more than one type of 
measurement modes.
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4.4.7 Maintenance Menu

Instrument maintenance procedures are described in Section 5.5 “Software-Controlled 
Maintenance Functions” of this manual. All maintenance functions can be initiated 
using the options displayed in the Instrument>Maintenance menu.

4.4.8 Tools Menu

Figure 4.159 

4.4.8.1 Administration

The Administration function is used to access the Administration module of the 
TOC-Control V software.

4.4.8.2 Screen Lock

If the user must temporarily leave the PC he/she is logged into, the screen can be 
locked by using the password function to prevent another individual from performing 
operations in TOC-Control V. This function can be used only if the User ID / Password 
item is checked in the Security dialog box.

To lock the screen, select Screen Lock in the Tools menu. The screen will then be 
locked and the Re-enter Password dialog box is displayed. To release the screen lock, 
enter the user ID and password into the designated fields. If the user ID and password 
entered are not the same as those used up to that point, the screen lock will not be 
released.

Figure 4.160  Re-enter Password Dialog Box
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4.4.9 Options Menu

The Options menu contains commands for viewing and displaying system information 
and for setting default measurement parameters.

Figure 4.161 Options Menu

4.4.9.1 General Information

The General Information command is used to view information about the system. The 
General Information window contains two tabs, one that displays System parameters 
and one that displays History information. Most of the fields in the General 
Information window are disabled because they were set previously. After changing an 
active field, click the OK button to close the window and save the changes or click the 
Apply button to save the changes without closing the window. Click the Cancel button 
to close the window without saving changes.

Figure 4.162 General Information Window: System Tab

System Tab

The System tab displays general parameters.

Parameter Description

System Displays the instrument identification.

File Version Displays the instrument file version.

User Displays the name of the user who set up the system. 

Date of Creation Displays the date the system was set up.

Comment Enter a comment (512 characters maximum), if desired.
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History Tab

Figure 4.163 General Information Window: History Tab

The History tab is used to view the system’s History Log or to enable the log if it was 
not previously selected.

Note: Once the History Log is enabled, it cannot be disabled.

Setting Item Description

Enable history log Select this option to enable the software to monitor all 
modifications to the system. If the History Log is not 
required, it need not be enabled, as the software 
operates properly without it.

User has to comment all 
modifications

Select this option to require comments or approval for 
all modifications. 
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4.4.9.2 Default Measurement Parameters

The Default Measurement Parameters command is used to enter the default values for 
samples, methods, and calibration curves. The Default Measurement Parameters 
window contains a separate tab for each analysis type, into which the default values are 
entered.

Figure 4.164 Default Measurement Parameters:
TC/IC/NPOC/POC/TN/SSM-TC/SSM-IC Tabs

The parameters shown on each of the tabs are similar and are described below.

Parameter Description

Units Select the default concentration units.

No. of injections Enter the default minimum/maximum number of 
injections.

No. of washes Enter the default number of times the syringe is washed 
with sample prior to the first injection. If the Auto 
Dilution option is selected, the sample is diluted and the 
syringe washed with the diluted sample.

Max SD Enter the default maximum acceptable standard 
deviation. If this value is met, no additional injections 
are required. If both this value and the Max CV value 
are exceeded, the samples are automatically reinjected 
up to the maximum number of times. The SD Max field 
is disabled if the No. of Injections is 1 or if the minimum 
is equal to the maximum.

Max CV Enter the default maximum acceptable coefficient of 
variation. If this value is met, no additional injections 
are required. If both this value and the Max SD value are 
exceeded, the samples are automatically reinjected up 
to the maximum number of times. The CV Max field is 
disabled if the No. of Injections is 1 or if the minimum 
is equal to the maximum.



4.4 Sample Table Editor
4.4.9 Options Menu

191TOC-VWP

4.4.9.3 Display Settings>Display Font

The Display Settings>Display Font function is used to select font options for both the 
general screen display (such as in the Sample Table and Print Preview screens) and 
printed reports. Select a font type, style, size, and color from the lists in the Font dialog 
box. A preview of the font appearance is displayed in the Sample field.

Figure 4.165 Font Dialog Box

4.4.9.4 Display Settings>Table Settings

The Display Settings>Table Settings function is used to select the parameters that are 
displayed in the Sample Table window. The Table Options window contains two tabs, 
one that lists Sample Table parameters and one that lists Injection Table parameters. On 
each tab, certain options are selected by default. Individual options can be selected or 
deselected by clicking in the check box. Use the Select All and Select None buttons to 
quickly select and deselect all options on a tab. Use the Default button to select the 
default options.

Sample Table Tab

Select the parameters that are displayed in the Sample Table.

Figure 4.166 Table Options Window: Sample Table Tab
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Samples Tab

Select the parameters that are displayed in the Injection Table.

Figure 4.167 Table Options Window: Samples Tab

4.4.9.5 Display Settings>Notification Bar Settings

The Display Settings>Notification Bar Settings function is used to set options for the 
Notification bar, where error messages and other notices are displayed. The 
Notification bar is located at the bottom of the Sample Table Editor window. 

Four folders can be displayed in the Notification Bar: Notifications, System Folders, 
Errors, and Events. When a folder is selected, a tab appears for that folder in the 
Notification bar. When more than one folder is selected for display, the contents of a 
specific folder can be displayed by clicking the appropriate tab.

Figure 4.168 Notification Bar Settings Window

Setting Item Description

Folder List Lists the folders that can be displayed in the 
Notification bar.

Display Folder Place a check in this box to display the folder. 

Max. Number of 
Displayed Lines

Enter the maximum number of lines to be displayed in 
the Notification bar. Acceptable values range from 0 to 
200.

Font Displays the selected font. Modify the font by selecting 
the Browse button to open the Font dialog box.



4.4 Sample Table Editor
4.4.9 Options Menu

193TOC-VWP

To select a folder for display in the Notification bar, click the folder in the Folder List, 
then select the Display Folder option. Set the Max. Number of Displayed Lines field to 
a value greater than 0. To change the color or appearance of the text displayed in the 
folder, use the Font option. The Display Folder check box, Max. Number of Displayed 
Lines field, and Font option apply only to the selected folder; as a result, these options 
must be set separately for each folder. 

Note: A folder is not displayed in the Notification bar unless the Display Folder 
option is selected and the Max. Number of Displayed Lines field is set to a 
value greater than 0.

4.4.9.6 Display Settings>Floating Point Number Formats

The Display Settings>Floating Point Number Formats command is used to select 
display options for numerical results in the Sample Table. These options apply only to 
the manner in which numbers are displayed; internal data retain their original values.

Figure 4.169 Floating Point Format Window

Select settings for both common numbers and percent values, as described below.

Common Floating Point Numbers

Percent Values

Setting Item Description

Number of 
significant digits

Select this option to display common floating point numbers using 
a specified number of significant digits. Use the spin control to set 
the number of significant digits. The default value is 4.

Number of digits 
after the decimal 
point

Select this option to display common floating point numbers using 
a specified number of digits after the decimal point. Use the spin 
control to set the number of digits after the decimal point. The 
default value is 2.

Setting Item Description

Number of significant 
digits

Select this option to display percent values using a specified 
number of significant digits. Use the spin control to set the 
number of significant digits. The default value is 4.

Number of digits after 
the decimal point

Select this option to display percent values using a specified 
number of digits after the decimal point. Use the spin control to 
set the number of digits after the decimal point. The default value 
is 2.
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4.4.9.7 Directories

The Directories function is used to modify system directories. Select 
Options>Directories to display the Folder window.

Figure 4.170 Folder Window

Show all directories for

Use the drop-down list to access various directories. Available directories are listed in 
the Folder text field.

Add

Click the Add button to add a new directory to the list for a specified topic, and the 
Folder dialog box is displayed. Highlight the desired directory from the drop-down 
Drive and Directory lists, then select it by clicking the OK button. Click the Network 
button to access a network drive.

Figure 4.171 Folder Dialog Box

Delete

Click the Delete button to delete a selected directory from the list.

Up

Click the Up button to move the selected directory up one line in the list. The order of 
the directories in the list determines the order directories are searched during 
instrument operation.

Down

Click the Down button to move the selected directory down one line in the list. The 
order of the directories in the list determines the order directories are searched during 
instrument operation.
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4.4.10 Window Menu

Figure 4.172 Window Menu

Cascade

The Cascade command is used to stack all open windows so that the title bars are 
visible.

Tile

The Tile command is used to size all open windows so that each window occupies an 
equal portion of the screen.

Arrange Icons

The Arrange Icons command is used to neatly organize windows that have been 
minimized or reduced to icons.

4.4.11 Help Menu

Figure 4.173 Help Menu

About

The About command is used to view copyright, software registration, and software 
version information.



4.4 Sample Table Editor
4.4.11 Help Menu

TOC-VWP196



5
5Maintenance

Inspection and maintenance of the TOC-V instrument are required to ensure 
normal operation and reliable and accurate data acquisition. 

5.1 Daily Inspection

Describes the daily inspection procedures that should be performed before 
instrument startup.

5.2 Periodic Inspections

Describes periodic inspection procedures for the TOC-V.

5.3 ASI-V Autosampler Maintenance

Describes periodic inspection procedures for the autosampler.

5.4 8-Port Sampler (OCT-1) Maintenance

Describes periodic inspection procedures for the 8-Port Sampler.

5.5 Software-Controlled Maintenance Functions

Describes maintenance functions controlled by the TOC-Control V software.

5.6 Troubleshooting

Describes the content of error messages and troubleshooting procedures.
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5.1 Daily Inspection

Check the levels of dilution water, oxidizing reagent, acid and drain vessel water 
before starting the instrument for the day's operations.

5.1.1 Checking the Dilution Water 

Verify that there is sufficient dilution water for analysis. Referring to Section 4.1.8 
“Preparation of Dilution Water”, replenish the dilution water as necessary. To obtain 
good measurement reproducibility, the dilution water should be replaced with fresh 
purified water every day. 

5.1.2 Checking the Persulfate Oxidizer Reagent 

Check the oxidizer before using the instrument. Referring to Section 4.1.6 “Preparing 
the Persulfate Oxidizer Solution”, replenish or replace the persulfate oxidizer reagent 
as necessary. Depending on the amount normally used, a narrow-mouth 1L glass bottle 
can be used as a suitable container. 

5.1.3 Checking the Acid

Verify that there is adequate acid for analysis. Referring to Section 4.1.7 “Preparing 
Acid”, replenish or replace the acid as necessary. Depending on the amount normally 
used, a narrow-mouth 1L glass bottle is a suitable container.
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5.1.4 Checking the Drain Vessel Water Level 

Figure 5.1 Drain Vessel Water Level

Verify that the water level in the drain vessel inside the instrument is within 10mm of 
the overflow tube on the side of the drain vessel. If the level is lower replenish using 
purified water.

Confirm that carrier gas does not leak from the tip of the drain tubing when the flow 
rate is 200mL/min.

Reference: Refer to Section 4.1.5 “Water Supply to the Dehumidifier Drain Container” for details on 
adding purified water.

5.1.5 Checking the Waste Container

Before using the instrument, check the liquid level in the waste container. Since the 
waste liquid is corrosive (acidic), ensure that the remaining container capacity is 
sufficient to prevent overflow of the container during instrument operation. Empty the 
container if there is insufficient capacity.

Overflow Tube
Drain Vessel

Purified Water
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5.2 Periodic Inspections

To maintain the performance of the instrument, perform periodic checks of the items 
listed in this section.

5.2.1 Replacing the High Purity Nitrogen (Cylinder)

A 47L cylinder of high purity nitrogen carrier gas will last about 1.5 months. Replace 
the cylinder before it is completely empty, while the remaining pressure is still several 
hundred kPa. When connecting the new cylinder, clean the connection port, and after 
connecting the tubing, be careful not to allow any dust to enter the instrument. 

Keep one full cylinder available as a spare. 

5.2.2 Replacing the CO2 Absorber

Once a year, replace each of the CO2 absorbers (P/N 630-00999) installed behind the 
instrument. 

CO2 Absorber Disposal Procedure

Used CO2 absorbers should be disposed of according to local industrial waste disposal 
regulations. It must be clearly disclosed using an industrial waste manifest that the CO2 
absorber contains soda lime.

Reference: Refer to Section 4.1.9 “Installation of the CO2 Absorber” for details on replacing the CO2 
absorbers.
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5.2.3 Replacing the Halogen Scrubber

The absorbent inside the halogen scrubber turns black as it absorbs chlorine; this 
discoloration band advances toward the outlet as the amount of chlorine absorbed 
increases. When the front of the discoloration band reaches the position shown in 
Figure 5.2 “Halogen Scrubber”, replace the scrubber with a new halogen scrubber. 

Replacement Procedure 

1. Open the upper and lower clips securing the halogen scrubber.

2. Remove the upper and lower connection clamps.

3. Disconnecting the Viton connectors remove the halogen scrubber.

Figure 5.2 Halogen Scrubber

Note: The halogen scrubber protects the more expensive non-dispersive 
infrared (NDIR) detector from corrosion. The halogen scrubber should 
be replaced as described above to avoid damage to the NDIR.

The baseline may fluctuate after replacement. Allow the instrument to run for a short 
time until the baseline stabilizes. Stabilization normally occurs within one hour.

Used halogen scrubbers should be disposed of according to local industrial waste 
disposal regulations. It must be clearly disclosed using an industrial waste manifest that 
the halogen scrubber contains copper

Figure 5.3 Halogen Scrubber Replacement

Dehumidifier

Gas Flow Direction

To Sample

Halogen Reactant-filled Cylinder

Replace Scrubber When
Discoloration Band Reaches
this Point

Cell Inlet

Clamps

Clips

Viton Connectors
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5.2.4 Replacing the Syringe Plunger Tip

The syringe plunger tip is constructed of fluororesin and wears with use. Gaps will 
eventually form between the plunger and the inner wall of the syringe barrel (glass 
tube) causing leaks. When leaks occur, bubbles are produced near the syringe tip while 
the sample is being drawn into the syringe or the sample may leak from the bottom of 
the barrel when the sample is discharged. Replace the plunger tip if either of these 
situations occur.

Replacement Procedure

1. Refer to Section 4.1.3 “Installing the Syringe” to remove the syringe.

2. As shown in Figure 5.4 “Removing the Old Plunger Tip”, use a sharp knife to 
make two or three incisions at the bottom of the plunger tip. 

3. Grasp the plunger tip with a pair of pliers and remove it from the plunger. The 
O-ring that is held in place by the plunger tip also comes off. DO NOT reuse 
this O-ring.

Figure 5.4 Removing the Old Plunger Tip

4. Refer to Figure 5.5 “Installing the New Plunger Tip (Cross-section)”. Push 
down on the plunger, press the leading edge of the new plunger tip, straight 
into the plunger tip seat. 

Figure 5.5 Installing the New Plunger Tip (Cross-section)

Note: Do not to scratch the perimeter of the plunger tip. This could cause leaks. 
Use only Shimadzu-specified plunger tips. Use of unspecified parts may result 
in instrument malfunction and/or diminished performance. 

Plunger Tip

Plunger Tip Seat
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5.2.5 Washing the TC Reactor

Procedure

1. Loosen both of the TC reactor cover screws. 

2. Remove the 6 retaining pins that secure the TC reactor heater insulation, and 
open both of the TC reactor heater retaining brackets.

 

Figure 5.6 TC Reactor Heater

3. Remove the TC reactor, and disconnect the tubing from the narrow end and 
branch tube of the TC reactor.

4. Open the upper door, and detach the UV lamp connector from the UV lamp 
power supply board. 

5. Referring to Figure 5.7 “Removing the UV Lamp”, pull the UV lamp out of 
the TC reactor along with the TC reactor cap.

Figure 5.7 Removing the UV Lamp

Retaining
Retaining
Brackets

Pins

UV Lamp
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6. Wash the TC reactor and UV lamp and rinse well with purified water. Do not 
allow water to contact the UV lamp lead or connector.

7. Using the procedure described in Section 4.1.1 “Installing the TC reactor”, re-
install the TC reactor and UV lamp.

 CAUTION

• Turn OFF the TC reactor heater and the UV lamp. Wait for the heater 
to cool to room temperature before performing any maintenance on 
the TC reactor. There is a danger of burn injury and electric shock. 

• High voltage is applied to the UV lamp and UV lamp power supply. 
Due to the danger of electric shock, turn OFF the UV lamp before 
performing any maintenance on the TC reactor.

• The oxidizing reagent is corrosive and may leak into the TC reactor. 
DO NOT spill or touch this reagent.

• The TC reactor is glass. To avoid injury, do not break the glass when 
connecting the TC reactor.

• When tightening the plastic nuts used on the connectors, do not use 
any tools. Tightening securely by hand is sufficient.

• Do not contaminate the internal or external surfaces of the TC reactor 
or its connections with organic substances such as grease or oil. This is 
critical for high sensitivity measurement.
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5.2.6 Washing the IC Reactor

Procedure

1. Remove the IC reactor from the mounting clamps.

Figure 5.8 Removing the IC Reactor

2. Disconnect the tubing from the narrow end and branch tube.

Mounting Bracket
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3. Remove the rubber cap from the top of the IC reactor along with the sparge 
tubing.

Figure 5.9 Removing the Rubber Cap

4. Wash the IC reactor and rinse it well with purified water. 

5. Using the procedure described in Section 4.1.2 “Installing the IC Reactor”, 
re-install the IC reactor.

 CAUTION

• Phosphoric acid is a corrosive substance and may leak inside the IC 
reactor. DO NOT spill or touch this substance.

• The IC reactor is glass. To avoid injury, do not break the glass when 
installing the IC reactor. 

• When tightening the plastic nuts used on the connectors, do not use 
any tools. Tightening securely by hand is sufficient.

• Do not contaminate the internal or external surfaces of the IC reactor 
or its connections with organic substances such as grease or oil. This is 
critical for high sensitivity measurement.

Rubber Cap

Sparge Tubing
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5.2.7 Replacing the UV Lamp

Replace the UV lamp once a year

Procedure

1. Using the procedure described in Section 5.2.5 “Washing the TC Reactor”, 
remove the UV lamp.

2. Using the procedure described in Section 4.1.1 “Installing the TC reactor”. 
install a new UV lamp.

 CAUTION

• Turn OFF the TC reactor heater and the UV lamp. Wait for the heater 
to cool to room temperature before performing maintenance on the TC 
reactor. There is a danger of burn injury and electric shock. 

• High voltage is applied to the UV lamp and UV lamp power supply. 
Due to the danger of electric shock, turn OFF the UV lamp before 
performing maintenance on the TC reactor.

• The oxidizing reagent is corrosive and may leak into the TC reactor. 
DO NOT spill or touch this reagent.

• The TC reactor is glass. To avoid injury, do not break the glass when 
connecting the TC reactor.

• When tightening the plastic nuts used on the connectors, do not use 
any tools. Tightening securely by hand is sufficient.

• Do not contaminate the internal or external surfaces of the TC reactor 
or its connections with organic substances such as grease or oil. This is 
critical for high sensitivity measurement.



5.2 Periodic Inspections
5.2.8 Replacing the Syringe Pump 8-Port Valve Rotor

TOC-VWP208

5.2.8 Replacing the Syringe Pump 8-Port Valve Rotor

The fluororesin rotor of the syringe pump 8-port valve gradually becomes worn and 
scratched after prolonged use, due to suspended particles in the samples. This wear 
eventually causes leaks from the 8-port valve.

The following symptoms are associated with leaks from the 8-port valve and indicate 
that it is necessary to replace the rotor. 

• Droplets of liquid around the 8-port valve (around the upper shaft) 

• Decreased analysis reproducibility

• Presence of bubbles in the syringe

If there is a large leak, sample remaining in the tubing after the syringe has been filled 
may leak back into the sample container. The sample tubing flange connection may be 
the source of this problem.

 CAUTION

Switch OFF the instrument before replacing the 8-port valve rotor.

Procedure

1. Turn OFF the power to shut down the instrument.

2. Verify that the O mark on the 8-port valve interrupt plate is directed toward the 
No. 1 port. If it is not, the instrument was not shut down using the appropriate 
procedure. If this is the case, switch the instrument back ON, and follow the 
correct shutdown procedure.

Reference: Refer to Section 4.3.4 “Ending Measurement” for the correct shutdown procedure.
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3. Remove the nut using the provided wrench.

Figure 5.10 Removing the Nut

4. Pull up to remove the rotor drive component. Hang it on the screw on the right 
side of the syringe assembly housing.

5. Loosen the retaining nut using the provided wrench.

Figure 5.11 Removing the Retaining Nut

6. Take notice of the orientation (toward port No. 1) of the flat surface of the 
spring-equipped rod. Remove the spring-equipped rod and retaining nut.

Nut

Retaining Nut
Spring-equipped Rod
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7. Take notice of the orientation of the rotor hole position. Grasp the rotor with 
forceps, and remove it by pulling upwards.

Figure 5.12 Removing the Rotor

8. Insert a new rotor, taking care that the rotor hole matches original orientation.

9. Reinsert the retaining nut and spring-equipped rod, with the flat surface 
directed toward the No. 1 port. Tighten the retaining nut.

10. Replace the rotor drive component, and tighten the nut.

11. Switch the instrument ON.

Reference: Perform the syringe pump zero detection procedure before analysis. Refer to Section 4.1.4 
“Syringe Pump Zero Point Detection” for more information.

Rotor
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5.3  ASI-V Autosampler Maintenance 

Maintenance of the autosampler includes periodic inspection of the rinse bottle, sample 
catcher and rinse pump.

5.3.1 Rinse Bottle Inspection

Perform the following inspections before conducting analysis with the autosampler. If 
the following inspections are not properly conducted, air may be drawn into the 
autosampler injection pump, preventing the delivery of rinse water. 

Check the Rinse Water Level 

Verify that the rinse water in the rinse bottle is above the 2-liter mark. Add 
water if it is below this level. 

Check the Rinse Tubing

Verify that the tip of the rinse tubing reaches nearly to the bottom of the rinse 
bottle. Adjust the tubing depth if necessary.

Figure 5.13 Rinse Bottle Inspection

5.3.2 Sample Catcher Inspection 

Examine the turntable (black plate) and the sample catcher tray below the turntable 
when installing or removing the autosampler vial rack. If they are wet or dirty, wipe 
them clean. 

 CAUTION

Corrosion of the instrument may occur if spilled sample is allowed to 
remain in the sample catcher. Keep the sample catcher clean.

Rinse Bottle

Rinse Tubing
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5.3.3 Replacing the Pump Head of the Rinse Pump

The rinse pump is located inside the autosampler and supplies rinse water to the rinse 
port.

The rinse pump is a peristaltic pump where a rotating roller flattens the rubber tubing 
that carries the rinse water. This rubber tubing gradually deteriorates requiring periodic 
replacement of the entire pump head.

The life of the pump head is generally about 300 hours of pump operation.

Replacement Procedure

Use the following procedure to replace the pump head.

1. Remove the rectangular pump access cover on the back left side of the 
autosampler.

2. Grasp the latch on the pump head by hand and pull the white pump head from 
the black pump body.

3. On the left side of the pump head, disconnect both of the yellow rubber tubes 
from the Teflon tubes.

4. Connect the new pump head tubing to the Teflon tubes. 

5. Replace the pump head and the replace the pump access cover. 

Figure 5.14 Replacing the Pump Head of the Rinse Pump

Pump Head

Pump HeadLatch

Rubber Tubing
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5.4 8-Port Sampler (OCT-1) Maintenance

5.4.1 Replacing the 8-Port Valve Rotor

The OCT-1 uses a fluororesin 8-port valve rotor. The valve rotor may become worn or 
scratched after prolonged use due to the suspended particles in the samples. This wear 
eventually causes leaks from the 8-port valve. 

The following symptoms are associated with leaks from the 8-port valve and indicate 
that it is necessary to replace the rotor. 

• Droplets of liquid around the 8-port valve (around the upper shaft)

• Decreased analysis reproducibility.

• Presence of bubbles in the TOC-V syringe.

If the leak is large, sample remaining in the tubing after the syringe has been filled may 
flow back into the sample container. This is most likely due to a sample tubing or 
flange connection problem.

CAUTION

Switch OFF the power before replacing to the 8-port valve rotor.

Replacement Procedure

1. Shut down the TOC-V unit and switch OFF the power.

Reference: Refer to Section 4.3.4 “Ending Measurement” for details on shutting down the TOC-V unit.

2. Remove the 4 screws at the top of the 8-Port Sampler, and take OFF the cover.

3. Verify that the O mark on the 8-port valve cover is directed toward port No.1. 

Note: If the O mark is not directed toward port No.1, the instrument was not 
shut down properly. If this is the case, turn the TOC-V on again, and 
shut it down properly. 
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4. Remove the nut using the wrench supplied with the TOC-V. 

Figure 5.15  Removing the Nut

5. Remove the 8-port valve by pulling downward. 

6. Loosen the retaining nut using the provided wrench.

Figure 5.16 Removing the Retaining Bracket

7. Note the orientation (toward port No. 1) of the flat surface of the spring-
equipped rod. Remove the spring-equipped rod and retaining nut. 

Nut

Retaining Nut
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8. Note the orientation of the rotor hole position. Grasp the rotor with forceps, 
and remove by pulling upwards. 

Figure 5.17 Removing the Rotor

9. Insert a new rotor, positioning the rotor hole to the original position.

10. Reinsert the spring-equipped rod and retaining nut with the flat surface 
directed toward port No. 1. Tighten the retaining nut.

11. Replace the 8-port valve in its original position, and secure it using the nut.

12. Replace the cover of the 8-Port Sampler and secure it with four screws. 

13. Switch on the TOC-V unit.

Rotor
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5.5 Software-Controlled Maintenance Functions

Maintenance functions that can be performed using the TOC-Control V software are 
described below. These functions are accessed through the Instrument>Maintenance 
menu: 

Figure 5.18 Instrument>Maintenance Menu

To access the menu, select Instrument>Maintenance in the Sample Table Editor.

5.5.1 Zero Point Detection

Use this function to determine the zero point of the syringe. Click the Start button to 
begin the procedure, during which a progress bar is active. The progress bar becomes 
inactive when the syringe zero point is determined. Click the Close button.

Figure 5.19 Zero Point Detection Dialog Box
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5.5.2 Replace Flowline Content

Select this command to remove bubbles from the dilution solution tubing, the oxidizer 
tubing or the acid tubing. This should be executed immediately after instrument 
installation, when reagents are replenished, or whenever bubbles are present in the 
tubing.

To start bubble removal, click the “Start” button.

Figure 5.20 Replace Flowline Content Dialog Box

5.5.3 Washing

Use this function to wash selected flow lines.

Figure 5.21 Washing Dialog Box
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To perform flow line washing, click the Select Flow Lines button to open the Wash 
Flow Lines dialog box. Select the flow lines to be washed, and click the Wash button. 
The ports for the 8-Port Sampler 1 (2) can be selected if the 8-Port Sampler 1 (2) is 
being used. 

Figure 5.22 Wash Flow Lines Dialog Box

While this process is being executed, the buttons in the Washing dialog box are 
disabled, and the progress bar activity is displayed. 

Flow Line Washing [TC] Washes the sample tubing.

8-Port Valve [Washing] Washes the inside of the 8-port valve.

8-Port Valve [Drying] Dries the inside of the 8-port valve.

Wet Chem. Sparging Unit [Washing] Washes the inside of the IC reactor with dilution 
water.

Wet Chem. Sparging Unit [Drain] Expels the contents of the IC reactor.

Wet Chem. Reactor Unit [Washing] Washes the inside of the TC reactor with dilution 
water.

Wet Chem.Reactor Unit [Drain] Expels the contents of the TC reactor.

Cmb. Reac. / Sparg. Unit Washes the inside of the TC and IC reactor using 
dilution water.
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5.5.4 Mechanical Check

Select this function to check the mechanical components of the instrument or to make 
adjustments. The Mechanical Check window consists of several tabs, one for each 
connected instrument.

TOC Tab

Figure 5.23 Mechanical Check Window: TOC Tab

Syringe Pump

Use the buttons to move the syringe pump to the Zero, Home, or Sparge 
positions. Click the Reset button to move the plunger to the highest position.

Solenoid Valves

Use the buttons to open or close the various solenoid valves. Different options 
are available depending on the instrument configuration and oxidation method.

Port Select

Open the line between the syringe and an injection port by clicking the button 
for the desired port.
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ASI / 8-Port Sampler Tab

Figure 5.24 Mechanical Check Window: ASI Tab

Rinse

Use the On and Off buttons to start and stop the ASI flow line rinsing option.

Move Tray

Use the directional arrows to move the ASI tray to the desired position. Click 
the Reset button to return the tray to its home position.

Arm

Use the directional arrows to move the arm vertically. Use the drop-down list 
to move the arm horizontally.

Vial Position

Use the spin controls to enter a vial position, and then click the Move button to 
verify that the arm moves to the specified vial position.
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5.5.5 ASI / 8-Port Sampler Initialization

Use this function when first connecting the instrument to establish communication 
between the TOC-Control V software and the ASI-V autosampler or the OCT-1 8-Port 
Sampler. This option is disabled if an ASI or 8-Port Sampler is not connected to the 
system.

Figure 5.25  Initialize ASI / 8-Port Sampler Window

Click the Start button to begin the procedure and activate the progress bar. The 
progress bar becomes inactive when the ASI or 8-Port Sampler is initialized. Click the 
Close button.

5.5.6 ASI Rack Change

Use this function to change the ASI rack. This option is disabled if an ASI is not 
connected to the system. 
 

Figure 5.26 ASI Rack Change Window

Click the Preparation Start button to begin the procedure. A progress bar is active while 
the rack moves to the position where it can be replaced. When the progress bar begins 
blinking, replace the rack. Click the Finish Replacement button to initialize the ASI 
and complete the rack change process. Click the Close button.
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5.5.7 ASI Needle Change

Use this function to change the ASI needle. This option is disabled if an ASI is not 
connected to the system.

Figure 5.27 ASI Needle Change Window

Click the Preparation Start button to begin the procedure. A progress bar is active while 
the needle moves to the position where it can be replaced. When the progress bar 
begins blinking, replace the needle. Click the Finish Replacement button to initialize 
the ASI and complete the needle change process. Click the Close button.

5.5.8 Change Syringe

Use this function to replace the syringe.

Figure 5.28 Syringe Change Window

Click the Preparation Start button to begin the procedure. A progress bar is active while 
the syringe moves to the position where it can be replaced. When the progress bar 
begins blinking, replace the syringe. Verify that the syringe moves smoothly between 
the upper and lower positions by clicking the directional arrows. Click the Finish 
Replacement button to move the syringe to its initialization position, then click the 
Close button.

Note: Perform the zero point detection procedure whenever the syringe is newly 
installed or the syringe is replaced. Refer to Section 4.1.4 “Syringe Pump Zero 
Point Detection” for details.
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5.5.9 Blank Check

Use this function to automatically determine the background TC level of the 
instrument. Conducting the Blank Check procedure is recommended prior to 
performing high sensitivity measurements. Open a blank Sample Table, connect the 
instrument, and select the Blank Check option from the Instrument menu. Refer to 
Section 4.3.3 “TC Blank Check Analysis” for details. Set the injection volume using 
the spin controls, then click the Start button to begin the procedure.

Figure 5.29 Blank Check Parameters Window

Note: Do not insert a sample into the Sample Table. The Blank Check procedure only 
works in a blank Sample Table.

5.5.10 History

Use this option to view the operational history of various instrument components and 
to set limits for various parameters of the components. When a limit is exceeded for an 
instrument component, a warning message is generated on the PC screen to remind the 
user to perform maintenance on that component. Refer to Section 4.2.4 “Maintenance 
History Settings” for a detailed description of this function.
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5.5.11 Sparge Gas Valve

Select this option to start and stop the flow of sparge gas when the external sparge kit is 
used. 

5.5.12 Adjusting Sparge Gas Flow Rate (Wet Chem.)

Use this function to adjust the flow of sparge gas to the IC reactor. Refer to Section 
4.3.1.4 “Setting Sparge Gas Flow Rate” for details.

Figure 5.30 Adjusting Sparge Flow Rate (Wet Chem)
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5.6 Troubleshooting

This section describes the error messages displayed by the TOC-Control V software 
and the actions recommended to resolve the underlying causes.

5.6.1 Error Messages

The following error messages are displayed on the PC screen when setting or operation 
errors are made, or when problems with instrument operation occur. Take the 
corrective actions indicated in the table below. 

Table 5.1 Error Message List 1

Error Message Description Corrective Action

WARNING: Dilution 
water depleted

Actual amount of dilution water 
used exceeds value set in the 
Maintenance History Settings.

Replenish the dilution water. Then, reset the 
Dilution Water amount in the Maintenance 
History Settings. 

WARNING: Acid depleted Actual amount of phosphoric acid 
used exceeds value set in the 
Maintenance History Settings.

Replenish the phosphoric acid. Then, reset 
the Total Acid Volume in the Maintenance 
History Settings.

WARNING: Oxidizer 
Volume

The volume of oxidizer used 
exceeded the value set in the 
Maintenance Log Settings.

Replenish the oxidation solution. Reset 
“Wet Chemical Oxidizer Usage Volume” in 
the Maintenance Log Settings.

ERROR: Syringe stroke 
number exceeded

Actual number of syringe strokes 
performed exceeds value set in the 
Maintenance History Settings.

Replace the plunger tip. Then, reset the 
Syringe Stroke value in the Maintenance 
History Settings.

WARNING: ASI pump 
tube operating hours 
exceeded.

Actual ASI pump tubing operation 
time exceeds value set in the 
Maintenance History Settings.

Replace the ASI pump tubing. Then, reset 
the ASI Rinse Pump time in the 
Maintenance History Settings.
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Table 5.2• Error Message List 2

Error Message Description Corrective Action
Information entered is incorrect. 
Re-enter user name and 
password.

The user name and password 
entered are not valid.

Enter the correct user name and 
password. These fields are case-
sensitive. If the user account has not been 
set up, contact the system administrator.

Database path not found. The specified file does not 
exist in the specified path.

Verify the file name and path. Determine 
if the specified file has been deleted or 
moved, or if the system used for the file 
has been deleted.

Opening of communication port 
has timed out. Check instrument 
connection and transmission 
settings.

The process of opening the 
communication port has 
timed out.

Verify that the instrument is switched 
On, and that the instrument connection 
and communication port settings are 
correct.

Closing of communication port 
has timed out. Transmission will 
be ended.

The process of closing the 
communication port has 
timed out.

Verify that the instrument is switched 
ON, and that the instrument connection 
and communication port settings are 
correct.

Instrument initialization has 
timed out.

The process of initializing 
the instrument has timed out.

Determine if there is a problem with the 
instrument operation, or if there is a 
problem with communication between 
the PC and the instrument.

The selected communication port 
is already open. Verify that it is 
not used with another connection.

An attempt was made to open 
a communication port that 
has already been opened. 

Determine if the selected port is being 
used with another connection.

Cannot open communication 
port. Check instrument status and 
transmission settings.

The communication port 
failed to open.

Verify that the instrument is switched on, 
and that the instrument connection and 
communication port settings are correct.

Mode error: Check instrument 
condition. If necessary, restart 
instrument.

The operation was not 
accepted due to the 
instrument condition.

Verify the instrument operation. If 
necessary, restart the instrument.

Table 5.3• Error Message List 3

Error Message Description Corrective Action
ERROR: Syringe Zero 
Point Detection.

Syringe zero point detection could not be 
performed. Syringe is not properly 
installed.

Properly mount the syringe. Then 
select Zero Point Detection from the 
Maintenance menu.

ERROR: Vial rack not 
present.

Operation cannot continue because there 
is no ASI vial rack in the turntable. 

Install a vial rack, and then execute the 
operation again.

ERROR: Vial rack has 
been exchanged.

Measurement cannot be performed 
because the ASI vial rack specified in 
the settings differs from the type actually 
detected.

Verify the type of vial rack installed in 
the ASI-V, and then set the vial rack 
type in the software.

ERROR: Vial rack type 
not set.

The measurement parameters cannot be 
validated because the ASI vial rack type 
is not specified in the software.

Set the vial rack type in the software.

ERROR: ASI Cover is 
open.

The ASI-V cover is open. The ASI-V 
operation has stopped as a safety 
measure.

Close the ASI-V cover.
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The following messages indicate that an error has occurred that prevents measurement 
from continuing. Take the appropriate corrective actions as indicated in the following 
table. If the cause of the problem cannot be discovered, or if the same error message 
appears after taking the indicated corrective actions, contact your Shimadzu 
representative.

Table 5.4• Error Message List 4

Error Message Description Corrective Action
ERROR: ROM Write 
Error

An error occurred while writing to 
memory.

Switch Off the power to the instrument. Contact 
your Shimadzu representative.

ERROR: Syringe 
Position Detection

The syringe is not operating 
normally.

Switch Off the power to the instrument. After 
switching On the power and running the 
instrument again, see if the same error is generated.

ERROR: Syringe 
Operation

The syringe is not operating 
normally due to clogging of the 
tubing connected to the 8-port 
valve. 

Switch Off the instrument, and remove any foreign 
particles from the line. After switching on the 
power and running the instrument again, see if the 
same error is generated.

ERROR: Syringe Zero 
Point Detection

The syringe is not operating 
normally.

Switch Off the instrument. After switching On the 
power and running the instrument again, see if the 
same error is generated.

ERROR: 8-Port Valve 
Position Detection

The 8-port valve is not operating 
normally due to clogging inside of 
the sample injector 8-port valve.

Switch Off the instrument, and remove the rotor 
from the 8-port valve. Remove any particles found 
in the 8-port valve and wash valve. 

ERROR: ASI Arm 
Vertical Position 
Detection

The ASI-V arm is not operating 
normally in the vertical direction.

Switch Off the power to the TOC-V main 
instrument. After switching on the power and 
running the instrument again, see if the same error 
is generated. 
Since the problem is unrelated to the TOC-V main 
unit, disconnect the ASI-V from the main unit, and 
perform operations using the TOC-V main unit 
alone until normal operation of the ASI-V is 
restored.

ERROR: ASI Arm 
Vertical Movement

The ASI-V arm is not operating 
normally in the vertical direction.

ERROR: ASI Arm 
Horizontal Position 
Detection

The ASI-V arm is not operating 
normally in the horizontal direction.

ERROR: ASI Arm 
Horizontal Movement

The ASI-V arm is not operating 
normally in the horizontal direction.

ERROR: ASI Turntable 
Position Detection

The ASI-V turntable position could 
not be detected. Either the rack is 
not properly seated in the turntable, 
or some object may be blocking a 
position detection notch on the 
periphery of the rack.

Switch Off the power to the TOC-V main unit. 
Make sure the rack is properly seated, and remove 
any objects that may be blocking the position 
detection notch on the periphery of the rack. After 
eliminating the cause of the problem, place the 
cover on the ASI-V, and switch on the power to the 
instrument again.

8-Port Sampler 1 
position detection

8-Port Sampler 1 operation error 
occurred due to foreign matter 
infiltration into 8-port valve, etc.

Switch Off the instrument. Remove 8-port valve 
rotor from 8-Port Sampler 1, remove debris, etc., 
and wash valve.8-Port Sampler 1 

operation
8-Port Sampler 2 
position detection

8-Port Sampler 2 operation error 
occurred due to foreign matter 
infiltration into 8-port valve, etc.

Switch off instrument. Remove 8-port valve rotor 
from 8-Port Sampler 2, remove debris, etc., and 
wash valve.

8-Port Sampler 1 
position detection

8-Port Sampler 1 operation error 
occurred due to foreign matter 
infiltration into 8-port valve, etc.

Switch off instrument. Remove 8-port valve rotor 
from 8-Port Sampler 1, remove debris, etc., and 
wash valve.
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5.6.2 Troubleshooting

5.6.2.1 TOC-V

1) An error message is displayed:

Refer to the error message.

2) The Ready lamp will not light:

Refer to the “Monitor” screen to see which parameters are not 
satisfied.

3) The baseline stays over the auto zero range. Baseline position never 
reaches the ready state.

Does carrier 

Carrier gas leak.

Repair the leak.

analysis

The dehumidifier temperature 
setting is bad.

Contact your Shimadzu 
representative.

The infrared gas

Contact your Shimadzu 
representative.

Is dehumidifier

detector (NDIR) is bad.

temperature?

YES

YES

gas flow normally 
to the

cell?

within the specified 

NO

NO
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4) The baseline is unstable.

Is carrier gas 
flowing normally?

Repair the leak.

Is the

Carrier gas leak.

 

Are

External conditions are

Eliminate the adverse

conditions (vibration,
temperature, power

normal?
voltage) 

adverse.

condition.
The infrared gas 

Contact your Shimadzu
representative.

detector (NDIR) is bad.

NO

NO

NO

NO

YES

YES

YES

YES

 dehumidifier
operating normally? 

environmental

The dehumidifier is bad.

Contact your Shimadzu
representative.

Are the TC

Accumulation of

Clean the TC or IC reactor.

and IC reactors clean?
(after high concentration

samples, etc.)

obstructing particles.
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5) Poor reproducibility with a standard solution.

Is the

 Prepare new standard

 

 

Poor injection volume

Eliminate bubbles.

Backlash of plunger tip.

 

 
 

(Section 5.5.2.3)

 

YES

Replenish the water.

 

 

 

NO

YES

NO

NO

NO

NO

YES

NO

YES

YES

YES

YES

NO

 

 

Do
 bubbles remain in

 syringe? (especially in
dilution analysis)

repeatability.

 
 normal?

Was plunger tip
 replaced recently?

 Replace plunger tip.

Does
carrier gas

   sometimes leak from the

 Low water level.

standard solution

solution.

Is baseline stable?

Baseline is unstable.

Stabilize baseline.

Are oxidizer and

Oxidation solution

Prepare new oxidation

TC reactor heater,

Contact your Shimadzu

TC reactor heater or

Bad standard solution.

(Sec. 5.5.2.1, item (4))

acid solution normal?

has deteriorated.

solution.

UV lamp operating
normally?

representative.

UV lamp are defective.

drain bottle? 

The infrared gas 

Contact your Shimadzu
representative.

detector (NDIR) is bad.

Are
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6) No peaks appear after sample injection.

Is carrier gas

Is the

 Low water level.

 Replenish water.

Was membrane filter

Clogged membrane

Replace the

 Large resistance downstream

 

 

always flowing from
the drain

 drain bottle?

 replaced?

of dehumidifier.

representative.
.

bottle?

level of the water

YES

YES

NO

NO

YES

YES

NO
 normal in the

Contact your Shimadzu

NO

filter.

membrane filter.

YES

NO

YES

NO

Is sample injected

Poor injection.

Correct injection condition.

Are oxidizer and

Oxidizer solution or acid

Prepare new oxidizer or

TC reactor heater,

TC reactor heater,

Contact your Shimadzu

into TC or IC reactor?
(visual check)

connections)(check syringe

acid solution normal?

has deteriorated.

acid solution.

UV lamp operating
normally?

UV lamp defective.

representative.

The infrared gas 

Contact your Shimadzu
representative.

detector (NDIR) is bad.

Are
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5.6.2.2 ASI-V

1) The ASI-V does not operate.

Is

Improperly connected cable.

Properly connect the cables.

Bad electrical system.

Contact your Shimadzu

and power cable
properly connected?

representative.

cable
connection

YES

NO

NO

YES

Is ASI cover closed?

ASI cover not closed or

Close or mount cover
incorrectly mounted.

properly.
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2) Rinse water is not delivered from the rinse port.

3) Poor measurement reproducibility.

Is there

Insufficient rinse water.

Replenish the rinse water.

Is the

The rinse tubing is not properly

Properly insert the tubing into

The rinse pump is bad.

Contact your Shimadzu

rinse water in rinse
water bottle?

properly inserted into

bottle?
inserted into rinse water bottle.

the rinse water bottle.

representative.

YES

YES

NO

NOsufficient

rinse tubing

the rinse water

Is there

Poor reproducibility due to

Remove the obstruction from

Is there

Air is drawn in at the

Properly reconnect the tubing.

Poor reproducibility due to

Refer to troubleshooting

adhering to the
sample

connection of sample
needle and ASI

sample

foreign matter.

the opening at the tip of the
sample needle.

connection.

a problem with the TOC-V.

NO

NO

YES

YESany material

needle?

a leak at the

tubing?

 # (1). TOC-V, item (5)



5.6 Troubleshooting
5.6.2 Troubleshooting

TOC-VWP234

5.6.2.3 8-Port Sampler OCT-1

1) 8-Port Sampler does not operate.

2) Poor reproducibility.

 

 

YES

NOAre the signal and 
power cables properly 

connected?
Cables are not properly 
connected.
Connect the cables properly.

Electrical system is defective.

Contact your Shimadzu 
representative.

 

 

NO

NO

YES

YES

Is any foreign material 
adhering to the sample 

tubing?

Is the leakage 
present at the 8-port valve 

and sample tubing 
connection?

Reduced reproducibility due to 
foreign material.
Eliminate blockage at the tip of the 
sample tubing.

Connection is leaking.

Connect the tubing properly.

Poor reproducibility is due to the 
TOC-V unit.

Refer to the TOC-V User Manual.
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5.6.2.4 Corrective Actions for Poor Reproducibility

Corrective Action to Eliminate Bubbles Inside the Syringe

Small bubbles that adhere to the inside of the syringe by the plunger tip have little 
effect on analysis values. Larger bubble inside the syringe, however, will affect values 
and result in poor reproducibility. Large bubbles form easily inside of a dirty syringe. 
These bubbles are evident when sample is mixed with dilution water in the syringe and 
when sparging inside the syringe for IC removal pretreatment for NPOC analysis.

To clean the syringe, detach the syringe from the syringe pump. Repeatedly fill the 
syringe with laboratory glassware detergent, discharging the cleaning solution each 
time. Draw a full stroke of cleaning solution into the syringe barrel and allow it to set 
for at least 20 minutes to overnight for heavily soiled syringes. Thoroughly rinse away 
all of the detergent and reattach the syringe to the syringe pump.

Decreased Reproducibility Due to Plunger Tip Backlash

With use, the plunger tip wears in the following ways. 

1) The surface of plunger tip becomes worn, and the seal between 
plunger tip and the inside of the glass syringe barrel deteriorates, 
allowing slight amounts of water to leak out with vertical movements 
of the plunger.

2) The contact site of the plunger tip and plunger becomes loose, causing 
a slight backlash with vertical movement of the plunger.

When the above conditions start to occur, repeatability of sample injection volume 
decreases, resulting in diminished analysis reproducibility. Item (2) above, rapidly 
leads to decreased reproducibility. It is very difficult to determine backlash by 
inspecting movement of the plunger tip, Inspect for backlash as follows.

Before sample injection, observe the wash injection used to replace the previous 
sample in the syringe and flow line with the new sample. After injection, if a droplet 
forms at the tip of the injection tubing and increases in size, there is a strong possibility 
that backlash has increased. The corrective action is to replace the plunger tip.

Note: The effect of backlash increases with smaller sample injection volumes. Poor 
results might be obtained with a sample injection volume of 10µL, while the 
effect might be negligible with a 100µL sample injection volume.
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6Reference Materials

This chapter describes the principles of analysis and lists instrument 
specifications, accessories, and parts. This chapter also includes installation 
procedures, for use in the event that the instrument is relocated.

6.1 Principles of Analysis
The analysis principles for TC, IC, NPOC, and TOC analysis are described in 
this section.

6.2 Analysis-Related Technical Information
Summarizes technical information related to analysis.

6.3 Specifications
Specifications for the TOC-VWP main unit and autosampler are listed here.

6.4 Standard Accessories
The standard accessories are listed in this section.

6.5 Special Accessories
The optional accessories are listed in this section.

6.6 Consumable Parts List
The consumable parts are listed in this section.

6.7 Maintenance Parts List
The maintenance parts are listed in this section.

6.8 Installation
The installation site requirements and installation procedures for future 
relocation of the instrument are described here.

6.9 Material Safety Data Sheets
Material Safety Data Sheets are included for many of the chemicals 
encountered in TOC analysis.
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6.1 Principles of Analysis
There are two types of carbon present in water: organic carbon and inorganic carbon. 
Organic carbon (TOC) bonds with hydrogen or oxygen to form organic compounds. 
Inorganic carbon (IC or TIC) is the structural basis for inorganic compounds such as 
gas carbonates and carbonate ions. Collectively these are referred to as total carbon 
(TC) and have the relationship TOC=TC-IC. 

Following is a description of the TOC measurement principle. 

6.1.1 Principle of TC (Total Carbon) Analysis 

In the TOC-V, carrier gas flows at a controlled rate of 200mL/min through the TC 
reactor, which is comprised of a UV lamp and heater. When sample is injected along 
with the oxidizing reagent (containing sodium persulfate and phosphoric acid) into the 
TC reactor which has been heated to 80°C, the TC in the sample is oxidized and 
decomposed to form carbon dioxide. This carbon dioxide is swept via the carrier gas 
from the reaction tube to a dehumidifier for cooling and dehydration. These products 
then pass through a halogen scrubber to reach the cell of a non-dispersive infrared 
detector (NDIR), where the carbon dioxide is detected. The analog detection signal of 
the NDIR forms a peak, and the area of this peak is measured by a data processor. 

The peak area is proportional to the TC concentration of the sample. Therefore, when a 
TC standard solution has been analyzed to create a calibration curve equation 
expressing the relationship between TC concentration and peak area, the TC 
concentration in the sample can be calculated. 

6.1.2 Principles of IC (Inorganic Carbon) Analysis

The IC comprises the carbon within carbonates, hydrogen carbonates and dissolved 
carbon dioxide. 

Defining IC

The IC (inorganic carbon) in TOC analysis refers to carbon contained in the carbon 
dioxide dissolved in water and that found in carbonates. By acidifying the sample with 
a small amount of phosphoric acid to obtain a pH less than 3, all the carbonates 
produce carbon dioxide (CO2) according to the following reaction.

Me2CO3 + H3PO4  CO2(g) + 2MeCl + H2O

MeHCO3 + H3PO4  CO2(g) + MeCl + H2O

The carbon dioxide and dissolved carbon dioxide in the sample are volatilized by 
bubbling (sparging) gas through the sample.

Analysis with the IC Reactor

Sparge gas flows at a controlled rate of 200mL/min through the IC reactor. When 
sample is injected along with phosphoric acid into the IC reactor, only the IC 
component of the sample is converted to carbon dioxide, which is subsequently 
detected by the NDIR. The IC concentration in the sample is then measured in the same 
way as the TC concentration. 
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6.1.3 Principle of NPOC (Non-Purgeable Organic Carbon) 
Analysis

After acidifying the sample to pH 2 to 3 by adding phosphoric acid, sparge gas is 
bubbled through the sample to eliminate the IC component. The TC remaining in the 
sample after sparging is measured to determine total organic carbon, and the result is 
generally referred to as (acidify and sparge) TOC. However, in the TOC-V, this 
analysis value is referred to NPOC to distinguish it from the TOC value obtained by 
the difference between TC and IC. NPOC stands for non-purgeable organic carbon and 
refers to the non-volatile organic carbon contained in a sample. 

NPOC and TOC (obtained by IC elimination) described in the TOC-related standard 
methods and referred to in water quality-related test methods (JIS, ASTM, EPA, EN) 
are identical. If the sample contains purgeable organic substances, this component can 
be lost during the sparging process. Consequently, when the sample contains purgeable 
organic substances, TOC should not be measured by the NPOC method. If the 
dissolved purgeable organic component in the water sample is large, the amount 
volatilized during sparging is relatively small. Generally, the amount of purgeable 
organic substances in natural environmental water, public water and purified water is 
small, so NPOC is referred to as TOC. 

Table 6.1 Residual Rate of Volatile Organic Substances Using a Nitrogen Gas 
Sparge

Organic 
Substance

Pre-Sparging 
Conc. (ppm)

Post-Sparging 
Conc. (ppm) Residual Rate (%)

Methanol 117. 5 116 98.6

Ethanol 106.5 105 98.5

Isopropyl alcohol 129 127 98.5

n-butyl alcohol 117 115 98.3

Acetone 106 101 95.3

Acetoaldehyde 130 117 90.0

Ethyl acetate 102 88 86.3

Tyrosine 117 116.5 99.5

Benzene 85 2.5 2.9

Cyclohexane 79 2 2.5



6.1 Principles of Analysis
6.1.4 Principles of Measuring TOC

TOC-VWP240

6.1.4 Principles of Measuring TOC

The TOC-V employs 2 methods for TOC analysis.

• TC-IC Method 
• NPOC Method

TC-IC Method

The TOC value determined by the difference in TC and IC analysis values includes 
errors associated with both the TC and IC analyses. This results in a large error for the 
TOC value. NPOC analysis is generally used and is recommended for samples that 
contain more IC than TOC (samples where TC consists almost entirely of IC).

NPOC Method

This is the most widely used method of TOC analysis. There is a tendency for samples 
that become foamy during sparging to partially form bubbles and flow out of the 
syringe, along with the concentrated TOC content of the sample, thus leaving a smaller 
concentration of TOC in the syringe. The TC-IC method is recommend for samples 
that foam during the sparging process.
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6.2 Analysis-Related Technical Information

6.2.1 Peak Area Analysis

When a sample is introduced, the TOC-V automatically detects the beginning and end 
of each peak produced and calculates the peak areas. Detection of the beginning and 
end of each peak is based on the slope of the tangent, which changes moment to 
moment. Peak detection begins when that slope exceeds a predetermined value and 
ends when a negative slope falls below a specified value. 

Note: Baseline correction is performed for peaks produced with fluctuating baseline 
to obtain the correct peak area.

Figure 5.1 Determining Peak Area
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6.2.2 Calibration Curves 

6.2.2.1 Types of Calibration Curves

1-Point and 2-Point Calibration Curves

The output signals of the TOC-V are linearized. There are almost no factors in the 
reaction systems of the TC and IC reactor components that might cause the 
concentration-output characteristic to deviate from linearity. Consequently, calibration 
curves are normally generated as 1-point curves consisting of 1 span point, or 2-point 
curves consisting of 1 span point and the zero point. 

The concentration of TC and IC vary with standard solutions prepared with purified 
water. A calibration curve generated using concentrations greater than 50 - 100mg/L 
will pass very close to the zero point. In this case, it is practical to generate a 1-point 
calibration curve.

Use a 2-point calibration curve when the concentration of TC or IC in the purified 
water used to prepare the standard solutions cannot be disregarded with respect to the 
standard solution concentration. Refer to Section 6.2.2.2 “Shifting of Calibration 
Curves” for information on handling of this type of curve.

Multiple Point Calibration Curves

Calibration curves can be generated using up to 10 points. Calibration curves 
consisting of 3 or more points can be generated as a point-to-point curve or as a 
regression line using the least squares method. A correlation coefficient is displayed 
with the least squares regression method. 
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6.2.2.2 Shifting of Calibration Curves

Shift to Origin

This function is used when the amount of TC or IC in the purified water used for 
standard solution preparation cannot be ignored with respect to the standard solution 
concentration. A correction must be made by shifting the calibration curve in a parallel 
fashion so that it passes through the origin. This accounts for the TC or IC 
concentration in the water used for standard solution preparation.

When water containing 0.5mg/L TC is used to prepare a 10mg/L TC standard solution 
(actually 10 + 0.5mg/L TC), a 2-point calibration curve appears as shown by the solid 
line in Figure 6.2 “Shifting the Calibration Curve”. If this curve is used as is, the 
sample analysis values will always show a value 0.5mg/L less than the true value. By 
shifting the calibration curve so that it passes through the origin, as shown by the 
broken line in “Figure 6.2”, the calibration curve deviation is effectively corrected. 

When there is a system blank, the measured value is greater by the amount of the 
system blank. The system blank refers to the peak obtained by measuring water that 
contains absolutely no carbon (water with zero TC). This instrument allows shifting of 
calibration curves only to the extent of the system blank value. In most cases, analysis 
error due to the TC content in the water used in preparing standard solutions is much 
greater than the system blank value. Correcting the calibration curve based on the TC 
content in the standard solution preparation water will produce satisfactory analyses. By 
this method, the analysis value obtained for a system blank, would be greater than zero 
by the amount of this blank value. 

Shift to Blank Point

This shift procedure is performed in high sensitivity analysis where the system blank 
value could have an effect on the analysis value. 

By selecting the shift-to-blank point option, a TC blank check analysis is performed 
using the same injection volume that is used in the analysis. The calibration curve zero 
point is shifted to the TC blank check value. 

Figure 6.2 Shifting the Calibration Curve
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6.2.3 Sparging During Standard Solution Analysis 

For standard solutions that have a TC concentration so low as to be affected by the 
amount of dissolved carbon dioxide in the standard solution, perform analysis of the 
standard solution after it has been sparged with carrier gas. The dissolved carbon 
dioxide is eliminated by sparging and will no longer affect the concentration of the 
standard solution. 

The amount of dissolved carbon dioxide in the water used for standard solution 
preparation is affected by factors such as water purification method, length and 
condition of storage, and the concentration of carbon dioxide in the atmosphere. Even 
if the dissolved carbon dioxide concentration in the water is low, the process of 
preparing the standard solution it may expose it to the atmosphere. Refer to Table 6.2 
“CO2 Content (ppm) in Distilled Water Equilibrated with Atmosphere Temperature 
(°C)” which presents the dissolution rates of atmospheric carbon dioxide in water. 

Both the concentration of the standard solution and the concentration of TOC 
contained in the water must be taken into consideration when deciding whether to use 
the sparging function. Use of sparging is indicated if the TOC contained in the water is 
low enough to not substantially affect the standard solution concentration, but not low 
enough to be ignored. 

Note: Do not use sparge IC standard solutions as sparging decreases the IC 
concentration. 

The above CO2 content can be converted to IC using the following equation. 

IC (ppm) = CO2 (mg/L) x 0.27

Table 6.2 CO2 Content (ppm) in Distilled Water Equilibrated with Atmosphere 
Temperature (°C)

Atmospheric CO2 
(vol%) 0 5 10 15 20 25 30

0.030 1.00 0.83 0.79 0.59 0.51 0.44 0.38

0.033 1.10 0.91 0.76 0.65 0.56 0.48 0.42

0.044 1.47 1.22 1.02 0.87 0.74 0.64 0.56



6.2 Analysis-Related Technical Information
6.2.4 Automatic Selection of the Optimal Calibration Curve

245TOC-VWP

6.2.4 Automatic Selection of the Optimal Calibration Curve

The TOC-V has the ability to automatically select which calibration curve is used to 
determine the sample value. Up to 3 calibration curves can be specified in the 
“Measurement Parameters” screen. If more than one calibration curve is listed, the 
TOC-V uses the following scenarios to determine the optimum calibration curve for 
analysis.

Procedure

Analysis is performed using the calibration curve designated as Calib. (1st). 

Selection Result

1) If the sample value is less than the concentration of Calib. (1st), and 
greater than the conc of Calib (2nd), the first calibration curve is used:

Conc. of 1st Calibration Curve > Measured Value > Conc. of 2nd 
Calibration Curves  First calibration curve is used.

2) When the concentration of Calib (2nd) is less than Calib. (1st), a 
sample value that is less than both is calculated using the lower 
concentration of Calib. (2nd):

Conc. of 1st Calibration Curve > Conc. of 2nd Calibration Curve > 
Measured Value  2nd Calibration Curve is used.

3) When three calibration curves are specified in the “Measurement 
Parameters” screen, the calibration curve that is closest to the sample 
value without being less is the one used for calculation of the result.

Conc. of 1st Calibration Curve > Conc. of 2nd Calibration Curve > 
Measured Value > Conc. of 3rd Calibration Curve  2nd 
Calibration Curve is used.

Conc. of 1st Calibration Curve > Conc. of 2nd Calibration Curve > 
Conc. of 3rd Calibration Curve > Measured Value  3rd 
Calibration Curve is used.

4) If the sample value is greater than the concentration of Calib. (1st), 
and the concentration of Calib. (2nd or 3rd) is greater than the 
concentration of Calib. (1st):

Conc. of 2nd or 3rd Calibration Curve > Measured Value > Conc. of 
1st Calibration Curve  2nd or 3rd Calibration Curve is used.

5) If the measured value is greater than the concentration of the first 
calibration curve and the concentrations of the other two calibration 
curves (2nd or 3rd) are greater than the concentration of the first 
calibration curve:

Analysis is first performed using the calibration curve with the lower 
concentration of the other two. 

Measured Value > Conc. of 2nd or 3rd Calibration Curve > Conc. of 
1st Calibration Curve  2nd or 3rd Calibration Curve is used.
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Note: By setting the concentration ratio between calibration curves to a factor of 
approximately 10, this function can be effectively utilized to enable analyses 
covering a wide range of concentrations. 
Example: 

Calib. (1st): 10ppm, Calib. (2nd): 100ppm, Calib. (3rd): 1000ppm

Considerations for Auto-select Function 

• The above processing does not change even if multiple point calibration curves 
are included. 

• When the number of analyses is set to more than one, the above determination 
is made using the measured value of the first analysis. 

• Since analysis always begins from the first calibration curve, set the most-used 
calibration curve in this position. 

• The priority of the second and third calibration curves is determined on the 
basis of the calibration curve concentrations and the sample concentration. 
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6.3 Specifications 

6.3.1 TOC-VWP

Analyte TC, IC, TOC (TC-IC), NPOC

Measurement Principle Wet chemical (Heated - UV - Persulfate) oxidation 
with non-dispersive infrared detection (NDIR)

Measuring range 0 - 35000mg/L

Detection limits 0.5µg/L

Measurement time TC and IC: Approx. 4min   NPOC: Approx. 5 min.

Repeatability CV% within 1.5% (CV% within 2.0% if range 
exceeds 100mg/L)

Sample introduction Auto injection using an 8-port valve syringe pump

Sample injection volume 350 - 20400µL (variable)

Sample dilution function Dilution within syringe, dilution factor 2 - 50 times

Pretreatment for IC Automatic acid addition and sparging

Carrier gas High purity nitrogen     Pressure: Between 300-
600kPa (44-87PSI)

Carrier gas flow rate 200mL/min (400mL/min when performing sparging 
for NPOC)

Ambient temperature 5 - 35°C

Power requirements AC100-127V (for a 100V system) or AC220-240V 
(for a 200V system)

Fuse 4A, T

Approximate dimensions (W) 440mm x (D) 560mm x (H) 460mm (excluding 
projections)

Weight Approximately 40kg
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6.3.2 ASI-V

6.3.3 OCT-1 8-Port Sampler

6.3.4 PC Hardware Requirements

Sample containers 24mL vial rack: 24mL (External diameter 23mm x Height 
85mm), 100 vials, 100 septum-equipped caps

40mL vial rack: 40mL (External diameter 27mm x Height 
95mm), 72 vials, 72 septum-equipped caps

125mL vial rack:125mL (External diameter 48mm x Height 
112mm), 24 vials, 24 septum-equipped caps

Vial rack capacity 24mL vial rack: 93 vials

40mL vial rack: 68 vials

125mL vial rack: 24 vials

Sample pretreatment Acid addition and sparging possible for NPOC analysis

Needle rinse possible

Ambient temperature 5 - 35°C

Approximate dimensions (W) 370mm x (D) 540mm x (H) 490mm (excluding 
projections)

Weight Approximately 13kg

No. of sample containers 
accommodated

8 containers

16 containers (using 2 OCT-1 units)

Ambient temperature 5 - 35° C

External dimensions Approx. (W) 245 x (D) 245 x (H) 440mm (excluding 
protruding parts)

Weight Approx. 3.5 kg

PC IBM-PC/AT or compatible, with 9-pin RS-232C connector

CPU 233MHz or better

Memory 32 MB or greater

Hard drive 2 GB or greater

OS Windows95, Windows98, Windows2000, WindowsNT 4.0 
(SP3 or later), WindowsXP (*For compliance with FDA 21 
CFR Part 11, use Windows2000)
The User Authentication function cannot be used with WindowsXP.

Monitor resolution 800 x 600 or better, 1024 x 768 suggested
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6.4 Standard Accessories

Table 6.3 Standard Accessories List 1 (TOC-VWP)

Part Number Part Name Quantity

638-52602 TC reactor 1

638-52592 IC reactor 1

631-81280 TC reactor heat transmitting sheet 1

638-52336-06 Persulfate bottle 500mL 1

638-52336-04 Acid bottle 500mL 1

638-52337 Rinse water bottle 1

630-00999 CO2 absorber 1

631-81214 CO2 absorber platform 1

638-59214 25mL syringe 1

638-59214-01 Plunger tip 1

630-00635-01 Potassium biphthalate, 25g 1

630-00962-01 Sodium carbonate, 25g 1

630-00963-01 Sodium bicarbonate, 25g 1

630-00315-09 Plastic tube 9mm ID x 12mm OD 2m

071-60813 Adapter, KPR-18 1

071-60814-01 Power cord set 1

072-02004-19 Fuse, 218 002 2

631-20265 Plug, 35154 1

631-78002 Wrench, for 8-port valve 1

037-72138-30 Caution label (corrosion caution), for drain bottle 1

072-60359-01 Wiring band 3

638-64727 CD-ROM “TOC-Control V” 1

638-74029 Cable (RS-232C) 1

638-94247 English Instruction Manual 1
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* Flared tubing set W and W2 are for samples and for connecting the main unit. Both have 1.5 mm internal
diameter. They are supplied with wet type 8-port sampler.
** There is a No. 2 mark at the TOC-V main unit. Connect between the port No. 2 of the TOC-V main unit
8-port valve and the COM port of the 8-port valve of the 8-Port Sampler 1.
*** There is a No. 1 mark at the TOC-V main unit. Connect between the port No. 1 of the TOC-V main
unit 8-port valve and the COM port of the 8-port valve of the 8-Port Sampler 2.

Table 6.4 Standard Accessories List 2 (ASI Unit)

Part Number Part Name 40mL 125mL

038-00165-21 Vials, 40mL (with cap, septum) 72

038-00165-32 Vials, 125 24

638-20074-02 Cap, 125mL 24

038-00165-49 Septum, 125mL 100

638-52337 Rinse water bottle 1 1

072-60310-03 Wiring band, TM-53M 2 2

631-51869-20 Name plate, SAMPLE 1 1

631-51869-21 Name plate, GAS 1 1

072-60301 Wiring band, Nylon TY-23M 1 1

638-74027 Cable ASSY, ASI, signal 1 1

638-41448-01 Needle, Standard Type 24, 40 1

638-41449-02 Needle, Standard Type 125 1

Table 6.5 Standard Accessories List 3 (OCT-1 8-Port Sampler) 

Part Number Part Name 8-Port 
Sampler 1

8-Port 
Sampler 2 Details

631-20265 8-port valve rotor 1 1 Rotor (for replacement 
maintenance)

638-41481-02 Flared tubing set W 1* 8 sample tubes,1 tube for 
connection to main unit.**

638-41481-04 Flared tubing set W2
1*

8 sample tubes,1 tube for 
connection to main 
unit.***

638-74004-01 Power cable 1 Main unit connection 
cable.

638-74028-01 Signal cable 1 Main unit connection 
cable.

638-74028-02 Power/signal cable
1

Connection cable for 8-
Port Sampler 1, 8-Port 
Sampler 2
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6.5 Special Accessories 

Table 6.6 Special Accessories List 1

Part Number Part Name Comment

638-93141-10 Autosampler ASI-V (40mL) 40mL vials

638-93141-06 Autosampler ASI-V (125mL) 125mL vials

638-53044-02 40mL vial rack set for autosampler Set consists of 40mL vial 
rack + 40mL vial caps + 
septa

638-53044-03 125mL vial rack set for autosampler Set consists of 125mL 
vial rack + 125mL vial 
caps + septa

638-93150-04 OCT-1 8-Port Sampler For TOC-VWP

638-93150-12 OCT-1 8-Port Sampler (2nd unit) For TOC-VWP

638-77152 External sparge kit

630-00749-04 High purity nitrogen gas cylinder Recommended that this 
be obtained locally.

630-08585-05 Cylinder pressure regulator User can provide this 
item.

638-41204 Air supply tubing set (with 20 meters of 
tubing) 

User can provide this 
item.

630-02525-01 High speed homogenizer

618-52344 Drain Bottle Kit for autosampler

Table 6.7 Special Accessories List 2 (Reagents)

Part Number Description
Quantity

Sodium Hydrogen
Persulfate (500g)

Phosphoric Acid 
(500mL)

638-60149-02 TOC-VWP Reagent Kit (single use 
supply) 1 1

638-60149-03 TOC-VWP Reagent Kit (1-year 
supply) 7 3
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6.6 Consumable Parts List 

Table 6.8 Consumable Parts List 1 (TOC-VWP)

Part Number Part Name Comment

630-00999 CO2 absorber

630-00992 Halogen scrubber

630-00635-01 Potassium biphthalate, 25g

630-00962-01 Sodium carbonate, 25g

630-00963-01 Sodium bicarbonate, 25g

631-20265 8-port valve rotor

638-69134 UV lamp

638-59214-01 Plunger tip

638-92207-01 Consumable Parts Kit (TOC-VWP) Refer to “Table 
6.11” for contents.

638-60149-02 TOC VWP Reagents Kit (single use supply) Refer to “Table 
6.12” for contents.

638-60149-03 TOC-VWP Reagents Kit (1 year supply) Refer to “Table 
6.12” for contents.

Table 6.9 Consumable Parts List 2 (ASI-V)

Part Number Part Name Comment

038-00165-21 Vial set * 40mL, 72pcs.

038-00165-32 Vials 125mL, 24pcs.

038-00165-50 Septum 40mL, 100pcs.

038-00165-49 Septum 125mL, 100pcs.

038-00165-40 Cap 40mL, 200pcs.

638-20074-02 Cap 125mL, 24pcs.

042-00405-11 Rinse pump head
* Each vial set contains septa and caps in the same quantity as the vials. 

Table 6.10 Consumable Parts List 3 (8-Port Sampler OCT-1)

Part Number Part Name Comment

631-20265 8-Port valve rotor
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Table 6.11 Consumable Parts List 4 (TOC-VWP)

Part Number Part Name Comment

630-00999 CO2 absorber 1

630-00992 Halogen scrubber 2

630-00635-01 Potassium biphthalate, 25 g 1

630-00962-01 Sodium carbonate, 25 g 1

630-00963-01 Sodium bicarbonate, 25 g 1

638-69134 UV lamp 1

631-20265 8-port valve rotor 1

638-59214-01 Plunger tip 2

Table 6.12 Consumable Parts List 5 (Reagents)

Part Number Description
Quantity

Sodium Hydrogen
Persulfate (500g)

Phosphoric Acid 
(500mL)

638-60149-02 TOC-VWP Reagent Kit (single use 
supply) 1 1

638-60149-03 TOC-VWP Reagent Kit (1-year 
supply) 7 3



6.7 Maintenance Parts List

TOC-VWP254

6.7 Maintenance Parts List

Table 6.13 Maintenance Parts List 1 (TOC-VWP)

Part Number Part Name Comment

631-81280 TC reactor heat transmitting sheet

631-52262 TC reactor tube TC reactor glass tube 
part only (excludes UV 
lamp)

638-42030 IC reactor tube IC reactor glass tube part 
only

638-56135 8-port valve

638-59214 Syringe

631-41660 Flared tubing

631-41660-05 Flared tubing, for dilution water

046-00044-11 Membrane filter

638-65383 Tandem cell (in case)

Table 6.14 Maintenance Parts List 2 (ASI-V)

Part Number Part Name Comment

638-41450-01 Needle, Wet Type 40mL For 40mL, 1pc.

638-41450-02 Needle, Wet Type 125mL For 125mL, 1pc.

638-41448-01 Needle, sparging For 40 mL sparging, 
1pc.

638-41449-01 Needle, simultaneous sparging For 40 mL simultaneous 
sparging, 1 pc.

638-42029-04 Tubing set (sampling) For 40/125mL, 1 
sampling tube, w/tube 
retainer, tube seal

638-42029-05 Tubing set (sparge) 1 sparge tube, w/ tube 
retainer, tube seal

638-42029-03 Tubing set (simultaneous sparge, sampling and 
sparge)

1 each simultaneous 
sparge and sampling 
tube, w/ tube retainer, 
tube seal

Table 6.15 Maintenance Parts List 3 (OCT-1 8-Port Sampler)

Part Number Part Name Comment

631-20265 8-port valve rotor Spare rotor

638-41660 Flared tubing C Sampling tube; for wet type TOC-V

638-41443-05 Common tubing C Main unit - OCT-1 connection tube; for 
wet type TOC-V, 1 unit

638-41443-06 Common tubing C2 Main unit - OCT-1 connection tube;   
for wet type TOC-V, add-on
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6.8 Installation 

6.8.1 Before Installation 

Parts Inspection 

Confirm that all of the components listed in Section 6.4 “Standard Accessories” are 
included in the shipping package. 

6.8.2 Installation Site

When selecting an installation site consider the size of the instrument, how it will be 
used, and the installation conditions indicated below. Instrument damage or analysis 
errors may result from improper installation. 

6.8.2.1 Installation Site Selection 

This instrument is designed to be placed on a workbench or similar countertop. 

See Figure 6.3 “External Dimensions with ASI-V Autosampler” for a description of 
the external dimensions of the instrument. A space of at least 200mm is required on 
either side of and behind the instrument to enable unhindered operation and 
maintenance.

Figure 6.3 External Dimensions with ASI-V Autosampler
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Figure 6.4 External Dimensions with OCT-1 8-Port Sampler

 CAUTION
When lifting the instrument, lift from the bottom and at both sides of 
the instrument. Do not lift it by the front access door, as this may cause 
instrument damage. 

6.8.2.2 Installation Site Conditions 

Select an installation site that complies with the following conditions. 

• A clean environment, free of corrosive gases, organic gases, and dust. 

Note: Airborne contaminants will cause analysis errors in high sensitivity analyses. 

• A strong, level bench, free of vibration and shock. 
• A location with a stable ambient temperature. 
• A location with access to a completely grounded, stable power supply. 

 CAUTION

Avoid locations where flames are prohibited. Some internal parts 
reach high temperatures and could cause a fire hazard.

Due to the possibility of analysis error, avoid the following kinds of locations. 

• Locations close to heat sources or windows in direct sunlight, or in direct 
contact with drafts from air conditioning vents. 

• Near equipment that generates intense magnetic fields, electrical fields, or high 
frequency waves. 
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6.8.3 Installation Procedure

6.8.3.1 Connecting Power Supply and Ground 

Power Supply 

Connect the instrument to a stable, AC100-127V (for a 100V system) or AC220-240V 
(for a 200V system) power supply with sufficient capacity to accommodate 6A or 
greater current. 

 CAUTION

The instrument may not operate properly if the power supply voltage 
exceeds the range of AC100-127V (for a 100V system) or AC220-
240V (for a 200V system). Unstable voltage may cause problems 
during high sensitivity analysis. 

Note: Since this instrument is compatible with both 50Hz and 60Hz power supplies, 
it can be used with either frequency. 

Grounding

The included power cord is a three-conductor cable including a ground wire and a 
2 prong plug (with ground) at the end. If the power outlet does not have ground 
receptacle, use the included 2 prong (no ground) adapter. Connect the external ground 
terminal to the ground.

See Figure 6.5 “Power Plug” for a description of the arrangement of the voltage 
terminals (AC) and ground terminal (ACC) on the power plug of this instrument. 
Connect them so that they match the power outlet being used.

Figure 6.5  Power Plug

Voltage Terminal (AC) Ground Terminal (ACC)

Ground Terminal (G)
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 CAUTION

• In addition to the consideration of safety, complete grounding is 
necessary to prevent as much as possible the occurrence of signal 
noise. A Type-3 ground (ground resistance: 100W or less, see 
Electrical Facilities Engineering Standards for details) is 
recommended. 

• Perform grounding separately and avoid contact with water supply 
pipes, gas pipes, and lightning rods. 

6.8.3.2 Changing the Power Supply Voltage 

The instrument was set up when it was shipped to match the power supply voltage in 
the locale where it will be used. If it becomes necessary to change the power supply 
voltage, please contact your Shimadzu representative. Depending on the voltage 
change, an authorized Shimadzu service engineer may be required to rewire 
connections to the terminal block to change the power supply voltage and/or perform 
changes to the main board. 

6.8.3.3 Connecting Gas 

Use the following types of carrier gas for this instrument.

• Cylinders filled with high purity nitrogen gas

• Instrumentation nitrogen gas

Use of Cylinders Filled with High Purity Nitrogen Gas

The gas must be guaranteed to contain less than 1 ppm of impurities consisting of 
carbon dioxide, carbon monoxide and hydrocarbons. Install an appropriate pressure 
regulator on the cylinder, and supply gas to the instrument gas connection inlet at a 
pressure 300kPa (43PSI). 

Note: If the carrier gas contains excessive impurities, analysis accuracy is diminished 
and good results are not obtained. 

Use of Instrumentation Nitrogen Gas

The gas must contain less than 1 ppm of impurities consisting of carbon dioxide, 
carbon monoxide and hydrocarbons.

Note: Install an air filter in the supply line to eliminate dust, oil mist and water 
droplets.

Gas Supply Pressure

Supply gas to the instrument gas connection inlet at a continuously stable pressure of 
300kPa (43PSI).

When instrumentation gas is used, verify that the supplied gas pressure does not exceed 
600kPa (87PSI). 
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 Precautions for Handling Gas Cylinders 
The handling and safety management of high-pressure gases is strictly 
regulated by high-pressure gas control laws, general high-pressure gas 
safety codes, and fire laws. 

The gas used in this instrument is not dangerous, but mistakes in the 
handling of high-pressure gas cylinders can be extremely hazardous. 
Carefully read and obey the following precautions. 

• Place gas cylinders in a well-ventilated location out of direct sunlight. 

• Ensure that gas cylinders never reach temperatures higher than 40°C. 

• Make sure there are no open flames anywhere within 2 meters of a gas 
cylinder. 

• Secure cylinders with bands or other fasteners to prevent tipping and 
falling. 

• Completely turn OFF all valves on the cylinder, immediately after use. 

• Inspect the operation of the pressure gauge at least once every three 
(3) months. 

Gas Supply Pressure 

Ensure that the gas supplied to the gas inlet of the instrument maintains a constant, 
stable pressure of 300 - 600kPa (44 - 87PSI).

Note: Avoid a carrier gas supply pressure of greater than 600kPa (87PSI). 
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Gas Tubing Connections

The special accessory Air Supply Tubing Set includes nylon tubing and 2 half union 
connectors. 

Procedure

Figure 6.6  Gas Tubing Connection 

1. Connect the half unions to the carrier gas inlet on the instrument and the 
connection outlet (¼" NPT) of the gas supply source. 

2. Connect the nylon tubing (4mm OD, 2.5mm ID) between the gas supply 
source and the instrument. 

Note: To connect the nylon tubing, firmly insert it into the half union. To 
disconnect the tubing, pull the tubing off while pushing down firmly 
on the green-colored ring of the half union with a screwdriver.

3. Verify that there are no gas leaks. 

 CAUTION

• Do not allow any acute bends in the tubing. 

• Clean the tubing and connectors to remove any oils or other 
contaminants on their inner surfaces. 

• Copper tubing or stainless steel tubing may also be used. 

Half Union

Connection Inlet

Nylon Tubing
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6.8.3.4 Connecting the Drain Tubing 

Drain tubing is connected to provide for external discharge of measured samples and 
other liquid waste. If a nearby drainage pit is not available, use a 10 to 20 liter 
polypropylene container as the drain receptacle.

Figure 6.7 Connect the Drain Tubing

The drain tube from the dehumidifier drain port is located inside the right panel. 
Connect it to the external drain tubing using two of the provided cable ties to connect 
the drain tubing so that there are no leaks. 

 CAUTION

Insufficient drainage could cause an overflow of drainage liquid into 
the instrument.

Keep resistance to drainage flow to a minimum as follows.

• Ensure that the height of the drain tubing is never higher than the drain 
port on the instrument.

• Keep the tip of the drain tubing above the surface of the liquid in the 
drain container. 

• Corrosive substances, such as acids, may be contained in the drainage. 
Be careful to avoid touching or spilling these liquids. 

Cable Tie

Drain Tubing

To Drain
Receptacle
(external) 



6.8 Installation
6.8.4 Installing the Autosampler

TOC-VWP262

6.8.3.5 PC Cable Connections

This section describes the procedure for connecting the TOC-V to the PC using the 
supplied RS-232C cable. 

Procedure

1. Insert the supplied RS-232C cable into the RS-232C connector (1) on the back 
of the TOC-V, and tighten the retaining screws on both sides. See Figure 2.4 
“Rear View” for more details.

2. Insert the plug at the other end of the RS-232C cable into the RS-232C 
connector of the PC, and tighten the retaining screws on both sides.

6.8.4 Installing the Autosampler 

6.8.4.1 Installing the Autosampler

This section describes the installation of the ASI-V autosampler.

Positioning the Autosampler

As shown in Figure 6.8 “Installing the Autosampler”, the autosampler is placed to the 
left of the TOC-V.

Figure 6.8 Installing the Autosampler

Note: Keep the distance between the autosampler and main unit to a minimum to 
allow a free range of motion of the autosampler arm. If the autosampler tubing 
is stretched, it may impede the movement of the autosampler arm, resulting in 
operation errors and damage.

ASI-V TOC-V
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Removing the Shipping Screw

The arm of the ASI is secured with a shipping screw to avoid damage during shipment. 
Before connecting power to the instrument, remove the ASI cover to access the 
shipping screw located on the retaining bracket. Remove the shipping screw and 
replace the cover. Label and retain the shipping screw.

 CAUTION

To avoid instrument damage, the customer should verify that the ASI 
arm is firmly attached to the retaining bracket with the shipping screw 
before shipping the instrument or moving it to another location. 

Connecting Cables

The TOC-V and ASI-V are connected using cables, as described below.

 CAUTION

Verify that the TOC-V is switched OFF before performing the 
following cabling procedure.

Procedure

1. Connect the ASI-V power cord to the rear of the TOC-V.

2. Connect the provided signal cable to the ASI-V signal connectors at the rear of 
the TOC-V and the ASI-V.

Figure 6.9 Connecting the Cables (TOC-V to ASI-V)

ASI Signal Cable ASI Power Cable
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Connecting the Sample Tubing and Sparge Tubing (External Sparge Kit)

The procedure for connecting the ASI-V sample tubing and sparge tubing for the 
External Sparge Kit is as follows.

Procedure

1. Open the TOC-Control V Sample Table Editor and connect the instrument.

2. From the Instrument menu, select Maintenance>ASI Needle Change.

3. Click the Preparation Start button.
The autosampler arm moves to the front of the needle replacement window, 
allowing easy access. 

4. Remove the screw on the lower left side of the needle replacement window, 
and detach the window cover by pulling downward. 

Figure 6.10  Tubing Installation

5. Install the bushing at the end of the sample tubing to the Number 2 port of the 
TOC-V sample injector 8-port valve.

Needle Replacement Window

Sample Catcher

Sample Tubing
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6. Draw the sparge tubing out through the joint and connect the sparge tubing.

Figure 6.11 Installing the External Sparge Kit

Note: Do not use the flow controller knob to turn off the sparge gas flow.

Sparge Tubing (Needle Accessory)

External Sparge Unit

Sparge Tubing

Sampling NeedleAdvance Sparge
Needle

Sparge Tubing
(External Sparge Kit)

ASI-V Cover

Tubing Installation Label
(External Sparge Kit)

Installation figure using the advance
sparge needle and the sampling needle. 
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Installing the Needle

This section describes installation of the ASI-V needle. There are two types of needles, 
the sample needle (same as the sparge needle) and the sample + sparge needle.

When installing the needle, remove the needle replacement window cover. 

Installation Procedure for the Sample Needle and Sparge Needle 

1. Open the TOC-Control V Sample Table Editor and connect the instrument.

2. From the Instrument menu, select Maintenance>ASI Needle Change.

3. Click the Preparation Start button.
The autosampler arm moves to the front of the needle replacement window, 
allowing easy access. 

4. Remove the screw, and then detach the needle holder from the arm.

5. Insert the needle into the opening in the needle holder.

6. Secure the needle by turning the retaining bracket and tightening the screw at 
the top of the needle holder.

Note: There are two openings; the left opening is for the sample tubing and 
the right is for the sparge tubing.

Figure 6.12 Installing the Needle - 1

7. Securely fit the sample tubing or sparge tubing onto the upper end of the 
needle.

Note: Verify that the bushing is in position to secure the sample tubing onto 
the sample needle.

Sample Needle Needle Holder

Retaining Bracket
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8. Insert the lower tip of the needle into the needle guide opening, thrusting the 
needle holder into the pin of the arm, then tighten the screw. 

9. Re-install the needle replacement, window cover, and tighten the screw.

Figure 6.13 Installing the Needle - 2

Installing the Turntable, Vial Rack and Cover

Installing the Turntable

1. Place the turntable on the ASI-V.

Note: There is no distinction between front and rear of the turntable, so 
orientation is irrelevant.

2. Place the turntable so that the 3 guides on the ASI-V pass through the 3 holes 
at the center of the turntable.

Figure 6.14 Installing the Turntable

Sample Tubing

Needle Guide

Turntable

Three Holes at
the Center of the
Turntable
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Installing the Vial Rack

1. Place the vial rack on top of the turntable.

2. Rotate the vial rack until the guides of the turntable fit into the vial rack. This 
secures the vial rack in place.

Installing the Cover

1. Place the cover on the ASI-V.

Note: There is a magnet at the left rear of the cover. Verify that the cover and 
ASI-V are in contact at the magnet. 

Install the Rinse Bottle and Drain Tank

Installation of the rinse bottle and drain tank is explained below. 

Rinse and drain tubing are attached to the autosampler, and are respectively labeled 
“RINSE” and “DRAIN.” Use the rinse water tubing as it is, and cut the drain tubing to 
an appropriate length. 

 CAUTION

Verify that the drain tubing remains lower than the drain port of the 
ASI-V, and that the end of the drain tubing remains above the surface 
of the liquid in the drain tank.

Corrosive substances, such as acids or etc., may be contained in the 
drainage. Avoid touching or spilling these liquids. 
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Preparation 

• The rinse bottle is provided as a standard accessory. 

• The drain bottle (P/N 638-52344) is provided as a special accessory. A suitable 
substitute may be used as the drain container. 

Procedure

1. Place the rinse bottle on the bench with the TOC-V and the autosampler. 

2. Place the drain container on the floor. 

3. To minimize resistance, keep the tip of the drain tubing above the surface of 
the drain liquid and as close to the instrument as possible. 

 CAUTION 

Do not allow any slack or bends in the tubing that could cause a 
buildup of water pressure.

Before Starting Analysis 

Check the following before starting analysis. 

• The rinse water bottle is filled to above the 2L mark on the bottle.

• The tip of the rinse tube reaches nearly to the bottom of the rinse water bottle. 

 CAUTION

Rinse water is not delivered and air may be taken into the TOC-V 
injection pump if the above checks are not made.
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6.8.5 OCT-1 8-Port Sampler Installation

The OCT-1 8-port sampler is installed as described below.

6.8.5.1 Installation Procedure

This section describes the procedure for installing the OCT-1 8-Port Sampler.

The unit is set up to the left of the TOC-V main body as shown in Figure 6.15 
“Installation of the 8-Port Sampler”.

TIP: When 2 OCT-1 8-Port Samplers are to be used, place both units to the left of the TOC-
V main unit as shown in the overhead view of Figure 6.4 “External Dimensions with 
OCT-1 8-Port Sampler”.

Figure 6.15 Installation of the 8-Port Sampler

Cable Connections

The cable is connected between the main unit of the TOC-V and the 8-Port Sampler.

CAUTION

Confirm that the power to the TOC-V main unit is switched OFF 
before performing this procedure. 

8-Port Sampler TOC-V Main Unit



6.8 Installation
6.8.5 OCT-1 8-Port Sampler Installation

271TOC-VWP

Connection Procedure

1. Remove the 4 screws at the top of the 8-Port Sampler, and take off the cover.

2. Connect the power and signal cable to the circuit board of the 8-Port Sampler. 

3. Connect the ground wire of the power cable to the grounding terminal on the 
circuit board of the OCT-1.

4. Pass the cable through the rear panel as shown in figure 1.8, and replace the 
cover of the 8-Port Sampler.

Figure 6.16 Cable Connections (TOC-V and 8-Port Sampler)

5. Connect the power cable to the power receptacle on the back of the TOC-V.

6. Connect the signal cable to the 8-Port Sampler connection on the back of the 
TOC-V.

8-Port Sampler Signal Cable 8-Port Sampler Power Cable

Rear Panel
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Installing Two 8-Port Sampler Units

When installing two 8-Port Sampler units, a signal cable (standard accessory) is 
connected between 8-Port Sampler 1 and 8-Port Sampler 2. 

Installation Procedure

1. Remove the covers from both 8-Port Sampler units.

2. Connect the signal cable exiting 8-Port Sampler 2 to the connector of 8-Port 
Sampler 1.

Figure 6.17 Connecting Two 8-Port Samplers

3. Remove the port number label from the 8-Port Sampler 2 unit and replace it 
with the port number label provided with the unit.

Note: The port that was originally labeled as port No. 1 should be labeled as 
port No. 9.

4. Replace the covers on the 8-Port Samplers.

Signal Cable

8-Port Sampler 1

8-Port Sampler 2
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Connecting the Sample Tubing

Use the following procedure to connect the sample tubing of the 8-Port Sampler.

Tubing Connection Procedure

1. The sample tubing differs according to the TOC-V model that is used with the 
8-Port Sampler

Note: Refer to Table 6.15 “Maintenance Parts List 3 (OCT-1 8-Port 
Sampler)” for the appropriate part numbers.

2. Connect the fitting at one end of the tubing to the common (COM) port of the 
8-Port Sampler.

3. Pass the sample tubing through the hole in the left side panel of the TOC-V 
main unit. Connect the fitting at the other end of the sample tubing to port No. 
2 of the 8-port valve of the TOC-V sample injector. Connect to port No. 1 
when installing 8-Port Sampler 2. 

4. Connect the sample tubing to ports 1 - 8 (ports 9 - 16 for 8-Port Sampler 2) of 
the 8-Port Sampler. 

Figure 6.18 Tubing Connections

Note: Connection to the TOC-V Main Unit
• 8-Port Sampler 1

Connect the COM tubing to the common (COM) port of 8-Port 
Sampler 1 and port No. 2 on the TOC-V unit. 

• 8-Port Sampler 2
Connect the COM tubing to the common (COM) port of 8-Port 
Sampler 2 and port No. 1 on the TOC-V unit

Sample Tubing 
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6.9 Material Safety Data Sheets

6.9.1 Sodium Persulfate                             

MATERIAL SAFETY DATA SHEET 
SECTION I PRODUCT IDENTIFICATION
CAT. NO.: CAS NO.: 7775-27-1
NAME: SODIUM PERSULFATE OTHER NAME: Sodium Peroxydisulfate, Peroxydisulfuric Acid Disodium Salt
PRODUCT USE: Specifically for use in Shimadzu TOC instruments. Consult the appropriate instrument manual for proper use.
SECTION II PHYSICAL DATA
APPEARANCE AND ODOR: White crystalline powder
PHYSICAL PROPERTIES: Specific gravity: 2.400
SECTION III HAZARDS IDENTIFICATION
Oxidizing, irritant, contact with combustible material may cause fire. Irritating to eyes, respiratory system and skin. Possible sensitizer. Keep 
away from combustible material. In case of contact with eyes, rinse immediately with plenty of water and seek medical advice. Wear suitable 
protective clothing.
SECTION IV STABILITY AND REACTIVITY 
INCOMPATIBILITIES: Strong reducing agents, finely powdered metals, strong bases. Protect from moisture, alcohols.
HAZARDOUS COMBUSTION OR DECOMPOSITION PRODUCTS: Toxic fumes of sulfur oxides.
SECTION V  FIRE FIGHTING MEASURES
EXTINGUISHING MEDIA: Water spray.
SPECIAL FIREFIGHTING PROCEDURES: Wear self-contained breathing apparatus and protective clothing to prevent contact with skin 
and eyes. Strong oxidizer.
UNUSUAL FIRE AND EXPLOSIONS HAZARDS: Contact with other material may cause fire. Emits toxic fumes under fire conditions. 
Container explosion may occur under fire conditions.
SECTION VI  TOXICITY DATA
To the best of our knowledge, the chemical, physical, and toxicological properties have not been thoroughly investigated.
RTECS #: SE0525000 Peroxydisulfuric Acid, Disodium Salt
TOXICITY DATA: IPR-MUS LD50:226 mg/kg
SECTION VII HEALTH HAZARD DATA
Acute effects: May be harmful by inhalation, ingestion, or skin absorption. Causes eye and skin irritation. Material is irritating to mucous 
membranes and upper respiratory tract. Prolonged or repeated exposure may cause allergic reactions in certain sensitive individuals.
SECTION VIII  FIRST-AID MEASURES
In case of contact, immediately flush eyes or skin with copious amounts of water for at least 15 minutes while removing contaminated clothing 
and shoes. Assure adequate flushing of the eyes by separating the eyelids with fingers. If inhaled, remove to fresh air. If not breathing give arti-
ficial respiration. If breathing is difficult, give oxygen. If swallowed, wash out mouth with water provided person is conscious. Call a 
physician. Wash contaminated clothing before reuse. Discard contaminated shoes.
SECTION IX ACCIDENTAL RELEASE MEASURES
Evacuate area. Shut off all sources of ignition. Wear self-contained breathing apparatus, rubber boots and heavy rubber gloves. Cover with 
dry-lime, sand, or soda ash. place in covered containers using non-sparking tools and transport outdoors. Ventilate area and wash spill site after 
material pickup is complete.
SECTION X  SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be 
held liable for any damage resulting from handling or contact with the above product. Users should make their own determinations regarding 
the suitability of this information for their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date
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6.9.2 Phosphoric Acid

MATERIAL SAFETY DATA SHEET 
SECTION I  PRODUCT IDENTIFICATION
CAT NO.: 630-00710-00 CAS NO.: 07664-38-2
NAME: Phosphoric Acid 25% Ultrapure OTHER NAME: Phosphoric Acid, IC Reaction Liquid
SECTION II  PRDUCT USE
This product is specifically for use in the IC channel of the TOC 500, TOC 5000, and TOC 4000 series of TOC analyzers. Refer to the appro-
priate instruction manual for directions on proper use. Keep tightly sealed in a cool, dry, well ventilated place. Store separate form flammable 
and combustible materials. Wear appropriate protective clothing and eye protection.
SECTION III  PHYSICAL DATA

SECTION IV  HAZARDS IDENTIFICATION
Corrosive, causes burns. Harmful if swallowed. Target organ(s): liver, blood. In case of contact with eyes, rinse immediately with plenty of 
water and seek medical advice. Take off immediately all contaminated clothing. Wear suitable protective clothing, gloves and eye/face 
protection.
SECTION V TOXICITY DATA

SECTION VI HEALTH HAZARD DATA
Acute Effects: Harmful if swallowed. May be harmful if inhaled. May be harmful if absorbed through the skin. Material is extremely 
destructive to tissue of the mucous membranes and upper respiratory tract, eyes and skin. Inhalation may result in spasm, inflammation and 
edema of the larynx and bronchi, chemical pneumonitis and pulmonary edema. Symptoms of exposure may include burning sensation, 
coughing, wheezing, laryngitis, shortness of breath, headache, nausea and vomiting. May cause cyanosis.
Chronic Effects: Target organ(s): liver, blood, bone marrow. To the best of our knowledge, the chemical, physical, and toxicological 
properties have not been thoroughly investigated. 
SECTION VII FIRST-AID MEASURES
In case of contact, immediately flush eyes or skin with copious amounts of water for at least 15 minutes while removing contaminated clothing 
and shoes. Assure adequate flushing of the eyes by separating the eyelids with fingers. If inhaled, remove to fresh air. If not breathing give arti-
ficial respiration. If breathing is difficult, give oxygen. If swallowed, wash out mouth with water provided person is conscious. Call a 
physician. Wash contaminated clothing before reuse. Discard contaminated shoes.
SECTION VIII FIRE FIGHTING MEASURES
EXTINGUISHING MEDIA: Carbon dioxide, dry chemical powder or appropriate foam. 
SPECIAL FIREFIGHTING PROCEDURES: Wear self-contained breathing apparatus and protective clothing to prevent contact with 
skin and eyes. 
UNUSUAL FIRE AND EXPLOSIONS HAZARDS: Emits toxic fumes under fire conditions.
SECTION IX ACCIDENTAL RELEASE MEASURES
Evacuate area. Wear self-contained breathing apparatus, rubber boots and heavy rubber gloves. Cover with dry lime or soda ash, pick up, keep 
in a closed container and hold for waste disposal. Ventilate area and wash spill site after material pickup is complete.
SECTION X STABILITY AND REACTIVITY 
INCOMPATIBILITIES: Strong bases, finely powdered metals
HAZARDOUS COMBUSTION OR DECOMPOSITION PRODUCTS: Thermal decomposition may produce toxic fumes of phosphorus 
oxides and/or phosphine.
SECTION XI SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be 
held liable for any damage resulting from handling or contact with the above product. Users should make their own determinations regarding 
the suitability of this information for their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date

Melt Point Boil Point Density Vapor Pressure Color Phase Water Solubility
N/A N/A N/A N/A Colorless / Clear Liquid Completely Soluble

UNR-MAN LDLO: 220 mg/kg ORL-RAT LD50: 1530 mg/kg                       
IHL-RAT LC50: >850 mg/m3/1h SKN-RBT LD50: 2740 mg/kg
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6.9.3 CO2 Absorber, Ca(OH)2, KOH, NaOH: Soda Lime

MATERIAL SAFETY DATA SHEET
SECTION I PRODUCT IDENTIFICATION
CAT. NO. 630-00556-00 CAS NO. 80006-28-8
NAME: Soda Lime OTHER NAME: Soda Lime; Soda and Lime
PRODUCT USE: CO2 Scrubber in Shimadzu TOC Analyzers
SECTION II PRECAUTIONS TO BE TAKEN IN HANDLING
Protect skin, eyes and clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling. Safety shower and eye bath. Use 8" 
minimum face shield. Store as a corrosive. Keep tightly closed and store in a cool, dry, place. Air and moisture sensitive. Use as directed in the 
TOC-4000 Instruction Manual.
SECTION III PHYSICAL DATA

SECTION IV REACTIVITY DATA
Incompatible with strong acids. Absorbs CO2, moisture inactivates.
SECTION V FIRE AND EXPLOSION HAZARD DATA
EXTINGUISHING MEDIA: Dry chemical fire extinguisher. Wear self-contained breathing apparatus and protective clothing to prevent skin 
and eye exposure.
UNUSUAL FIRE HAZARD: Emits toxic fumes in a fire.
SECTION VI TOXICITY DATA

SECTION VII HEALTH HAZARD DATA
Acute effects: Harmful if swallowed, inhaled, or absorbed through skin. Material is extremely destructive to tissue of the mucous membranes 
and upper respiratory tract, eyes and skin. Inhalation may be fatal as a result of spasm, inflammation and edema of the larynx and bronchi, 
chemical pneumonitis and pulmonary edema. Symptoms of exposure may include burning sensation, coughing, wheezing, laryngitis, short-
ness of breath, headache, nausea and vomiting. To the best of our knowledge, the chemical, physical, and toxicological properties have not 
been thoroughly investigated.
SECTION VIII FIRST AID
An antidote is a substance intended to counteract the effect of a poison. It should be administered only by a physician or trained emergency 
personnel. Medical advice can be obtained from a POISON CONTROL CENTER.
In case of contact: Immediately flush eyes or skin with copious amounts of water for at least 15 minutes while removing contaminated cloth-
ing and shoes. Assure adequate flushing of the eyes by separating eyelids with fingers. If inhaled, remove to fresh air. If not breathing, give 
artificial respiration. If breathing is difficult, give oxygen. If swallowed, wash out mouth with water provided person is conscious. CALL A 
PHYSICIAN. Wash contaminated clothing before reuse. Discard contaminated shoes. For complete information, see actual entry in RTECS 
#VX965000.
SECTION IX SPILL OR LEAK PROCEDURES
Occupational spill: Evacuate area. Wear self-contained breathing apparatus, rubber boots and heavy rubber gloves. Absorb on sand or vermic-
ulite and place in closed containers for disposal. Ventilate area and wash spill site after material pickup is complete.
SECTION X SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive and shall be used only as a guide. SHIMADZU shall 
not be held liable for any damage resulting from handling or from contact with the above product. Users should make their own investigations 
to determine the suitability of the information for their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date

Melt 
Point Boil Point Density Vapor 

Pressure
Vapor 
Density

Evaporation 
Rate Odor Color Phase Water Solubility

N/A N/A N/A N/A N/A N/A N/A White Granules, various 
sizes N/A

RAT/MOUSE LD50 RTECS# OSHA PEL ACGIH TLV-TWA
N/A VX965000 N/A N/A
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6.9.4 Halogen Scrubber

MATERIAL SAFETY DATA SHEET 
SECTION I  PRODUCT IDENTIFICATION
CAT. NO. 630-0092-00 CAS NO.07740-50-8
NAME: Halogen Scrubber OTHER NAME:Copper Wool
PRODUCT USE: This product is for specific use with TOC instruments.
SECTION II PHYSICAL DATA

SECTION III  HAZARDS IDENTIFICATION
Dust, mist or fumes may cause eye and skin irritation. Avoid contact. 
SECTION IV TOXICITY DATA

SECTION V HEALTH HAZARD DATA
Exposure to large amounts can cause gastrointestinal disturbances, nausea, vomiting, headaches, or dizziness.
SECTION VI FIRST-AID MEASURES
In case of contact, immediately flush eyes with copious amounts of water for at least 15 minutes. in case of skin contact, immediately wash 
skin with soap and copious amounts of water. if ingested and subject is conscious, immediately give large amounts of water. get medical 
attention.
SECTION VII FIRE FIGHTING MEASURES
EXTINGUISHING MEDIA: Appropriate to surrounding fire. Possible formation of toxic copper fumes. Use appropriate respiratory support. 
SECTION VII ACCIDENTAL RELEASE MEASURES 
N/A
SECTION IX STABILITY AND REACTIVITY 
INCOMPATIBILITIES: Strong acids, active halogens such as chlorine, fluorine, iodine, and bromine. ammonia.
SECTION X SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be 
held liable for any damage resulting from handling or contact with the above product. Users should make their own determinations regarding 
the suitability of this information for their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date

Melt 
Point Boil Point Density Vapor 

Pressure
Vapor 

Density
Evaporation 

Rate Odor Color Phase Water 
Solubility

1083°C 2595°C N/A N/A N/A N/A N/A Reddish Solid Malleable Metal N/A

RAT/MOUSE LD50 RTECS# OSHA PEL ACGIH TLV-TWA
N/A GL5325000 N/A N/A
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6.9.5 Sodium Bicarbonate

MATERIAL SAFETY DATA SHEET 
SECTION I PRODUCT IDENTIFICATION
CAT. NO. 630-00963-01 CAS NO. 144-55-8
NAME Sodium Bicarbonate 100% OTHER NAME: Sodium hydrogen carbonate, Baking soda
SECTION II PRDUCT USE
This product is specifically for use as a standard in TOC. Refer to the appropriate instruction manual for directions on proper use. 
SECTION III PHYSICAL DATA

SECTION IV HAZARDS IDENTIFICATION
Possible eye and skin irritation. Avoid contact. 
SECTION V TOXICITY DATA
N/A
SECTION VI HEALTH HAZARD DATA
Exposure to large amounts can cause gastrointestinal disturbances.
SECTION VII FIRST-AID MEASURES
In case of contact, immediately flush eyes with copious amounts of water for at least 15 minutes. In case of skin contact, immediately wash 
skin with soap and copious amounts of water. 
SECTION VIII  FIRE FIGHTING MEASURES
N/A
SECTION IX ACCIDENTAL RELEASE MEASURES
N/A
SECTION X STABILITY AND REACTIVITY 
N/A
SECTION XI SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be 
held liable for any damage resulting from handling or contact with the above product. Users should make their own determinations regarding 
the suitability of this information for their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date

Melt 
Point Boil Point Density Vapor 

Pressure
Vapor 
Density

Evaporation 
Rate Odor Color Phase Water 

Solubility
50°C N/A 2.16 N/A N/A N/A N/A White Solid Powders 10%
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6.9.6 Sodium Carbonate

MATERIAL SAFETY DATA SHEET 
SECTION I PRODUCT IDENTIFICATION
CAT. NO. 630-0092-01 CAS NO. 497-19-8
NAME: Sodium Carbonate, 100% OTHER NAME: N/A
SECTION II PRDUCT USE
This product is specifically for use in the IC channel of the TOC 500, TOC 5000, and TOC 4000 series of TOC analyzers. Refer to the appro-
priate instruction manual for directions on proper use. Keep tightly sealed in a cool, dry, well ventilated place. Store separate form flammable 
and combustible materials. Wear appropriate protective clothing and eye protection.
SECTION III PHYSICAL DATA

SECTION IV HAZARDS IDENTIFICATION
Corrosive, causes burns, harmful if swallowed. Target organ(s): liver, blood. In case of contact with eyes, rinse immediately with plenty of 
water and seek medical advice. Take off all contaminated clothing. Wear suitable protective clothing, gloves and eye/face protection.
SECTION V TOXICITY DATA
ORL-RAT LD50:4090 MG/KG,IHL-RAT LC50:2300 MG/M3/2H
ORL-MUS LD50:6600 MG/KG,IHL-MUS LC50:1200 MG/M3/2H 
SCU-MUS LD50:2210 MG/KG,IHL-GPG LC50:800 MG/M3/2H
SECTION VI HEALTH HAZARD DATA
Harmful if swallowed, inhaled, or absorbed through skin.causes severe irritation. High concentrations are extremely destructive to tissues of 
the mucous membranes and upper respiratory tract, eyes and skin. Symptoms of exposure may include burning sensation, coughing, wheez-
ing, laryngitis, shortness of breath, headache, nausea and vomiting. To the best of our knowledge, the chemical, physical, and toxicological 
properties have not been thoroughly investigated.
SECTION VII FIRST-AID MEASURES
In case of contact, immediately flush eyes or skin with copious amounts of water for at least 15 minutes while removing contaminated clothing 
and shoes. Assure adequate flushing of the eyes by separating the eyelids with fingers. If inhaled, remove to fresh air. If not breathing give arti-
ficial respiration. If breathing is difficult, give oxygen. If swallowed, wash out mouth with water provided person is conscious. Call a 
physician. wash contaminated clothing before reuse. Discard contaminated shoes.
SECTION VIII FIRE FIGHTING MEASURES
NONCOMBUSTIBLE. Use extinguishing media appropriate to surrounding fire conditions. 
SPECIAL. Wear self-contained breathing apparatus and protective clothing to prevent contact with skin and eyes. 
UNUSUAL FIRE AND EXPLOSIONS HAZARDS.Emits toxic fumes under fire conditions.
SECTION IX ACCIDENTAL RELEASE MEASURES
Evacuate area. Wear self-contained breathing apparatus, rubber boots and heavy rubber gloves. Wear disposable coveralls and discard them 
after use. Sweep up, place in a bag and hold for waste disposal. Avoid raising dust.Ventilate area and wash spill site after material pickup is 
complete.
SECTION X  STABILITY AND REACTIVITY 
INCOMPATIBILITIES: Strong acids, aluminum, protect from moisture. 
HAZARDOUS COMBUSTION OR DECOMPOSITION PRODUCTS: Carbon monoxide, carbon dioxide.
SECTION XI SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be 
held liable for any damage resulting from handling or contact with the above product. Users should make their own determinations regarding 
the suitability of this information for their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date

Melt 
Point Boil Point Density Vapor 

Pressure
Vapor 

Density
Evaporation 

Rate Odor Color Phase Water 
Solubility

N/A N/A 2.16 N/A N/A N/A N/A White Solid Powder 
or Crystals

Completely 
Soluble
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6.9.7 Potassium Hydrogen Phthalate

MATERIAL SAFETY DATA SHEET 
SECTION I PRODUCT IDENTIFICATION
CAT. NO. 630-00635-01 CAS NO. 877-24-7
NAME: Potassium Hydrogen Phthalate OTHER NAME: Phthalic Acid, Monopotassium Salt, Khp Primary Standard
SECTION II PRODUCT USE
Specifically for use as an organic carbon standard in the Shimadzu TOC 500, TOC 5,000, and TOC 4,000 instruments. Consult the appropriate 
instrument manual for proper use.
SECTION III PHYSICAL DATA

SECTION IV HAZARDS IDENTIFICATION
Irritant, irritating to eyes, respiratory system and skin. Possible sensitizer. In case of contact with eyes, rinse immediately with plenty of water 
and seek medical advice. Wear suitable protective clothing.
SECTION V TOXICITY DATA
RTECS #: CZ4326000
1,2-BENZENEDICARBOXYLIC ACID, MONOPOTASSIUM SALT
ORL-RAT LD50:>3200 MG/KG KODAK* 21MAY1971
SKN-GPG LD50:>1 GM/KG KODAK* 21MAY1971
Only selected registry of toxic effects of chemical substances (RTECS) data is presented here. See actual entry in RTECS for complete 
information. 
SECTION VI HEALTH HAZARD DATA
ACUTE EFFECTS:May be harmful by inhalation, ingestion, or skin absorption; causes skin irritation; vapor or mist is irritating to the eyes, 
mucous membranes and upper respiratory tract.
EXPOSURE CAN CAUSE ASTHMATIC SYMPTOMS: Cough, hoarseness, rhinorrhea, wheezing, and conjunctivitis, nausea, or 
vomiting. Prolonged or repeated exposure may cause allergic reactions in certain sensitive individuals. To the best of our knowledge, the 
chemical, physical, and toxicological properties have not been thoroughly investigated.
SECTION VII FIRST-AID MEASURES
In case of contact, immediately flush eyes or skin with copious amounts of water for at least 15 minutes while removing contaminated clothing 
and shoes. If inhaled, remove to fresh air. if not breathing give artificial respiration. If breathing is difficult, give oxygen. If swallowed, wash 
out mouth with water provided person is conscious. Call a physician. wash contaminated clothing before reuse.
SECTION VIII FIRE FIGHTING MEASURES
EXTINGUISHING MEDIA: Water spray, carbon dioxide, dry chemical powder or appropriate foam.
SPECIAL FIREFIGHTING PROCEDURES: Wear self-contained breathing apparatus and protective clothing to prevent contact with 
skin and eyes.
UNUSUAL FIRE AND EXPLOSIONS HAZARDS: Emits toxic fumes under fire conditions.
SECTION IX ACCIDENTAL RELEASE MEASURES
Wear respirator, chemical safety goggles, rubber boots and heavy rubber gloves. Sweep up, place in a bag and hold for waste disposal. Avoid 
raising dust. Ventilate area and wash spill site after material pickup is complete.
SECTION X  STABILITY AND REACTIVITY 
STABILITY: Stable.
INCOMPATIBILITIES: Strong oxidizing agent
HAZARDOUS COMBUSTION OR DECOMPOSITION PRODUCTS: Toxic fumes of carbon monoxide, carbon dioxide
HAZARDOUS POLYMERIZATION: Will NOT occur.
SECTION XI  SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be 
held liable for any damage resulting from handling or contact with the above product. Users should make their own determinations regarding 
the suitability of this information for their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date

Melt Point Boil Point Density Vapor 
Pressure

Vapor 
Density

Evaporation 
Rate Odor Color Phase Water 

Solubility
295-300°C N/A N/A N/A N/A N/A N/A White  Crystals N/A
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6.9.8 Water

MATERIAL SAFETY DATA SHEET 
SECTION I PRODUCT IDENTIFICATION
CAT. NO. CAS NO. 7732-18-5 
NAME: Water OTHER NAME: Dihydrogen Oxide
MOLECULAR WEIGHT: 18 CHEMICAL FORMULA: H2O 
SECTION II  HAZARDS IDENTIFICATION
EMERGENCY OVERVIEW: Not applicable. 
HEALTH RATING: 0 - None CONTACT RATING: 0 - None 
FLAMMABILITY RATING:0 - None LAB PROTECTIVE EQUIP: Goggles; lab coat 
REACTIVITY RATING: 1 - Slight STORAGE COLOR CODE: Orange (General Storage) 
SECTION III  HEALTH EFFECTS
POTENTIAL HEALTH EFFECTS:Water is non-hazardous. 
INHALATION: Not applicable. EYE CONTACT: Not applicable. 
INGESTION: Not applicable. CHRONIC EXPOSURE: Not applicable. 
SKIN CONTACT Not applicable. AGGRAVATION OFPRE-EXISTING CONDITIONS: Not applicable. 
SECTION IV FIRST AID MEASURES
NHALATION: Not applicable. SKIN CONTACT:  Not applicable.
INGESTION: Not applicable. EYE CONTACT: Not applicable. 
SECTION V FIRE FIGHTING MEASURES
FIRE: Not applicable. EXPLOSION: Not applicable. 
FIRE EXTINGUISHING MEDIA:Use extinguishing media appropriate for surrounding fire. 
SPECIAL INFORMATION: In the event of a fire, wear full protective clothing and NIOSH-approved self-contained breathing apparatus 
with full facepiece operated in the pressure demand or other positive pressure mode. 
SECTION VI ACCIDENTAL RELEASE MEASURES
Non-hazardous material. Clean up of spills requires no special equipment or procedures. 
SECTION VII HANDLING AND STORAGE
Keep container tightly closed. Suitable for any general chemical storage area. Protect from freezing. Water is considered a non-regulated prod-
uct, but may react vigorously with some materials. Avoid contact with all materials until investigation shows substance is compatible. 
SECTION VII EXPOSURE CONTROLS/PERSONAL PROTECTION
AIRBORNE EXPOSURE LIMITS: Not applicable. 
VENTILATION SYSTEM: Not applicable. PERSONAL RESPIRATORS (NIOSH APPROVED): Not applicable. 
SKIN PROTECTION: None required. EYE PROTECTION: None required. 
SECTION VIII PHYSICAL AND CHEMICAL PROPERTIES

SECTION IX STABILITY AND REACTIVITY
STABILITY: Stable under ordinary conditions of use and storage. 
HAZARDOUS DECOMPOSITION PRODUCTS: Not applicable. 
HAZARDOUS POLYMERIZATION: Will not occur. 
INCOMPATIBILITIES: Strong reducing agents, acid chlorides, phosphorus trichloride, phosphorus pentachloride, phosphorus oxychloride. 
SECTION X ECOLOGICAL INFORMATION
ENVIRONMENTAL FATE: Not applicable. 
ENVIRONMENTAL TOXICITY: Not applicable. 
SECTION XIDISPOSAL CONSIDERATIONS: Whatever cannot be saved for recovery or recycling should be flushed to sewer. If material 
becomes contaminated during use, dispose of accordingly. Dispose of container and unused contents in accordance with federal, state and 
local requirements. 
SECTION XII TRANSPORT INFORMATION
Not regulated. 
SECTION XIII OTHER INFORMATION
NFPA RATINGS: Health: 0 Flammability: 0 Reactivity: 0 LABEL FIRST AID: Not applicable. 
LABEL HAZARD WARNING: Not applicable. PRODUCT USE: Laboratory Reagent. 
LABEL PRECAUTIONS: Keep in tightly closed container. 
SECTION XIV  SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be 
held liable for any damage resulting from handling or contact with the above product. Users should make their own determinations regarding 
the suitability of this information for their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date

Melt 
Point Boil Point Specific 

Gravity
Vapor 

Pressure
Vapor 
Density

Evaporation 
Rate pH Color Phase Water 

Solubility
0°C 100°C 1.00 17.5 @ 20°C N/A N/A 7.0 Clear, Colorless  Liquid Complete
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Appendix A

Appendix AMethod Validation
The Method Validation function tests the variance and the linearity of the data. The 
function also determines performance characteristics according to the requirements of 
DIN 38402-Part 51. The Method Validation function displays the data used for 
executing method validation, performs the required calculations and displays the 
results. Data can either be imported directly from the TOC-Control V Sample Table, or 
entered manually into the data table. Data can also be exported to ASCII files, stored 
and printed.



A.1 Main Window
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A.1 Main Window

The Main Window is separated into three sections. The upper left section of the 
window displays the calibration curve, the upper right section displays the calculated 
validation results and the lower portion displays the data table, which contains all 
relevant data for performing the validation. Refer to Section 4.4.2 “File Menu” and 
Section 4.4.3 “Edit Menu” for descriptions of the toolbar options, such as Open, Save, 
Cut, Copy, and Paste. 

Figure  A.1  Method Validation Main Window

Note: Windows can be resized by dragging the dividers between the sections.



A.2 File Menu
A.2.1 New
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A.2 File Menu

Figure  A.2  File Menu

A.2.1 New

Use the New command to create a new, empty method validation file. A new file can 
also be created by clicking the New toolbar button. If a file that contains modified and 
unsaved data is open when the New command is selected, a prompt is displayed in a 
dialog box. Select one of the options in the dialog box to determine if the unsaved data 
should be saved before opening a new method validation file. Click the Yes button to 
save the document and create a new method validation file. Click the No button to 
create a new document without saving previous data.

Figure  A.3  Prompt for Saving Data 



A.2 File Menu
A.2.2 Open
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A.2.2 Open

Use the Open command to open a saved method validation file (*.val). A file can also 
be opened by clicking the Open toolbar button.

Start the method validation process by selecting a.cal file; application of DIN 38402 
will begin. The process can also be started by selecting the calibration curve row in the 
Sample Table and opening the method validation function using the Tools>Method 
Validation command.

Figure  A.4  Open Dialog Box

When the Open command is selected, the File>Open dialog box is displayed. To open 
an existing file, select the filename and choose the Open button. To create a new 
method validation file, type the filename into the File name text field, then select the 
New button. Refer to Section 4.4.2.4 “Open” for further information on the standard 
functions of the Open dialog box.

Note: An error message is displayed if a file that is not in a correct, TOC-Control V 
format is selected to be opened.

A.2.3 Save

Use the Save command to save data in the current active file. If the file has not yet been 
saved, selecting the Save command opens the Save As dialog box. The Save command 
can also be executed by clicking the Save toolbar button.



A.2 File Menu
A.2.4 Save As
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A.2.4 Save As

Figure  A.5  Save As Dialog Box

The Save As command saves the active, current data to a new file name. Enter the 
desired name in the File Name field. Two different file types are available: validation 
files (*.val) used for storing the data in binary files and ASCII files (*.txt) used for 
exporting the data. Select the desired file type from the Save As Type drop-down list. 
Use the Save In window to select the location where the file should be saved. Refer to 
Section 4.4.2.7 “Save As” for details about the Save As command.

A.2.5 Print

Use the Print command to print data from a method validation file. Executing the Print 
command opens the Print dialog box; displayed options vary based on the installed 
printer driver. The Print command can also be executed by clicking the Print toolbar 
button.

Figure  A.6  Print Dialog Box 

Use the Print Range option to specify the range to be printed. The All selection prints 
all pages in the file. Specific pages can be printed by selecting the Pages option and 
entering the desired page numbers. Use the Number of Copies field to select the 
number of copies to be printed. 



A.2 File Menu
A.2.6 Print Preview
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A.2.6 Print Preview

Use the Print Preview command to view the method validation file before printing.

Figure  A.7  Print Preview Window

Button Description

Print Click the Print button to print the report.

Next Page and Prev Page Click the Next Page button to display the next 
page of the report. Click the Prev Page button 
to display the previous page of the report. The 
Next Page button is disabled when the last 
page of the report is displayed, and the Prev 
Page button is disabled when the first page of 
the report is displayed.

One Page/Two Page Click the One Page button to display one page 
at a time in the Print Preview window. After 
selection, the button toggles to the Two Page 
button. Click the Two Page button to display 
two pages side by side.

Zoom In and Zoom Out Click the Zoom In and Zoom Out buttons to 
change the magnification of the displayed 
pages. Three different zoom factors are 
available. Repeated selection of either option 
will continue to increase or decrease the 
magnification, as applicable.

Close Click the Close button to close the Print 
Preview window and return to the previous 
window. The Print Preview window must be 
closed to edit the report.



A.2 File Menu
A.2.7 Print Setup
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A.2.7 Print Setup

Select Print Setup to open the Print Setup dialog box.

Figure  A.8  Print Setup Dialog Box

The print options available vary based on the printer installed. Select the paper size and 
source from the drop-down lists, and select Portrait or Landscape to change the 
orientation of the printed pages. Click the OK button to save the selections, or click the 
Cancel button to close the dialog box without saving changes.



A.2 File Menu
A.2.8 Page Setup
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A.2.8 Page Setup

Use the Page Setup command to select items to be printed and to select options for 
printing format, such as margins, headers, and footers.

The Page Setup window consists of several tabs. Use the OK button to save changes 
and exit the Page Setup window. Click the Cancel button to exit the Page Setup 
window without saving changes. Click the Apply button to update the parameters 
without closing the Page Setup window.

Note: On each tab in the Page Setup window, certain items are checked (selected) by 
default. To deselect these options, click the item.

Data Tab

The Data tab displays a list of items that can be selected for printing. Select the desired 
items and click the OK button.

Figure  A.9  Page Setup Window: Data Tab



A.2 File Menu
A.2.8 Page Setup
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Grid Tab

Figure  A.10  Page Setup Window: Grid Tab

The Grid tab displays a list of format items for the report, as described below.

Option Description

Row Headers Prints row headers in the table.

Column Headers Prints column headers in the table.

Print Frame Prints a frame around the table.

Vertical Lines Prints vertical lines in the table.

Horizontal Lines Prints horizontal lines in the table.

Only Black and White Prints only in 2 colors, without gray 
backgrounds or other colors.

First Rows, then Columns Prints rows first, followed by columns, when 
more than one page is printed

First Columns, then Rows Prints columns first, followed by rows, when 
more than one page is printed.

Vertical Prints the table on the vertical center of the page.

Horizontal Prints the table on the horizontal center of the 
page.



A.2 File Menu
A.2.9 Exit
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Miscellaneous Tab

Figure  A.11  Page Setup Window: Miscellaneous Tab

The Miscellaneous tab displays a list of format items for the report, as described below.

A.2.9 Exit

Select Exit to close the Method Validation application. If an active file contains 
unsaved information, a prompt to save changes is displayed. Select Yes or No, or select 
Cancel to abort the exit function.

Figure  A.12  Prompt to Save Data Changes

Setting Item Description

Margins Use the spin controls to enter the page margins 
(in mm).

Footer, Page No. Select this option to print the page number in 
the footer of each page.

Header Organization: Select this option and enter the 
name of the organization in the text box to 
print the organization name in the page header. 

Logo: Select this option to print a bitmap in the 
page header. Use the Browse button to select 
the bitmap file.

Date/Time: Select this option to print the 
current system date and time in the page 
header.

Operator: Select this option to print the 
current user name in the page header.



A.3 Edit Menu
A.3.1 Undo
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A.3 Edit Menu

Options such as Cut, Copy, and Paste are available only if content is selected.

Figure  A.13  Edit Menu

A.3.1 Undo

Use the Undo function to reverse the last change made in the data table. This function 
is available only in documents that can be manually edited and when the user changes 
the content of a cell in the data table.

A.3.2 Cut/Copy/Paste

Use the Cut, Copy, and Paste commands to edit highlighted table cells and rows. The 
Cut command deletes information in rows or cells and stores it on the clipboard. The 
Copy command copies data from rows or cells to the clipboard. The Paste command 
copies the contents of the clipboard to the current row of the table. When pasting a 
whole row, select the entire destination row first by clicking the row number.

Note: Do not select a row for pasting that currently contains data. The data will be 
overwritten!

TIP: The Cut, Copy and Paste commands have shortcut buttons on the toolbar.

A.3.3 Recalculate

Use the Recalculate command to recalculate all method validation data. The results and 
calibration curve sections of the Method Validation window are also updated when the 
Recalculate command is selected. Errors that occur during the recalculation process are 
displayed in message boxes. For example, an error message may be displayed if the 
data in the table does not contain sufficient information, if there are not enough data 
points defined in the table, if less than 3 injections are available, and if numeric data 
are incorrect and results in an illegal mathematical operation (such as division by zero).

TIP: The Recalculate command has a shortcut button on the toolbar.



A.4 View Menu
A.5.1 General Parameter
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A.4 View Menu

Figure  A.14   View Menu

Toolbar

The Toolbar function displays or hides the toolbar. 

Status Bar

The Status Bar function displays or hides the status bar. 

A.5 Options Menu

Figure  A.15  Options Menu

A.5.1 General Parameter

Select the General Parameter command to display the General Information dialog box.

Figure  A.16  General Information Dialog Box

The General Information dialog box is used to view and edit information about the 
method validation file, such as the system used to create the file, the file version, the 
operator who created the file and the date on which the file was created. Some 
information fields may be disabled. Comments about the file are displayed in the 
Comment field.



A.5 Options Menu
A.5.2 Method Validation Parameter Window
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A.5.2 Method Validation Parameter Window

The Method Validation Parameter command displays the Method Validation Parameter 
window, which contains detailed information about the method, as described below.

Figure  A.17  Method Validation Parameter Window 

Item Description

Enable manual editing Select to allow data tables to be edited 
manually. This option is disabled for files 
linked to TOC-Control V calibration curves. If 
this option is deselected, it is disabled and 
cannot be selected again. This option is 
selected by default.

Unit Displays the calibration curve units. This 
option is disabled if the Enable manual editing 
option is not selected.

Analysis Type Displays the analysis used to create the 
calibration curve. This option is disabled if the 
Enable manual editing option is not selected.

Date/Time Displays the date and time the file was created. 

Title Displays the title of the method validation file.

Calibration curve file name Displays the name of the TOC-Control V 
calibration curve.



A.5 Options Menu
A.5.3 Font
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A.5.3 Font

Use the Font command to select fonts for printed reports and display screens. Selecting 
the Font command opens the Font dialog box.

TIP: The Font command has a shortcut button on the toolbar.

Figure  A.18  Font Dialog Box

Choose a font for printed reports by selecting options from the Font, Font Style, Size, 
Color and Script drop-down lists. A preview of the font appearance is visible in the 
Sample field on the lower portion of the Font dialog box.
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A.5.4 Floating Point Numbering Format

Use the Floating Point Numbering Format command to select display options for 
numeric results in the method validation tables. These options apply only to the manner 
in which numbers are displayed; internal data retain their original values.

Figure  A.19  Floating Point Format Window

Common Floating Point Numbers

Percent Values

Setting Item Description

Number of significant digits Select this option to display common floating 
point numbers using a specified number of 
significant digits. Use the spin control to set 
the number of significant digits. The default 
value is 4.

Number of digits after the 
decimal point

Select this option to display common floating 
point numbers using a specified number of 
digits after the decimal point. Use the spin 
control to set the number of digits after the 
decimal point. The default value is 2.

Setting Item Description

Number of significant digits Select this option to display percent values 
using a specified number of significant digits. 
Use the spin control to set the number of 
significant digits. The default value is 4.

Number of digits after the 
decimal point

Select this option to display percent values 
using a specified number of digits after the 
decimal point. Use the spin control to set the 
number of digits after the decimal point. The 
default value is 2.
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A.5.5 ASCII Export Options

Use the ASCII Export Options function to export method validation data to an ASCII 
file.

Figure  A.20  ASCII Export Options Dialog Box

To export a file, create or open a method validation file. Select the desired options from 
the ASCII Export Options dialog box and select OK. The File>Save As dialog box is 
displayed. Enter a file name for the ASCII file and select the *.txt file type.

A.5.6 Validation Strictly Following DIN38402

Use the Validation Strictly Following DIN38402 option to conduct the validation 
calculation by DIN 38402 requirements; that is, only the area obtained from the first 
injection of every standard is used in the calibration calculation. When this option is 
not selected, the mean value of the area counts from all injections of each standard is 
used in the calibration calculation. 

Perform method validation according to DIN regulations according to the following 
steps:

1. Select the estimated working range.

2. Prepare 10 calibration standards, with concentrations distributed uniformly 
over the complete working range.

Setting Item Description

Header Select to export method validation file header.

Data Select to export method validation data.

Results Select to export method validation results.

Separator Select the type of separator to be used between 
items in the ASCII file.

Export strings in quotation 
marks

Select this option to add quotation marks to all 
exported strings.
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3. Create a Sample Table, with 10 injections of the highest and lowest standard 
concentrations and a single injection for all other standards. If more than one 
injection is made of the intermediate standards, the linearity test is calculated 
with the results of the first replicates only.

4. Analyze the standards. The results are saved in a.cal file.

5. Select Method Validation from the Tools menu in the Sample Table Editor. The 
Method Validation main window is displayed.

6. Select the Validation Strictly Following DIN from the Options menu.

7. Select Open from the File menu.

8. Select.cal from the file type drop-down list.

9. From the list of file names, select the.cal file where the measurement data was 
saved. Then select OK.

10. The calculations are automatically performed, and the validation data 
displayed.

11. Select Save from the File menu, assign a file name in the dialog box, and select 
OK. The validation data are saved with a.val file name extension.

When the Validation Strictly Following DIN option is enabled, a check mark is 
displayed in front of the menu item. After selecting this option, a confirmation message 
is displayed.

Figure  A.21  Confirmation Message for Validation Strictly Following DIN 38402

Select Yes to execute recalculation. The calibration curve and result sections of the 
Method Validation window are updated accordingly.
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A.6 Help Menu

About Meth Val...

Use the About command to view copyright and version information.
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Appendix BControl Charts
The Control Charts software monitors precision and accuracy of a defined data set. The 
software supports five types of Control Charts:

•Mean Value Control Charts

•Recovery Control Charts

•Blind Value Control Charts

•Spanwidth Control Charts

•User Defined Control Charts

The Mean Value Control Chart checks the accuracy of an analytical method on an 
instrument. Control value drifts may indicate a change in system performance.

The Recovery Control Chart tests an analytical method for matrix influences and 
provides a restrictive control of accuracy by testing proportional system errors. Using 
certified standards will test the accuracy of the system as well as the recovery rate.

The Blind Value Control Chart is a special form of the Mean Value Control Chart used 
for quality assurance of the instrument and variable elements. Unlike the Mean Value 
Control Chart, the control value is the information value (absorbance, peak height, 
peak area) received from the analysis.

The Spanwidth Control Chart tests the precision of an analytical method and monitors 
the accuracy under actual conditions (Drift Control). For this type of Control Chart, 
there are several existing models for calculating the control and warning limits.

Each type of control chart can be used to create charts for different working range and 
analysis methods. For each control chart, a file is created which contains general 
information about the type, data structure and other global data.
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B.1 File Menu

Figure B.1  File Menu

B.1.1 New

The New function is used to define new control charts and displays the Control Chart 
Wizard. Follow the Control Chart Wizard process to enter a new control chart. The file 
extension *.cc is used for all control charts.

Note: Control Chart parameters can be changed at a later time by selecting 
Options>Control chart options from the main menu bar.

Control Chart Wizard System Information Window

The first page of the Control Chart Wizard is used to enter basic system information 
and is similar to the System Information pages in the Method and Sample Wizards 
Refer to Section 4.4.5.2 “Sample” and Section 4.4.2.3 “Method Wizard” for more 
details.

Figure B.2  Control Chart Wizard: System Information Window
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Control Chart Wizard Control Chart Type Window

Select the type of control chart to be created and select the analysis type from the drop 
down list.

Figure B.3  Control Chart Wizard: Control Chart Type Window

Control Chart Wizard Control Chart Parameters Window

Enter the control chart parameter values and limits as described below.

Figure B.4  Control Chart Wizard: Control Chart Parameters Window
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Setting Item Description

Automatic calculation of the 
control chart limits

Select to enable automatic calculation of the 
control chart limits. The upper and lower 
warning and control limits are calculated after 
the control samples for the preparation period 
are added to the control chart.

No. of samples in the pre-
period

Enter the number of samples in the preparation 
period. The default value is 12. This option is 
disabled if the Automatic calculation of the 
control chart limits option is not selected.

No. of samples in the 
control-period

Enter the number of samples in the control 
period. The default value is 50.

Working range Enter the upper and lower limits of the 
working range. Match the range with the 
concentration of samples used for control 
tracking and the concentration range of the 
selected calibration curve. Use the drop-down 
list to select the units.

Rated Value Enter the rated value of the working range. 
This option is disabled if the Automatic 
calculation of the control chart limits option is 
not selected.

Control Limits Enter the upper and lower control limits. This 
option is disabled if the Automatic calculation 
of the control chart limits option is not 
selected.

Warning Limits Enter the upper and lower warning limits. This 
option is disabled if the Automatic calculation 
of the control chart limits option is not 
selected.

Exclusion Limits Enter the upper and lower exclusion limits.
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Control Chart Wizard Recovery Control Chart Parameter Window

This window is only displayed if the Recovery Control Chart is selected in the Control 
Chart Wizard, and Automatic calculation of the control chart limits is not selected.

Figure B.5   Control Chart Wizard: Recovery Control Chart Parameter Window

Setting Item Description

Use of certified standard Select this option to use a certified sample as a 
control sample.

Fixed theoretical 
concentration

Select this option if the standard has a fixed 
concentration. Enter the concentration in the 
text box.

Use of real sample Select this option if the control sample is a real 
sample.

Fixed concentration of the 
spiked component

Select this option if the spiked component has 
a fixed concentration. Enter the concentration 
in the text box.
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Control Chart Wizard Spanwidth Control Chart Options Window

This window is only displayed if the Spanwidth Control Chart is selected in the 
Control Chart Wizard.

Figure B.6  Control Chart Wizard: Spanwidth Control Chart Options Window

Setting Item Description

No. of inj. per sample Enter the number of injections for a sample 
used in the control chart. The default value is 
3, and the range is 3-25.

Refuse control samples with 
different inj. no

Select this option to exclude from the control 
chart samples whose number of injections 
differs from those specified in the No. of inj. 
per sample field.
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Control Chart Wizard History Window

The Control Chart Wizard History function is identical to other history functions in the 
TOC-Control V system. Refer to Section 4.4.2.3 “Method Wizard” for more details 
about the History function. The History window provides information on all control 
chart changes when enabled.

Figure B.7  Control Chart Wizard: History Window

Setting Item Description

Enable history log Select this option to enable the History Log, 
which is used to monitor all modifications to 
the control charts. Once the History Log is 
enabled, it cannot be turned off.

Operator has to comment all 
modifications

Select this option to require the user to enter 
comments or obtain approval for 
modifications to the control charts.
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B.1.2 Following Control Chart

Select the Following Control Chart menu item to create a Following Control Chart. It is 
recommended that a new control chart be created after 50 samples have been entered in 
the control period. The new control chart uses the calculated standard deviation from 
the control period as the new control chart limits. Control chart options are:

B.1.3 Open

The Open command is used to open files. Select a *.cc file to open a control chart file. 
Refer toSection 4.4.2.4 “Open” for further information on the standard File>Open 
dialog box.

B.1.4 Save

The Save command saves the current control chart.

B.1.5 Save As

Use the Save As command to save files for the first time, or to save a file using a new 
file name. Files can be saved as file types *.cc or *.txt (ASCII format). Refer to 
Section 4.4.2.7 “Save As” for more information on the Save As function.

Setting Item Description

File Name Displays the name of the currently active 
control chart.

Save the current control 
chart as

Enter a new file name in this field to save the 
currently active control chart to a new location 
or with a new file name. A confirmation 
message is displayed to confirm the operation.

Create Select this option to create the Following 
Control Chart. The new limits are calculated 
from the samples of the control period stored 
in the previous control chart.

Parameter Select this option to display the parameters of 
the newly created Following Control Chart. 
This function can also be accessed using the 
Options>Control Chart Options command in 
the main window. 
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B.1.6 Print>Data

Use the Print>Data command to print data in spreadsheet format. Refer to 
Section 4.4.2.10 “Print>Table” for more information on the Print function.

B.1.7 Print>Graph

Use the Print>Graph command to print data in graphical format. Refer to 
Section 4.4.2.10 “Print>Table” for more information on the Print function. 

B.1.8 Print Preview>Data/Print Preview>Graph

Use the Print Preview>Data function to display a preview of the data to be printed. Use 
the Print Preview>Graph function to display a preview of the graph to be printed. Refer 
to Section 4.4.2.12 “Print Preview>Table” for more information on the Print Preview 
function.

B.1.9 Print Setup

Use the Print Setup command to select the printing parameters.

Figure B.8  Print Setup Dialog Box

The print options available vary based on the printer installed. Select the paper size and 
source from the drop-down lists, and select Portrait or Landscape to change the 
orientation of the printed file. Select OK to save the selections, or Cancel to close the 
dialog box without saving changes.
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B.1.10 Page Setup

Use the Page Setup command to select items to be printed and to select options for 
printing format, such as margins, headers, and footers.

The Page Setup window consists of several tabs. Use the OK button to save changes 
and exit the Page Setup window. Click the Cancel button to exit the Page Setup 
window without saving changes. Click the Apply button to update the parameters 
without closing the Page Setup window.

Note: On each tab in the Page Setup window, certain items are checked (selected) by 
default. To deselect these options, click the item.

Data Tab

The Data tab displays a list of items that can be selected for printing. Select the desired 
items and click the OK button.

Figure B.9  Page Setup Window: Data Tab
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Grid Tab

Figure B.10  Page Setup Window: Grid Tab

The Grid tab displays a list of format items for the report, as described below. 

Option Description

Row Headers Prints row headers in the table.

Column Headers Prints column headers in the table.

Print Frame Prints a frame around the table.

Vertical Lines Prints vertical lines in the table.

Horizontal Lines Prints horizontal lines in the table.

Only Black and White Prints only in 2 colors, without gray 
backgrounds or other colors.

First Rows, then Columns Prints rows first, followed by columns, when 
more than one page is printed

First Columns, then Rows Prints columns first, followed by rows, when 
more than one page is printed.

Vertical Prints the table on the vertical center of the 
page.

Horizontal Prints the table on the horizontal center of the 
page.
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Miscellaneous Tab

Figure B.11  Page Setup Window: Miscellaneous Tab

The Miscellaneous tab displays a list of format items for the report, as described below. 

B.1.11 Exit

Select Exit to close the Control Chart application.

Setting Item Description

Margins Use the spin controls to enter the page margins 
(in mm).

Footer, Page No. Select this option to print the page number in 
the footer of each page.

Header Organization: Select this option and enter the 
name of the organization in the text box to 
print the organization name in the page header. 

Logo: Select this option to print a bitmap in the 
page header. Use the Browse button to select 
the bitmap file.

Date/Time: Select this option to print the 
current system date and time in the page 
header.

Operator: Select this option to print the current 
user name in the page header.
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B.2 Edit Menu

Figure B.12  Edit Menu

Copy

Use the Copy command to copy the selected range from the data table to the clipboard.

Recalculate

Use the Recalculate command to recalculate the limits of the control chart. This 
function should be performed after one or more control samples have been excluded or 
added to the control chart.

Exclude

Use the Exclude command to exclude a selected range of control samples from the 
control chart calculations. When Exclude is selected, the Exclude dialog box is 
displayed. Enter a comment describing the reason for excluding the sample. The 
Exclude function is only available when one or more control samples are selected. A 
dialog box displays a message requesting confirmation that the sample be excluded. 
Select Yes to confirm and recalculate the control limits, or No to abort recalculation.
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B.3 View Menu

Figure B.13   View Menu

B.3.1 Statistics

The Statistics command displays the Statistics window.

Figure B.14  Statistics Window

Setting Item Description

Type Displays the type of control chart.

No. of samples (pre-period) Displays the number of samples in the 
preparation period. This value was entered in 
the Control Chart Wizard.

Total no. of samples Displays the total number of samples in the 
control chart. Excluded samples are not 
included in the total number.

Control limits Displays the control limits.

Data from the control period Displays the Average Control Value, which is 
the mean value of the samples in the control 
period. Also displays the calculated standard 
deviation and coefficient of variation.
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B.3.2 Comparison

After a control chart is complete, the results from the control period must be compared 
with the results from the preparation period. For control charts without a preparation 
period, the current values must be compared with the results of the preparation period 
or the control period from the previous control chart. The View>Comparison command 
displays the Comparison between control charts window.

Figure B.15  Comparison Between Control Charts Window

Setting Item Description

Previous control chart Displays the file name of the previous control 
chart, if applicable.

Mean value t-test Displays the results of the T-test in the text box 
beneath the Item and Value lists. The T-table 
value and the calculated test value are also 
displayed in the Item and Value list. The test 
value is calculated based on the mean values 
and variances obtained from the control and 
preparation period. The T-test result shows 
whether the long term deviation of the control 
samples is significant. 

F-test Displays the results of the F-test in the text box 
beneath the Item and Value list. The F-table 
value and the calculated test value are also 
displayed in the Item and Value list.
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B.3.3 Out of Control Events

The Out of Control Events window displays a list of all out of control events.

Figure B.16  Out of Control Events Window

Spl. No.

Displays the sample number for which the out of control event occurred.

Event

Describes the out of control event.

B.3.4 Toolbar/Status Bar

The View>Toolbar and View>Status Bar commands show and hide the Toolbar and 
Status Bar, respectively.
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B.4 Options Menu

Figure B.17  Options Menu

B.4.1 Control Chart Options

Use the Control Chart Options command to view and edit the control chart parameters 
entered in the various pages of the Control Chart Wizard. Refer to Section B.1.1 
“New” for more details.

Note: Some options within the Control Chart Options tabs (such as control chart type 
or sample concentrations) may be disabled if the control chart contains data. 
The disabled parameters are options that cannot be modified once data are 
entered.

B.4.2 Font

The Font command opens the standard Font dialog box. Refer to Section 4.4.9.3 
“Display Settings>Display Font” for detailed information about font options.

B.4.3 Floating Point Numbering Format

The Floating Point Numbering Format command is used to select display options for 
numeric results in the control charts. These options apply only to the manner in which 
numbers are displayed; internal data retain their original values.

Figure B.18  Floating Point Format Window
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Common Floating Point Numbers

Percent Values

Setting Item Description

Number of significant digits Select this option to display common floating 
point numbers using a specified number of 
significant digits. Use the spin control to set 
the number of significant digits. The default 
value is 4.

Number of digits after the 
decimal point

Select this option to display common floating 
point numbers using a specified number of 
digits after the decimal point. Use the spin 
control to set the number of digits after the 
decimal point. The default value is 2.

Setting Item Description

Number of significant digits Select this option to display percent values 
using a specified number of significant digits. 
Use the spin control to set the number of 
significant digits. The default value is 4.

Number of digits after the 
decimal point

Select this option to display percent values 
using a specified number of digits after the 
decimal point. Use the spin control to set the 
number of digits after the decimal point. The 
default value is 2.
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B.4.4 ASCII Export Options

The ASCII Export Options function is used to export control chart data to an ASCII-
formatted file.

Figure B.19  ASCII Export Options Dialog Box

To export a file, create or open a control chart. Select the desired options from the 
ASCII Export Options dialog box, and select OK. The File>Save As dialog box is 
displayed. Enter a file name for the ASCII file and select the *.txt file type.

B.4.5 Enable Exclusion

Use the Enable Exclusion command to exclude a selected range of control samples 
from the control chart calculations. When the Enable Exclusion command is executed, 
the Exclude dialog box is displayed. Enter a comment describing the reason for 
excluding the sample.This option is only available when one or more control samples 
are selected. A dialog box displays a message requesting confirmation that the sample 
be excluded. Select Yes to confirm and recalculate the control limits, or No to abort the 
process.

Setting Item Description

Header Select to export control chart file header.

Data Select to export control chart data.

Limits Select to export control chart limits.

Separator Select the type of separator to be used between 
items in the ASCII file.

Export strings in quotation 
marks

Select this option to add quotation marks to all 
exported strings.
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B.5 Help Menu

About ContrCharts...

Use the About command to view copyright and version information.
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